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Change Log

Date Change Description

January 2022 5.1 Initial release.

June 2022 Updated the following topics:
l Loading a Server Certificate on page 256
l Predefined Policies on page 196

July 2022 l Added Oracle Linux 6.10 as a supported operating system in Installing FortiEDR on page
19.

l Added link to Fortinet Support in several topics.

August 2022 Updated the following topics:
l Installing FortiEDR on page 19 (System requirements section)
l Step 2 – Defining or Importing an Organization on page 341

September 2022 Updated the following topics:
l Installing the FortiEDR Central Manager and FortiEDR Aggregator on the Same Machine
on page 383

l Installing FortiEDR Collectors on page 26
l Installing the FortiEDR Core on page 397

October 2022 Updated the following topics:
l Uninstalling FortiEDR Collectors on page 50
l SAML IdP Configuration with Okta on page 274

February 2023 Updated the Playbook Policy Actions on page 92 topic.

July 2023 Updated Installing a FortiEDR Collector on Linux on page 41.

November 2023 Updated the following topics:
l A FortiEDR Collector Does Not Display in the INVENTORY Tab on page 336
l Installing FortiEDR on page 19

January 2024 Updated the following topics:
l Upgrading FortiEDR Components on page 52
l Uninstalling FortiEDR Collectors on page 50

February 2024 Updated Installing a FortiEDR Collector on Linux on page 41.
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Introducing FortiEDR

This chapter describes the FortiEDR system components, FortiEDR technology and the workflow for protecting your
organization using FortiEDR.

Introduction

FortiEDR provides multi-layered, post- and pre-infection protection that stops advanced malware in real time. FortiEDR
recognizes that external threat actors cannot be prevented from infiltrating networks, and instead focuses on preventing
the exfiltration and ransoming of critical data in the event of a cyber-attack. FortiEDR's unique virtual patching technique,
which only blocks malicious outbound communications, enables emplyees to continue working as usual even when their
devices are infected.

Execution Prevention

Next-Generation Anti-Virus (NGAV) is a signature-less approach that can detect and mitigate zero-day attacks.
FortiEDR stops both known and unknown malware types using machine-learning-based NGAV, which filters out known
malware variations. This blocks the execution of files that are identified as malicious or suspected to be malicious. For
this policy, each file is analyzed to find evidence for malicious activity.

Data Exfiltration

Data exfiltration is the unauthorized transfer of sensitive information from a target’s network to a location that a threat
actor controls.

FortiEDR is a realtime targeted-attack exfiltration prevention platform.

Threat actors only benefit when they actually succeed in stealing your data.

FortiEDR ensures that your data is not exfiltrated by threat actors, regardless of the methods that they use.

FortiEDR can prevent malicious exfiltration attempts of any kind of data, from any application, from any process, using
any protocol or port.

FortiEDR becomes your last line of defense in case of a data exfiltration attempt. All malicious connections
are blocked and precise details of the infected devices and their associated components are available for your
review.

FortiEDR is a software-only solution that can be installed with your current standard equipment.

FortiEDR protects your data from exfiltration both On-Premises and Off-Premises.
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Ransomware

Ransomware is malware used by attackers to infect a device, hijack files on that device and then lock them, via
encryption, so that they cannot be accessed until the attacker decrypts and releases them. A successful ransomware
attack represents the exploit of a greater security vulnerability in your environment. Paying the attacker is only a short-
term solution that does not address the root of the problem, as it may likely lead to another attack that is even more
malicious and more expensive than the previous one.

FortiEDR prevents, in real time, an attacker’s attempt to encrypt or modify data. FortiEDR then generates an alert that
contains the information needed to initiate an investigation, so the root breach can be uncovered and fully remediated.
Moreover, the end user can continue to work as usual even on an infected device.

Threat Hunting

FortiEDR’s threat-hunting capabilities features a set of software tools and information sources focused on detecting,
investigating, containing and mitigating suspicious activities on end-user devices.

FortiEDR provides post- and pre-infection endpoint protection management, while delivering high detection rates with
realtime blocking and response capabilities when compared to traditional Endpoint Detection and Response (EDR)
tools.

FortiEDR provides malware classification, displays Indicators of Compromise (IOCs) and delivers full attack-chain views
– all while simultaneously enabling users to conduct further threat hunting, if and when needed.
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FortiEDR Technology

When looking at how external threat actors operate, we recognize two important aspects. The first is that the threat
actors use the network in order to exfiltrate data from an organization. Second, they try to remain as stealthy as possible
in order to avoid existing security measures. This means that threat actors must establish outbound communications in a
non-standard manner.

FortiEDR’s technology prevents data exfiltration by identifying, in real time, malicious outgoing communications that
were generated by external threat actors. Identification of malicious outgoing communications is the result of our
research conducted on both operating system internals and malware operation methods.

Our research revealed that all legitimate outgoing communications must pass through the operating system. Thus, by
monitoring the operating system internals it is possible to verify that a connection was established in a valid manner.
FortiEDR gathers OS stack data, thread and process related data and conducts executable file analysis to determine the
nature of the connection. Additionally, any type of threat attempting to bypass the FortiEDR driver is detected as the
connection will not have the corresponding data from FortiEDR.
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FortiEDR’s technology prevents data exfiltration by identifying, in real time, malicious outgoing communications that
were generated by external threat actors. Identification of malicious outgoing communications is the result of our
research conducted on both operating system internals and malware operation methods.

FortiEDR Components

Overview

The FortiEDR platform is a distributed architecture that collects the connection establishment flow of your organization’s
communicating devices directly from each device’s operating system internals. FortiEDR analyzes the flow of events
that preceded the connection establishment and determines whether the connection establishment request was
malicious. The system can enforce your organization’s policy by blocking the connection establishment request in order
to prevent exfiltration.

The FortiEDR platform is comprised of the following components:

FortiEDR Collector

The FortiEDR Collector is a brainless collector that resides on every communicating device in your enterprise, including
desktops, laptops and servers.

The FortiEDR Collector resides deep inside the communicating device’s operating system.
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Upon every attempt made by the communicating device to establish a network connection, the FortiEDR Collector
collects all required metadata and sends it to the FortiEDR Core (described below) signed by a FortiEDR digital
signature.

The FortiEDR Collector then holds the establishment of this connection until authorization is received from the FortiEDR
Core.

l Pass: Legitimate requests are allowed out of your network with extremely negligible latency.
l Block: Malicious exfiltration attempts are blocked.

If third-party software attempts to stop the FortiEDR Collector service, the system prompts for
the registration password. This is the same password used when installing the Collector. If an
incorrect password is supplied at the prompt, the message Access Denied displays on the
Collector device. In this case, the FortiEDR Collector service is not stopped. For more details
about the required password to supply in this situation, you may refer to Component
Authentication on page 295.

A FortiEDR Collector should be installed on each communicating device in your organization. The same FortiEDR
Collector can be installed on all Windows systems, Mac systems and Linux systems. The following are the connections
established between the FortiEDR Collector and other FortiEDR components:

l To the FortiEDR Aggregator: The FortiEDR Collector initially sends registration information to the FortiEDR
Aggregator via SSL and then it sends ongoing health and status information.

l From the FortiEDR Aggregator: The FortiEDR Collector receives its configuration from the FortiEDR Aggregator.
l To the FortiEDR Core: The FortiEDR Collector sends compressed operating systemmetadata to the FortiEDR Core
and then ongoing health and status information.

l From the FortiEDR Core: The FortiEDR Collector receives connection establishment authorization or denial
(blocking) from the FortiEDR Core.

Negligible Footprint

The FortiEDR Collector retains only a limited amount of metadata on the device in order to keep CPU usage to virtually
zero and the storage requirements to a minimum. FortiEDR’s traffic consumption requirements are low since FortiEDR
only processes the initial connection establishment. The amount of metadata sent to the FortiEDR Core is so minimal
that the latency on the Core’s decision point is negligible. Additionally, FortiEDR uses message compression in order to
further reduce the traffic sent to the network. You may refer to Installing FortiEDR on page 19 for the exact specifications
of the system requirements.

Quick and Easy Installation

The FortiEDR Collector comes as a standard installer package that is easily installed via standard remote unattended
deployment tools, such as Microsoft SCCM. No local configuration or reboot is required; however, a reboot of the system
ensures that any malicious connections that were previously established before the installation are thwarted and tracked
via FortiEDR after the reboot is complete. Upgrades can be performed remotely and are rarely needed, because all the
brains of the FortiEDR system are in the FortiEDR Core.
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Event Viewer

TheWindows Event Viewer records whenever a FortiEDR Collector blocks communication from a device, as described
in Event Viewer on page 134.

FortiEDR Core

The FortiEDR Core is the security policy enforcer and decision-maker. It determines whether a connection
establishment request is legitimate or represents a malicious exfiltration attempt that must therefore be blocked.

FortiEDR collects OS stack data, thread and process-related data and conducts executable file analysis to determine the
nature of every connection request, as follows.

l When working in prevention mode, all the connection establishment requests in your organization must be
authorized by a FortiEDR Core, thus enabling it to block each outgoing connection establishment request that is
malicious.

l When the FortiEDR Core receives a connection establishment request, it comes enriched with metadata collected
by the FortiEDR Collector that describes the operating system activities that preceded it.

l The FortiEDR Core analyzes the flow of events that preceded the connection request and determines whether the
connection request was malicious. The system then enforces your organization’s policy by blocking (or only
logging) the connection request in order to prevent/log exfiltration.

l The collection of the flow of events that preceded the connection request enables FortiEDR to determine where the
foul occurred.

One or more FortiEDR Cores are required, according to the size of your network based on deployment size (up to 50
FortiEDR Cores). Installing FortiEDR on page 19 for the exact specifications of the system requirements. The following
are the connections established between the FortiEDR Core and other FortiEDR components:

l To the FortiEDR Aggregator: The FortiEDR Core sends registration information the first time it connects to the
FortiEDR Aggregator and then sends events and ongoing health and status information.

l From the FortiEDR Aggregator: The FortiEDR Core receives its configuration from the FortiEDR Aggregator.

The FortiEDR Core is located on exit points from your organization. It only reviews FortiEDR Collector metadata; it does
not see the outgoing traffic. It is a central Linux-based software-only entity that can run on any workstation or VM that is
assigned with a static IP address.

FortiEDR Aggregator

The FortiEDR Aggregator is a software-only entity that acts as a proxy for the FortiEDR Central Manager and provides
processing load handling services. All FortiEDR Collectors and FortiEDR Cores interact with the Aggregator for
registration, configuration and monitoring purposes. The FortiEDR Aggregator aggregates this information for the
FortiEDR Central Manager and distributes the configurations defined in the FortiEDR Central Manager to the FortiEDR
Collectors and FortiEDR Cores.

Most deployments only require a single FortiEDR Aggregator that can be installed on the same server as the FortiEDR
Central Manager. Additional FortiEDR Aggregators may be required for larger deployments of over 10,000 FortiEDR
Collectors and can be installed on a different machine than the FortiEDR Central Manager.
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FortiEDR Central Manager

The FortiEDR Central Manager is a software-only central web user interface and backend server for viewing and
analyzing events and configuring the system. Chapters from Security Settings on page 54 to Forensics on page 204
describe the user interface of the FortiEDR Central Manager. The FortiEDR Central Manager is the only component that
has a user interface. It enables you to:

l Control and configure FortiEDR system behavior
l Monitor and handle FortiEDR events
l Perform deep forensic analysis of security issues
l Monitor system status and health

FortiEDR Cloud Service

The FortiEDR Cloud Service (FCS) enriches and enhances system security by performing deep, thorough analysis and
investigation about the classification of a security event. The FCS is a cloud-based, GDPR-compliant, software-only
service that determines the exact classification of security events and acts accordingly based on that classification – all
with a high degree of accuracy.

The FCS security event classification process is done via data enrichment and enhanced deep, thorough analysis and
investigation, enabled by automated and manual processes. The enhanced processes may include (partial list)
intelligence services, file analysis (static and dynamic), sandboxing, flow analysis via machine learning, commonalities
analysis, crowdsourced data deduction and more.

Along with potential classification reassurance or reclassification, once connected, FCS can also enable several
followed actions, which can be divided into two main activities:

l Tuning: Automated security event exception (allowlisting). After a triggered security event is reclassified as Safe, an
automated cross-environment exception can be pushed downstream and expire the event, preventing it from
triggering again. For more details, see Exception Manager on page 64

l Playbook Actions: All Playbook policy actions are based on the final determination of the FCS. For more details see
Playbook Policies on page 89.

How Does FortiEDR Work?

1. The FortiEDR Collector Collects OS Metadata: A FortiEDR Collector runs on each communicating device in the
organization and transparently collects OS metadata on the computing device.

2. Communicating Device Makes a Connection Establishment Request: When any connection establishment
request is made on a device, the FortiEDR Collector sends a snapshot of the OS connection establishment to the
FortiEDR Core, enriched with the collected OSmetadata. Meanwhile, FortiEDR does not allow the connection
request to be established.

3. The FortiEDR Core Identifies Malicious Requests: Using FortiEDR’s patented technology, the FortiEDR Core
analyzes the collected OSmetadata and enforces the policies.

4. Pass or Block: Only legitimate connections are allowed outbound communication. Malicious outbound connection
attempts are blocked.

5. Event Generation: Each FortiEDR policy violation generates a realtime security event (alert) that is packaged with
an abundance of device metadata describing the internals of the operating system leading up to the malicious
connection establishment request. This security event is triggered by the FortiEDR Core and is viewable in the
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FortiEDR Central Manager console. FortiEDR can also send email alerts and/or be integrated with any standard
Security Information and Event Management (SIEM) solution via Syslog.

6. Forensic Analysis: The Forensic Analysis add-on enables the security team to use the various options provided by
the FortiEDR Central Manager console to delve deeply into the actual security event and the internal stack data that
led up to it.

Using FortiEDR - WorkFlow

The following is a general guideline for the general workflow of using FortiEDR and specifies which steps are optional.

Setup Workflow Overview

The following describes the workflow for getting FortiEDR up and running in your organization:

1. Installing: Install all FortiEDR components, as described in Installing FortiEDR on page 19 and Launching the
FortiEDR Central Manager for the First Time on page 21.

2. Reviewing the Inventory: Review the health status and details of all the FortiEDR components in the Dashboard
on page 121 and Inventory on page 99 FortiEDR Collectors are automatically assigned FortiEDR’s default policies.
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3. [Optional] Modifying the FortiEDR Policies: By default, the FortiEDR policies are ready to log out-of-the-box. If
needed, use the Security Settings on page 54 to modify the default policies for blocking and/or to create additional
policies.

4. [Optional] Defining Collector Groups: By default, the FortiEDR default policies are assigned to a default
Collector Group that contains all FortiEDR Collectors. Policies in FortiEDR are assigned per Collector Group. You
can define additional Collector Groups in Inventory on page 99. You can then assign the required policy to each
Collector Group (see Assigning a Security Policy to a Collector Group on page 61)

5. [Optional] Administration: The FortiEDR system installs with a single administrator user. This user can:
l Create additional users of the FortiEDR Central Manager.
l Define the recipients to receive email notifications of FortiEDR events.
l Configure a SIEM to receive notifications of FortiEDR events via Syslog.

Ongoing Workflow Overview

The following is the workflow for monitoring and handling FortiEDR security events on an ongoing basis:

l Monitoring: Monitor and analyze the events triggered by FortiEDR in the:
o Dashboard on page 121
o Event Viewer on page 134
o Syslog on page 289

l [Optional] Creating Event Exceptions: FortiEDR precisely pinpoints interesting system events. However, if
needed, you can create exceptions in order to stop certain events from being triggered for certain IP addresses,
applications, protocols and so on. See Playbook Policies on page 89.

l [Optional] Handling Events: Mark security events that you have handled and optionally describe how they were
handled. See Marking a Security Event as Handled/Unhandled on page 143.

l [Optional] Forensics (page 153): This licensed add-on enables deep investigation into a security event, including
the actual internals of the communicating devices’ operating system.
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Installing FortiEDR

This chapter describes how to install each of the FortiEDR components

Before You Start

Before you start the FortiEDR installation process, please make sure that:

l All devices, workstations, virtual machines and servers on which a FortiEDR component will be installed comply
with the system requirements provided on Installing FortiEDR on page 19.

l You have read and selected the most suitable deployment option for you.
l FortiEDR Core, FortiEDR Aggregator and FortiEDR Central Manager use ports 555, 8081 and 443, respectively.
Ensure that these ports are not blocked by your firewall product (if one is deployed).
If the FortiEDR Aggregator and FortiEDR Central Manager are installed separately, port 8091 is used by the
Aggregator to communicate with the Manager.
As a security best practice, it is recommended to update the firewall rules so that they only have a narrow opening.
For example:
o Only open the TCP outbound port 555 to the Core IP address.
o Only open the TCP outbound port 8081 to the Aggregator IP address.
o Only open TCP outbound port 8091 to the Central Manager IP address to be accessed by the Aggregator when
the Aggregator is installed on premise, while the Central Manager is in the Cloud.

The default deployment mode of FortiEDR backend components is in the cloud and is provided by Fortinet. Cloud
components are installed for you by Fortinet.

If you require that the FortiEDR Threat Hunting Repository, Central Manager, Aggregator, or Core would be deployed on
your organization’s premises (on-premises), see Appendix C, On-Premise Deployments in Appendix C – ON PREMISE
DEPLOYMENTS on page 383.

System Requirements

Component System Requirements

Processor l The FortiEDR Collector runs on Intel or AMD x86 – both 32-bit and 64-bit and
on Apple M1 (ARM) hardware.

l FortiEDR Core, FortiEDR Aggregator and FortiEDR Central Manager run on
Intel or AMD x86 64-bit.

l FortiEDR is designed to use less than 1% CPU for the FortiEDR Collector.
l FortiEDR Aggregator and Central Manager require a minimum of four CPUs.
l FortiEDR Core requires a minimum of four CPUs.
l FortiEDR Core running as a Jumpbox requires two CPUs.

Physical Memory l FortiEDR Collector requires at least 60 MB of RAM.
l FortiEDR Core requires at least 16 GB of RAM.
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Component System Requirements

l FortiEDR Core running as a Jumpbox requires 4 GB of RAM.
l FortiEDR Aggregator requires at least 16 GB of RAM.
l FortiEDR Central Manager requires at least 16 GB of RAM.

Disk Space l FortiEDR Collector installation requires at least 20 MB of disk space.
l FortiEDR Core requires an SSD disk with at least 80 GB of disk space. For a
Threat Hunting license, each 1k of Collectors, over and above the first 1k,
require an additional 45 GB.

l FortiEDR Core running as a Jumpbox requires 50 GB of disk space (non-
SSD).

l FortiEDR Aggregator installation and logs space requires at least 80 GB of
disk space.

l FortiEDR Central Manager installation and logs space requires at least 150
GB of disk space (SSD).

Threat Hunting Repository l The number of required CPUs (Cores) depends on the number of seats and
the required Threat Hunting data retention. A minimum of 16 CPUs is
required for a month’s worth of retention with a default Collection profile for
4k FortiEDR Collectors. The addition of each 2k of Collectors requires an
additional 6 CPUs.

l Disk Size:
o OS disk: 50 GB
o Requires an SSD disk - Minimum of 1.5 TB of available space for a
month’s worth of retention with a default Collection profile for 4k
FortiEDR Collectors. The addition of each 2k of Collectors requires an
additional 1.1 TB.

o Note that in the case of installing in Hyper-V: disk should be IDE
l Minimum of 1.5 TB of available space for a month’s worth of retention with a
default Collection profile for 4k FortiEDR Collectors. The addition of each 2k
of Collectors requires an additional 1.1 TB.

l Memory: At least 32 GB are required for a month’s worth of retention with a
default Threat Hunting data Collection profile for 4k FortiEDR Collectors. The
addition of each 2k of Collectors requires an additional 6GB of memory.

l For the specifications required for supporting more than 10k Collectors,
please contact Fortinet Support.

Connectivity l FortiEDR Core listens to communication on port 555.
l FortiEDR Aggregator listens to communication on port 8081.
l FortiEDR Central Manager listens to communication from the Aggregator on
port 8091.

l Browser connection to the FortiEDR Central Manager is via port 443.
l FortiEDR Threat Hunting Repository listens to communication from the Core
on port 32100, 32001

l FortiEDR Threat Hunting Repository listens to communication from the
Central Manager on port 8095

l FortiEDR Core, FortiEDR Aggregator and FortiEDR Central Manager
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Component System Requirements

components must be assigned a static IP address or domain name. The
FortiEDR Aggregator and FortiEDR Central Manager can be installed on the
same machine.

l Network connectivity between all system components is required.
l Allow up to 5 Mbps of additional network workload for each 1,000 Collectors.

Supported Operating Systems The FortiEDR Collector can be installed on any of the following operating systems
(both 32-bit and 64-bit versions):
l Windows XP SP2/SP3, 7 SP1, 8, 8.1, 10, and 11.
l Windows Server 2003 SP2, R2 SP2, 2008 SP2, 2008 R2 SP1, 2012, 2012
R2, 2016, 2019, and 2022.

l MacOS Versions: El Capitan (10.11), Sierra (10.12), High Sierra (10.13),
Mojave (10.14), Catalina (10.15), Big Sur (11), Monterey (12), and Sonoma
(14).

l Linux Versions: RedHat Enterprise Linux and CentOS 6.8+, 7.2+ and 8+,
Ubuntu LTS 16.04.5+, 18.04 and 20.04 server, 64-bit, Oracle Linux 6.10,
7.7+, and 8.2+, Amazon Linux AMI 2 2018 and SUSE Linux Enterprise
Server SLES v15. The complete list of supported Linux versions and kernels
is updated regularly and can be provided upon request.

l VDI Environments: VMware Horizons 6 and 7 and Citrix XenDesktop 7.
l The FortiEDR Core, Repository Server, FortiEDR Aggregator and FortiEDR
Central Manager components are supplied in ISO format, which includes a
CentOS 7 image. FortiEDR Core, FortiEDR Aggregator and FortiEDR
Central Manager can be installed on a virtual machine or a dedicated
workstation or server.

Supported Browsers The FortiEDR Central Manager console can be accessed using the Google
Chrome, Firefox Mozilla, Microsoft Edge and Apple Safari browsers.

Launching the FortiEDR Central Manager for the First Time

The procedure below enables you to define passwords. No passwords are provided by Fortinet.

1. Use any standard Internet browser to connect securely (via https://) to the IP address and port of the machine on
which the FortiEDR Central Manager is installed, as follows:
a. https://<machine_IP_addess>/
b. Default port is 443
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2.

Define the first administrator user to be allowed to log into the FortiEDRManager by filling in the First Name, Last
Name, Email Address, and Define administrator user name fields.

3. Enter and confirm the password to be used by this administrator user.
4. In the DEVICE REGISTRATION PASSWORD fields, enter and confirm the password to be used to install all

FortiEDR Collectors, FortiEDR Aggregators and FortiEDR Cores. This same password must be used by all.

Write this password down in a good place. This password will be needed each time a
FortiEDR component is installed.

5. Click the LOGIN button. The regular FortiEDR Central Manager Login page is then displayed, as shown below. The
page that displays varies, depending on whether the FortiEDR system is set up as a single organization or multi
organization system.

l The FortiEDR system can be set up as a single-organization or multi-organization
system. In a multi-organization system, all users except an Administrator user must
specify the organization in the Organization Name dropdown list. If a user is defined
for an organization, then he/she can log in to that organization. Otherwise, he/she
cannot.
For more details about logging in to a multi-organization system, see Step 1 – Logging
In to a Multi-organization System on page 340.

6. Enter the administrator user name and password you have just defined and click the LOGIN button. All fields are
case sensitive. The following window displays automatically the first time you log into the FortiEDR Central
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Manager:

7. Send the displayed Installation ID to FortiEDRAdmin@fortinet.com by email in order to receive a license string from
Fortinet.

8. Click the Load New License button. The following window displays:

9. Copy/paste the license string that you received by email into the LOAD NEW LICENSE window and click the Load
License button. The following displays showing the relevant licensed entitlements:
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Field Description

Installation ID Specifies the unique identifier that is automatically generated upon installation
of the ForitEDRManagement server. You may be asked to provide this ID and
the Name field when contacting Fortinet for support.

Name Specifies the name of the organization in a multi-organization FortiEDR
system. For more details, see Multi-tenancy (Organizations) on page 338.

Expiration Date Specifies when this license expires. Notifications will be sent to you
beforehand.

License Type Specifies whether the Discover, Protect and Response license, Discover
and Protect license, or Protect and Response license was purchased. The
license type defines the availability of the relevant add-ons.

Communication Control Specifies the word Available if the Communication Control add-on is included
in the license.

eXtended Detection Specifies the word Available, when the eXtended Detection add-on is
included in the license.

Forensics Specifies the word Available if the Forensics add-on (described in Forensics
on page 204 is included in the license.

Threat Hunting Specifies the word Available if the Threat hunting add-on (described in Threat
Hunting on page 222) is included in the license. It also specifies whether
Repository add-ons have been purchased and how many have been.

Content Updates Specifies the word Available if the Content Updates add-on is included in the
license. This add-on enables you to automatically receive the latest FortiEDR
policy rule and built-in exception updates.
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Field Description

The system arrives with the latest content pre-installed.
There is no need to install content during the initial
installation.

The button enables you to update content, as well as to update the
Collector version on any existing Collector.

To load content updates on your FortiEDR system, click the button
and then select the content file to load. In a multi-tenant environment, the

button is available in Hoster View .
If the content file contains a Collector update, you can update all Collectors
with the new version at that time, or choose to do so later.

Click the button to update the version for all Collectors.

Vulnerability Management Specifies the word Available if the Vulnerability Management add-on
(described in Administration on page 252) is included in the license.

License Capacity Specifies the number of available licenses for protection by FortiEDR
Collectors (for workstations and servers). Only the number of FortiEDR
Collectors allowed by the license can register with the FortiEDR Central
Manager. Additional FortiEDR Collectors are not registered with the FortiEDR
Central Manager. In addition, the number of IoT devices specified under the
License Capacity determines whether or not IoT Discovery is available (zero
number).
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Field Description

In Use Specifies the number of FortiEDR licenses for workstations and servers that
are currently in use. In addition, it specifies the number of IoT devices detected
in the system thus far.

Remaining Specifies the number of FortiEDR licenses for workstations and servers that
are still available for use.

Regarding questions about the number of licenses purchased, you may contact Fortinet Support.

The FortiEDR Central Manager Server and console are now fully operational.

Installing FortiEDR Collectors

Preparing for FortiEDR Collector Installation

The communicating device on which the FortiEDR Collector will be installed, must meet the following requirements:

l Complies with the requirements described in the System Requirements section on Installing FortiEDR on page 19.
l Has connectivity to a Local Area Network (for wired users) or a Wireless Network (for wireless users). If there is no
connectivity, consult your IT support person.

l Has connectivity to the FortiEDR Core and the FortiEDR Aggregator. You can check this by browsing to the Core’s
IP address and the Aggregator’s IP address. For problems connecting, see Troubleshooting on page 336.

l Has connectivity to the FortiEDR Reputation Server at 35.186.218.233.
l If the FortiEDR Core is deployed on your organization’s premises (on-premises) and you use a web proxy to filter
requests, then before running the installer, set the system proxy to work with an HTTPS connection, as follows:
o Edit the file /etc/environment to have a proxy address configuration, https_proxy or PAC address.
For example: https_proxy=https://192.168.0.2:443
(for PAC): https_proxy=pac+http://192.168.200.100/sample.pac, where the sample.pac file
contains an HTTPS address of the proxy.

o If the definitions of the system proxy are placed somewhere other than /etc/environment, then:
n Copy the definitions to the file /etc/environment. Note that this affects all processes on the Linux system.
n Define a specific environment variable for the FortiEDR Linux Collector with the name nslo_https_proxy

at the file /etc/environment
For example: nslo_https_proxy=https://192.168.0.2:443
(for PAC): nslo_https_proxy=pac+http://192.168.200.100/sample.pac

Note:For more details about installing a Core in a multi-organization environment, Core Registration on page 340.
Note: You can get a Collector that is customized to your environment’s settings, see Requesting and Obtaining a
Collector Installer on page 256. If a custom Collector is used during the installation, all input fields such as
Aggregator address and registration password are auto-filled.

Installing a FortiEDR Collector

Only the number of FortiEDR Collectors allowed by the license can register with the FortiEDR Central Manager.

Additional FortiEDR Collectors cannot register with the FortiEDR Central Manager.
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You can uninstall a FortiEDR Collector from a device and then delete it from the FortiEDR INVENTORY (Deleting a
Collector Group/Collector on page 106) if you would like to add another FortiEDR Collector.

When a user attempts to uninstall the Collector from aWindows OS device, he/she must supply the registration
password.

In order to stop the FortiEDR service from running on aWindows OS device, enter the following command:

C:\Program Files\Fortinet\FortiEDR\FortiEDRCollectorService.exe --stop and then provide the registration
password in the pop-up windows.

Installing a FortiEDR Collector on Windows

1. Run the FortiEDR Collector installation file. Use the FortiEDRCollectorInstaller32.msi file if you are using a 32-bit
operating system; or use the FortiEDRCollectorInstaller64.msi file if you are using a 64-bit operating system.

2.

Click Next.
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3.

Leave the default FortiEDR Collector installation folder or change it as necessary. Click Next.
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4.

In the Aggregator Address field, specify the FortiEDR Aggregator domain name or IP address.
5. In the Port field, specify the FortiEDR Aggregator port (8081)

When upgrading a FortiEDR Collector, the Aggregator address field can be left empty – in
order to retain the previously defined Aggregator address.

6. In the Registration Password field, enter the device registration password that you defined, as described in
Launching the FortiEDR Central Manager for the First Time on page 21.

7. For a multi-organization FortiEDR system, enter the name of the organization in theOrganization field. For more
details, see the Collector Registration on page 339.

8. If you are installing the Collector on a VDI environment, check the VDI checkbox. For more details, see Working with
FortiEDR on VDI Environments on page 49.

9. If you use a web proxy to filter requests in this device’s network, then check the Use System Proxy Settings
checkbox. Note that Windows must be configured to use a proxy and tunneling must be allowed from the Collector
to the Aggregator on port 8081 and from the Collector to the Core on port 555. (Run as Administrator: netsh
winhttp set proxy <proxy IP >).

10. If you are installing the Collector on a Citrix PVS golden image, check the Citrix PVS installation checkbox.
11. Click Next twice to start the installation. Windows may possibly display a message requesting that you confirm the

installation. Please do so.
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12. After the installation of the FortiEDR Collector has been successfully completed, the following window displays:

Check Windows Services to verify that the FortiEDR Collector Service is running, as shown below:

13. Verify that the FortiEDR Collector details are listed in the INVENTORY tab of the FortiEDR Central Manager
console (see Inventory on page 99. Select the New filter to display a list of newly registered FortiEDR Collectors, as
shown below:
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Installing a FortiEDR Collector on a Mac Operating System

To install a FortiEDR Collector on a Mac operating system that is running with Big Sur (version
11) or above:

The process described below includes a description of how to allow the following upon first FortiEDR Collector
installation:

l System Extensions
l Network Extensions
l Full Disk Access

IMPORTANT: Failure to add these permissions will result in incomplete protection.

Deployment can also be managed using an MDM, such as Jamf.

1. Double-click the *.dmg file named FortiEDRCollectorInstallerOSX_4.1.x.dmg.
2.

Click Continue.
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3.

Click Install. Enter the Mac password at the prompt.
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4.

In the Collector Conifguration page, specify the Aggregator's address and FortiEDR registration password.
Optionally, you can select a desitination Organization and Collector Group and/or installation using a system proxy.

5. Click Apply to start the installation process.
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6. Perform the following during installation:
a. Enable Network and System Extensions, shown below:

i. Open Security Preferences.
ii. Click the lock at the bottom of the window in order to make changes.
iii. In the General tab, click Details.
iv.
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Mark both checkboxes in order to allow FortiEDR to use Netword and System Extensions.
v. Click OK in the System Extension BlockedWindow.

b. Enable Full Disk Access by performing the following:
i. Open Security Preferences.
ii. Click the lock at the bottom of the window in order to make changes.
iii. In the Privacy tab, select Full Disk Access from the left pane.
iv. Mark the checkboxes of both the FortiEDRCollector (FortiEDR in MacOS v11.3 and below) and the

FortiEDR_EndPoint applications:

v. If that FortiEDR application does not display on this page, click the + button.
vi.

Click Applications, select FortiEDR and then clickOpen.
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7.

In the popup window, click Later.
8.

Click Allow.
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9.

ClickOK.
10. Click Close to complete the process.
11. When prompted to allow FORTIEDRTRAY notifications, click Allow

12. Reboot the device.
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13. You can run the following command to check the status of the Collector:

/Applications/FortiEDR.app/fortiedr_collector.sh status

To install a FortiEDR Collector on a Mac- operating system with versions prior to Big Sur (11),
such as Catalina or Mojave:

1. Double-click the *.dmg file named FortiEDRCollectorInstallerOSX_1.3.0.xxx.dmg.
2.

Double-click the *.pkg file named FortiEDRCollectorInstallerOSX_1.3.0.xxx.pkg
3.

Click Continue
4. Select the destination disk and click Continue
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5.

Specify the installation location and click Install
6.

In the Aggregator Address field, enter the IP address of the Aggregator in the first box and the port of the
Aggregator in the adjacent (Port) box.

7. In the Registration Password field, enter the registration password as described in Launching the FortiEDR Central
Manager for the First Time on page 21.

8. Leave the Organization field empty or for a multi-tenant setup, insert the organization to which this Collector belongs
(as it appears under the ADMINISTRATION > ORGANIZATIONS tab of the FortiEDR Central Manager).

9. If you use a web proxy to filter requests in this device’s network, then check the Use System Proxy Settings
checkbox. Note that the MacOSmust be configured to use a proxy and that the proxy must support HTTPS before
installing the Collector (System Preferences > Network > Advanced > Proxies).

10. Click Apply.
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11.

Click Close.

Installing a FortiEDR Collector on Linux

To install a customized FortiEDR Collector on Linux:

1. Copy the custom Linux Collector installer zip file, FortiEDRSilentInstall_5.1.0.195_envname_Tenant.zip to the
device. This file was downloaded from the provided link as described in Requesting and Obtaining a Collector
Installer on page 256.

2. Unzip using the following command:

sudo unzip ./FortiEDRSilentInstall_5.1.0.195_envname_Tenant.zip

If you don’t have zip software on the device, install it using:

yum install zip

3. Extract the installer using the following command:

sudo gunzip ./FortiEDRSilentInstall_5.1.0.195_envname_Tenant.sh.gz

4. Change the installation script permission with the following command:

chmod 755 FortiEDRSilentInstall_5.1.0.195_envname_Tenant.sh

5. Run the following to execute the installation script:

sudo ./FortiEDRSilentInstall_5.1.0.195_envname_Tenant.sh
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To install a non-customized FortiEDR Collector on Linux:

1. Run the FortiEDR Collector installation file for 64-bit servers using the following command:
l CentOS/RHEL/Oracle/AMI:
sudo yum install ./FortiEDRCollectorInstaller_%Linux_distribution%-%version_number%.x86_64.rpm
For example, sudo yum install ./FortiEDRCollectorInstaller_CentOS6-3.1.0-74.x86_64.rpm.

l Ubuntu:
sudo apt-get install ./FortiEDRCollectorInstaller_Ubuntu-%version_number%.deb
For example, sudo apt-get install ./FortiEDRCollectorInstaller_Ubuntu-3.1.0-74.deb.

l SUSE Linux:
rpm --import RPM-GPG-KEY.key
The FortiEDR PGP key is included in the download link of the pre-populated installer, see theRequesting and
Obtaining a Collector Installer on page 256.
zypper install FortiEDRCollectorInstaller_%distribution% -%version_number%.rpm
For example: zypper install FortiEDRCollectorInstaller_openSUSE15-4.5.0-88.x86_64.rpm

2. After the installation is completed, run the following:

sudo /opt/FortiEDRCollector/scripts/fortiedrconfig.sh

3. Specify the FortiEDR Aggregator domain name or IP address.
4. Enter the FortiEDR Aggregator port information (usually 8081).
5. For a multi-tenant setup, enter the organization. Otherwise, leave the organization empty.
6. Enter Collector Group information or leave empty to be registered to the default Collector Group.
7. Enter the device registration password, described in Launching the FortiEDR Central Manager for the First Time on

page 21.
8. At the Do you want to connect via proxy (Y/N)? prompt, type Y if your setup includes a web proxy. For more

details see Installing FortiEDR Collectors on page 26.
9. 9 If your software distribution system does not allow the addition of specific parameters to the command, you can

use the custom FortiEDR Collector installer, which can be accessed via the Central Manager Console using the
required DNS or IP address and password that is already embedded inside. For more details, see Requesting and
Obtaining a Collector Installer on page 256.

Note – Installation of the FortiEDR Linux Collector on a VM that is running other components of FortiEDR such as Core or Aggregator requires adding a special

hidden configuration. Contact Fortinet Support for more assistance.

Automated FortiEDR Collector Deployment

Automated FortiEDR Collector Deployment on Windows

FortiEDR can be installed automatically via any software installation and distribution system.
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To deploy a FortiEDR Collector via a command line:

1. Use the following command syntax:

msiexec /i FortiEDRCollectorInstaller64.msi /qn AGG=10.0.0.1:8081 PWD=1234

For example, to install a FortiEDR Collector on a 64-bit machine, connect it to a FortiEDR Aggregator on IP address
10.0.0.1 and use the device registration password 1234, enter the following command:

msiexec /i FortiEDRCollectorInstaller64.msi /qn AGG=10.0.0.1:8081 PWD=1234

You can specify which Collector Group to assign this Collector to by adding the DEFGROUP parameter. This
parameter is optional. When you specify this parameter, the first time that this Collector registers with the system, it
is automatically assigned to the Collector Group specified by the DEFGROUP parameter.
For example, to install a FortiEDR Collector on a 64-bit machine, connect it to a FortiEDR Aggregator on IP address
10.0.0.1, use the device registration password 1234, use the DEFGROUP parameter and enter the following
command:

msiexec /i FortiEDRCollectorInstaller64.msi /qn AGG=10.0.0.1:8081 PWD=1234 DEFGROUP=server

Note: The name of the Collector MSI file may be different.
For Collectors version 3.0.0 and above, you can set a designated group and/or organization. To do so, enter the
following command:

./CustomerBootstrapGenerator --aggregator [IP] --password '[PASSWORD]' --organization '
[ORGANIZATION]' --group '[GROUP]' > CustomerBootstrap.js

2. Using web proxy can be configured for Collectors version 3.0.0 and above. To do so, append the parameter
PROXY=1 to the command syntax shown above.

3. In general, a FortiEDR Collector does not require the device on which it is installed to reboot after its installation.
However, in some cases, you may want to couple the installation of the FortiEDR Collector with a reboot of the
device. To do so, append the parameter NEEDREBOOT=1 to the command syntax shown above.
Collectors that are installed with this flag appear in the FortiEDR Central Manager as Pending Reboot (page 87) and
will not start operating until the after the device is rebooted.
Note:In general, rebooting the device after installing a FortiEDR Collector is good practice, but is not mandatory. Rebooting may prevent a threat actor

from attempting to exfiltrate data on a previously existing connection that was established before installation of the FortiEDR Collector.

4. When installing on a Citrix PVS golden image, append the parameter CITRIXPVS=1 to the command syntax shown
above.

5. If your software distribution system does not allow the addition of specific parameters to the command, you can use
the custom FortiEDR Collector installer, which can be accessed via the Central Manager Console using the
required DNS or IP address and password that is already embedded inside. For more details see Requesting and
Obtaining a Collector Installer on page 256.
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Automated FortiEDR Collector Deployment on Mac

To deploy a custom FortiEDR macOS Collector via a command line:

1. Get a pre-populated customized Collector installer for macOS as described in Requesting and Obtaining a Collector
Installer on page 256.

2. Run the following command in order to install using the specified settings:

sudo installer -pkg <package path> -target /

For example, if the package file is FortiEDRInstallerOSX_2.5.2.38.pkg, use the following command:

sudo installer -pkg ./FortiEDRInstallerOSX_2.5.2.38.pkg -target /

To deploy a non-customized FortiEDR macOS Collector via a command line:

Run the following command line to generate the settings file:

./CustomBootstrapGenerator --aggregator [IP] --password [PASSWORD] > CustomerBootstrap.jsn

If the Aggregator port is different than 8081 (which is set by default), you can add the following:

./CustomBootstrapGenerator --aggregator [IP] --password [PASSWORD] --port 8083 >
CustomerBootstrap.jsn

The following are optional parameters that can be used with the custom installer generator:

l If the Collector should be part of a designated Collector Group, use --group ‘[GROUP]’.
l For a multi-tenant setup, the organization to which this device belongs to can be added using

--organization ‘[ORGANIZATION]’

l If a web proxy is being used to filter requests in this device’s network, use

 --useProxy '1'

The following is an example that includes all optional parameters:

./CustomBootstrapGenerator --aggregator [IP] --password [PASSWORD] --useProxy '1' --organization
‘[ORGANIZATION]’ --group ‘[GROUP]’ > CustomerBootstrap.jsn
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Automated FortiEDR macOS Collector deployment on Big Sur operating system devices with
MDM

When distributed with MDM solutions such as Jamf, FortiEDR can be allowlisted with the following Team ID and Bundle
ID identifiers:

l A97R6J3L29 com.ensilo.ftnt
l A97R6J3L29 com.ensilo.ftnt.sysext

Installing FortiEDR on Mac Big Sur Devices using Jamf PRO

To install FortiEDR on Mac Big Sur devices using Jamf PRO:

1. In jamf PRO, navigate to Computers > Configuration Profiles > New.
2. Create a configuration profile as shown in the screenshots below:
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A sample Jamf profile for upload can be provided upon request.

Working with FortiEDR on VDI Environments

The FortiEDR Collector must only be installed on the master image (not on a clone) of the VMware Horizon or Citrix
XenDesktop in order to ensure that the virtual environment is protected. On Citrix, it is also recommended to install the
Collector on the Windows servers that run the entire Citrix platform.

When installing the Collector, set the VDI-designated installation flag. To do so, append the parameter VDI=1 to the
command syntax shown above or check the VDI checkbox in the installation wizard, as shown in Installing FortiEDR
Collectors on page 26.

When installing on a Citrix PVS golden image, append an additional parameter CITRIXPVS=1 to the command syntax
shown above.

After the Collector is successfully installed and running on the golden image and before the image is being cloned, the
FortiEDR Collector configuration must be erased such so that cloned images will not show up as the same Collector on
the Central Manager console. To do that so, run the following command as an administrator:

FortiEDRCollectorService.exe --stop --clean

In VDI installations where VDI pools are used, there is no need to generate Collector groups in the user interface. Any
newly generated virtual desktop is automatically assigned to the default VDI Collectors group. Upon first user login to the
virtual desktop, FortiEDR automatically generates a Collector group that corresponds with the respective pool name, as
specified in VMware Horizon. Any Collector that is installed on a virtual desktop that is part of this pool is automatically
assigned from the default VDI Collectors group to the corresponding Collector group, regardless of whether the pool
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definition in VMware is dedicated or floating. In effect, Collector groups in the FortiEDR user interface are a copy of the
virtual machines’ pool on VMware Horizon or Citrix.

Any newly created Collector group is automatically assigned to an out-of-the-box predefined policy. This mechanism
ensures that any newly created virtual machine is automatically and immediately protected by a unique instance of the
FortiEDR Collector.

IMPORTANT:When using FortiEDR automatic updates to Collectors via the Central Manager, make sure to update the
master image too. Otherwise, every time that a new environment is created from the master image, an automatic update
is performed, which can overload network traffic.

Uninstalling FortiEDR Collectors

You can uninstall a FortiEDR Collector using the following methods:

l From the Central Manager INVENTORY > Collectors page

This method is recommended for Windows, Linux, and macOS 10.11 to 10.15.

For macOS 11 or later, due to a macOS design limitation, this method does not remove the
FortiEDR Collector system extension, which can only be uninstalled using an MDM
solution.

l Through the operating system’s application management (for example, Add or Remove Programs onWindows)
l Using dedicated FortiEDR scripts

The following section describes how to uninstall a FortiEDR Collector with Fortinet scripts.

Windows

Uninstall the Collector by running either of the following commands as administrator. Replace REGPWD with the
registration password used for the installation, which is available in Component Authentication on page 295.

l msiexec.exe /x GUID /qn UPWD=REGPWD RMCONFIG=1 /l*vx log.txt

ReplaceGUID with the FortiEDR uninstallation product key, which can be found by following the steps below:
a. Select Start >> Run.
b. Type regedit to open the Registry Editor window.
c. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\.
d. Expand the Uninstall subkeys in the left-hand pane and search for "FortiEDR" to locate the subkey for

FortiEDR.
e. Open the FortiEDR subkey and copy the UninstallString value in the right pane, for example, {01C88AE6-

6782-4798-81C6-954E0D14FCF5}.
f. Close the Registry Editor window.

l msiexec /x FortiEDRCollectorInstaller_X.msi /qn UPWD=REGPWD RMCONFIG=1

You must run this command from same directory as the msi installer. Or you can replace the msi filename with the
full path to the msi file, such as C:\Users\Allen\Desktop\FortiEDRCollectorInstaller64_
4.1.0.491.msi, which allows you to run the command anywhere.
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macOS

To uninstall the Collector on macOS with versions prior to Big Sur (11), such as Catalina or Mojave:

sudo /Library/FortiEDR/fortiedr_uninstaller.sh 'REGISTRATION PASSWORD'

It is good practice to use REGISTRATION PASSWORD wrapped with single quotes so that it
is interpreted correctly by the shell. For example,

sudo /Library/FortiEDR/fortiedr_uninstaller.sh '!EPdzv30break'

To uninstall the Collector on macOS with Big Sur (version 11) or above:

/Applications/FortiEDR.app/fortiedr_uninstaller.sh 'REGISTRATION PASSWORD'

Linux

Uninstalling a Linux Collector removes all configuration files. You must reconfigure all settings
after installing a new Linux Collector.
If you are uninstalling a non-customized Linux Collector installer and would like to retain the
configuration for later use, Fortinet recommends that you upgrade the Linux Collector instead
of uninstalling the current Collector and re-installing a new one. However, you cannot perform
an upgrade on a custom Linux Collector.

To uninstall a Collector on Linux:

1. Check the status of the Collector using the following command:

/opt/FortiEDRCollector/control.sh --status

The Collector should be stopped before running the uninstall command.
2. If the status is not stopped, stop the Collector using the following command:

 /opt/FortiEDRCollector/control.sh --stop <registration password>

For example:

/ opt/FortiEDRCollector/control.sh --stop 12345678
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3. Uninstall the Collector using the following command:
l CentOS, RHEL, Oracle, AMI, SLES:

o

yum remove <package name>

OR

o

rpm -qa | grep fortiedr | xargs rpm –e

l Ubuntu:

sudo dpkg --purge fortiedrcollectorinstaller

Upgrading FortiEDR Components

If your FortiEDR Threat Hunting Repository, Central Manager, Aggregator or Core are deployed on your organization’s
premises (on-premises), see to Appendix C – ON PREMISE DEPLOYMENTS on page 383

Upgrading the Collector

After a Collector has been installed in the system, you can upgrade it using one of the following methods:

l Using the Load Content option, see Content Updates in step 9 of Launching the FortiEDR Central Manager for the
First Time on page 21

l As described in the procedure below.

You can use whichever method you prefer.

To upgrade the Collector manually (not via the user interface):

Windows

1. Copy the FortiEDRCollectorInstallaler32_x.x.x.xxx.msi or
FortiEDRCollectorInstallaler64_x.x.x.xxx.msi file (as appropriate) to the Collector machine. For
example, FortiEDRCollectorInstallaler32_2.0.0.330.msi or
FortiEDRCollectorInstallaler64_2.0.0.330.msi.

2. Double-click the FortiEDRCollectorInstallaler32_x.x.x.xxx.msi or
FortiEDRCollectorInstallaler64_x.x.x.xxx.msi file and follow the displayed instructions.

Linux

You can only manually upgrade non-customized Linux Collectors. For custom Linux
Collectors, you must first uninstall the current Collector and then install a new one, which
requires reconfiguration.
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To upgrade a non-customized Collector on Linux:

1. Check the status of the Collector using the following command:

/opt/FortiEDRCollector/control.sh --status

The Collector should be stopped before running the upgrade command.
2. If the status is not stopped, stop the Collector using the following command:

 /opt/FortiEDRCollector/control.sh --stop <registration password>

For example:

/ opt/FortiEDRCollector/control.sh --stop 12345678

3. Copy the installer file to the Collector machine (either FortiEDRCollectorInstaller_Linux_
distribution-version_number.x86_64.rpm or FortiEDRCollectorInstaller_Ubuntuversion_
number.deb).

4. Upgrade the Collector using the following command:
l CentOS/RHEL/Oracle/AMI:

sudo yum install FortiEDRCollectorInstaller_Linux_distribution-version_number.x86_64.rpm

l Ubuntu:

Ubuntu: Run sudo apt install FortiEDRCollectorInstaller_Ubuntu-version_number.deb

l SLES:

zypper install FortiEDRCollectorInstaller_distribution-version_number.rpm

5. Enter y when asked if you want to upgrade.
6. After the upgrade is complete, start the Collector using the following command:

/opt/FortiEDRCollector/control.sh --start
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Security Settings

This chapter describes FortiEDR security policies and Playbook policies for defining, monitoring and handling FortiEDR
security.

Security Events

FortiEDR Security Policies

The most powerful proprietary feature of the FortiEDR platform is its predefined and configurable security policies.

To access the FortiEDR Security Policies page, click the down arrow next to SECURITY SETTINGS > Security Events
> Security Policies.

Out-of-the-box Policies

FortiEDR provides the following out-of-the-box policies:

l Execution Prevention: This policy blocks the execution of files that are identified as malicious or suspected to be
malicious. For this policy, each file is analyzed to find evidence for malicious activity. One of the following rules is
triggered, based on the analysis result:
o Most Likely a Malicious File: A Malicious File Execution rule is triggered with a critical severity. By default,
the file is blocked.

FortiEDR 5.1.0 Administration Guide 54
Fortinet Inc.



Security Settings

o Probably a Malicious File: A Suspicious File Execution rule is triggered with a high severity. By default, the
file is blocked.

o Show Evidence of Malicious File: An Unresolved file rule is triggered with a medium severity. By default, the
file is logged, but is not blocked.

l Exfiltration Prevention: This policy enables FortiEDR to distinguish which connection establishment requests are
malicious ones.

l Ransomware Prevention: This policy enables FortiEDR to detect and block malware that prevents or limits users
from accessing their own system.

l Application Control: This policy enables FortiEDR to block user-defined applications from running, so that they do
not launch. Blocklist management is done on the Application Control Manager page, see page 57 for more details.

l Device Control: This policy enables FortiEDR to detect and block the usage of USB devices, such as USBmass
storage devices. In this policy, detection is based on the device type. This feature is a license-dependent and
requires the Vulnerability Management add-on (meaning License Type that is either Discover and Protect or
Discover, Protect and Response.

l eXtended Detection Policy: This policy provides visibility into data across multiple security systems and identifies
abnormal or malicious activity by applying analytics and correlating data from various systems. This policy requires
that you configure an XDR source connector in the ADMINISTRATION > INTEGRATIONS section. This feature is a
license-dependent add-on. You may contact Fortinet Support for more information.
Note: The Extended Detection policy provides detection features (meaning that events are logged and displayed in
the Event Viewer). No blocking options are provided. The exceptions and forensics options are not available in the
Event Viewer for security events triggered by the Extended Detection policy.

l Note: You will receive one or all policies, depending on your FortiEDR license.

FortiEDR security policies come with multiple highly intelligent rules that enforce them.

The Exfiltration Prevention, Ransomware Prevention, Application Control, Device Control, Execution Prevention and
eXtended Detection security policies can run simultaneously.
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When multiple security policies are used, they do not generate duplicate security events:
l Exfiltration Prevention rule violation is detected when there is a connection establishment
attempt.

l Ransomware rule violation is detected when there is an attempt to lock files or access
their data (for example, by encrypting the data).

l Execution Prevention rule violation is detected when a malicious file is being executed by
the user or by the operation system.

l Device Control rule violation is detected when there is an attempt to use a USB device,
such as a mass storage device. It is supported onWindows devices only.

l Application Control rule violation is detected when there is an execution attempt of an
application that is included in the blocklist.

l An Extended Detection rule violation is detected when malicious activity is identified
across network, endpoints and cloud.

Thus, these security policies detect rule violations at different places and points in time in the
operating system. Device control and Application Control security events are displayed under
dedicated Device Control or Application Control filters in the Events page and are not listed
as part of the All filter.

Protection or Simulation Mode

During an initial acquaintance period or at any time, you can decide that FortiEDR acts as either of the following:

l Protection: FortiEDR enforces its active exfiltration prevention policy that blocks all connections that violate the
relevant FortiEDR security policy rules.

l Simulation (Notification Only): FortiEDR only issues an alert (described below) for all connections that violate any
rule in the FortiEDR security policy. In this mode, FortiEDR does not block exfiltration. FortiEDR comes out-of-the-
box set to this mode.
Note: If you have purchased a Content add-on license, policy rules and built-in exceptions are periodically automatically added or updated by Fortinet.

When a new security policy is added, an indicator number displays on the SECURITY SETTINGS tab.

Use the Protection/Simulation slider at the far right of the window to enable the applicable mode, as shown below:

You can click the down arrow next to the Protection/Simulation slider to see an at-a-glance view of the system’s
various security policies and their impact on the Collectors in the system.
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Security Policies Page

The SECURITY POLICIES page displays a row for each security policy. Each policy row can be expanded to show the
rules that it contains, as shown below. To access this page, click the down arrow next to SECURITY SETTINGS and
then select Security Policies.

FortiEDR is provided out-of-the-box with several predefined security policies (depending on your license), ready for you
to get started. By default, all policies are set to Simulation mode (meaning that they only log and do not block) and show
the logo. This page also enables you to define additional policies.

Security Policy Icon

Exfiltration Prevention

Ransomware Prevention

Execution Prevention

Device Control Policies
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Security Policy Icon

Application Control Policies

Extended Detection

The following information is defined per security policy:

Information Field Description

Policy Name The policy name appears in the left most column. The policy name is defined
when the policy is created. The name of the Default Policy cannot be changed.

Rule Name FortiEDR’s proprietary rules come predefined and are the primary component of
FortiEDR’s proprietary security solution. This column displays a short description
for the purpose of this rule.
Note : You can expand the ADVANCED POLICY & RULES DATA area at the
bottom left of the window to display a more detailed description of what the rule
does and how it works.

Action Specifies the action that is enforced when this rule is violated. You can change
this field, as follows:
l Block : When this policy is set to Preventionmode (Setting a
Security Policy’s Prevention or Simulation Mode on page 59), the exfiltration
attempt is blocked and a blocking event is generated. When this policy is set
to Simulationmode, the outgoing connection attempt is NOT blocked and a
simulated-blocking event is generated (this indicates that FortiEDRwould
have blocked the exfiltration if the policy had been set to Prevention mode).

l Log : The event is only logged regardless of whether the policy is set
to Prevention or Simulation mode. The outgoing connection attempt is not
blocked.

State (Enabled/Disabled) This option enables you to disable/enable this rule.
FortiEDR’s rules have been created as a result of extensive expertise and
experience. Therefore, we do not recommend disabling any of them.

To reset a FortiEDR security policy to its out-of-the-box settings, click the Reset Policy button
in the ADVANCED POLICY & RULE DATA section, as shown below:
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Setting a Security Policy’s Prevention or Simulation Mode

Each FortiEDR security policy can be set to operate in one of the following modes:

l Prevention: FortiEDR enforces its active prevention policy that blocks all activity that violates relevant rules in the
FortiEDR security policy.

l Simulation/Notification Only: FortiEDR logs and alerts only violations of FortiEDR security policy. The events are
shown in the FortiEDR Central Manager. In this mode, FortiEDR does not block malicious activity. This is the default
mode of all FortiEDR security policies out of the box. You can decide to use this mode during an initial acquaintance
period or at any time.

To set a security policy to Prevention or Simulation mode:

1. 1 Select the checkbox of the security policy to be configured. Alternatively, you can select the top-left checkbox to
configure all security policies at once.

2. You can now either:

a. : Click the Set Mode button and select either Prevention or Simulation, as shown above.
b. : Move the slider to the left for Prevention or to the right for Simulation.
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You can also set all FortiEDR policies to Simulation mode at once by moving the slider at
the top-left corner to Simulation, as shown below:

Creating a New Security Policy

A new security policy can be created by cloning an existing policy, as described below. New security policies are only
needed if you are going to assign different policies to different Collector Groups. Otherwise, you can simply modify one
of the default policies that are provided out-of-the-box and apply it to all FortiEDR Collectors by default. Modifications
made on one security policy do not affect any other policies.

To create a new security policy:

1. In the SECURITY POLICIES page, check the checkbox of the security policy to be cloned. The buttons at the top of
the window then become active.
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2. Select the Clone Policy button. The following window displays:

3. Specify the name of the new security policy and click the Clone button.
4. If needed, assign the security policy to the required Collector Group so that it protects all the FortiEDR Collectors in

that group, as described in Assigning a Security Policy to a Collector Group on page 61.

Assigning a Security Policy to a Collector Group

By default, a security policy protects the FortiEDR Collectors that belong to that Collector Group. A security policy can be
assigned to more than one Collector Group. Multiple security policies can be assigned to each Collector Group.
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It is not recommended to assign multiple security policies that have the same or overlapping
rules to a Collector Group, as this means that the same security events will be triggered in
response to both policies, producing duplicated events.

Refer to Defining a New Collector Group on page 104 for a description of how to define a new Collector Group in the
INVENTORY tab.

1. 1 In the SECURITY POLICIES page, select the name of the security policy to be assigned by clicking its checkbox.

2. 2 The right side of the window displays the Collector Groups to which this policy is assigned.

Click the toolbar button, which displays the following window in which you can select the
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Collector Groups to which to assign this policy.

The ASSIGNED COLLECTORS GROUPS area lists all the Collector Groups that have been
assigned a security policy to protect them. You can also simply drag-and-drop a Collector
Group from this list onto a policy in the left pane of this window to assign the Collector Group to
be protected by that policy.

FortiEDR 5.1.0 Administration Guide 63
Fortinet Inc.



Security Settings

Deleting a Security Policy

Select the policy’s checkbox and then click the button.

Note: The Exfiltration Prevention, Ransomware Prevention, Device Control, Application Control, eXtended Detection
and Execution Prevention FortiEDR security policies provided out-of-the-box ( ) cannot be deleted.

Exception Manager

Exceptions enable you to limit the enforcement of a rule, meaning to create a white list for a specific flow of events that
was used to establish a connection request or perform a specific operation.

An exception can be made for a Collector Group (several specific ones or for all) and a destination IP (a specific one, IP-
set or all). The event is then no longer triggered for that specific Collector Group or destination IP. This exception can be
added on part or the entire set of rules and the process that triggered this event.

When an exception is defined, it results in one or more exception pairs. An exception pair specifies the rule that was
violated, and the process on which the violation occurred, including its entire location path. For example, the following
shows several examples of exception pairs:

l Rule – File encryptor with Process – c:\users\root\Desktop\ransom\RnsmTOX.exe
l Rule – Process hollowing with Process – c:\users\root\AppData\Local\hipmiav.exe

An exception that applies to a security event can result in the creation of several exception pairs. Each exception is
associated with a specific process path. You determine whether the exception pair can run from the event-specific path
or whether to apply the exception for this process so that it can run from any path.

If the exception pair includes more than one process, you can include the other processes too, as well as determine
whether they can run from the event-specific path or from any path.

Any exception that you define applies to all policies.

Exceptions are created in the Event Viewer, as described onDefining Security Event Exceptions on page 147

Note – FCSmay push an automated exception in cases where extended analysis and investigation of a security event
leads to its reclassification as Safe. This prevents the security event from triggering again.
In such cases, the security event is moved under archived events and the exception that was set is added in the
Exception Manager with FortiEDRCloudServices as the handling user.

To manage exceptions:

1. Select SECURITY SETTINGS > Security Events > Exception Manager. Alternatively, in the EVENT VIEWER
page, click the button. The following window displays, showing the list of previously created
exceptions:
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Tip – If the exception includes a free-text comment, you can hover over the Event ID in the Exception Manager to
display it.

Tip – You can delete one or more exceptions simultaneously by selecting the checkbox at the beginning of its row
and then clicking the Delete button.

2. To filter the exception list, click the Advanced button. The window displays various filter boxes at the top of the
window, which you can use to filter the list by specific criteria.

Click the Basic search button to access the standard search options.

Click the Edit Exception button in an exception row to edit that exception. For more details, see Editing
Security Event Exceptions on Editing Security Event Exceptions on page 161.

Click the Delete button in an exception row to delete that exception.
Changes can be made on multiple exceptions at the same time by checking the Exceptions that you would like to
edit and then clicking on the Edit tool, as shown below:
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The following window displays in the which you can choose to add new Collector Groups in addition to existing ones
or to replace all Collector Groups with the new Collector Group values that you select:

This same procedure can be used to edit the IP sets of the destination addresses of the selected exceptions.

Exclusion Manager

The Exclusion Manager enables you to define which processes or files are excluded from Security Policies monitoring.
Two types of exclusions can be defined in the Exclusion Manager:

l Process Exclusions: This type of exclusion specifies that FortiEDR does not inspect the actions that are
performed by specific processes, so that these processes do not trigger security events. The processes that are
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excluded are identified by the attributes of the processes, according to your definitions.
There may be various reasons for excluding a process in this manner. For example, when a process’s
performance/functionality is affected by FortiEDR’s inspection, but the customer knows that this process is
good/safe (this example is relevant, even when the process does not trigger security events). Therefore, in this
case, the exclusion will specify that FortiEDR no longer inspects the specified processes.
Please note that adding this type of exclusion excludes this process from being monitored by all FortiEDR features
and all activities of this process are ignored.

l Execution Prevention Exclusions: The Execution Prevention policy inspects/scans files and then blocks their
execution if they are identified as malicious or suspected to be malicious. Execution Prevention Exclusions specify
that FortiEDR does not apply the Execution Prevention policy inspection, which analyzes files in order to find
evidence of malicious activity, as described in Security Settings on page 54. The files that are excluded are
identified by the attributes of the files that are the target of the Execution Prevention actions, according to your
definitions.

To manage exclusions:

Select SECURITY SETTINGS > Security Events > Exclusion Manager. The following window displays, showing the
list of previously created exclusions:

The list of exclusions in the Collection Exclusions page contains the following columns:

Column Description

Checkbox Enables you to select multiple rows.

Icon Represents the type of exclusion
l - Process

l - Execution Prevention

SOURCE ATTRIBUTES Specifies the attributes that were defined in order to identify the Process/File, as
described in Defining Exclusions on page 69

OS Specifies the operating system to which theis exclusion applies. Currently, only
Windows is supported.

LAST UPDATED Specifies when this exclusion was last updated and by whom.

STATE Specifies whether this exclusion is enabled or disabled.

Edit and delete excursion tools.
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The following actions can be performed in the Collection Exclusions page:

l Filtering on page 68
l Defining Exclusion Lists on page 68
l Defining Exclusions on page 69

Filtering

To filter the Exclusion List names and their content, simply enter text in the Search field. Afterwards, only the Exclusion
Lists that match the provided text are displayed showing only the relevant exclusions.

To filter the list of exclusions by type, click one of the following options:

Defining Exclusion Lists

An Exclusion List contains a list of exclusions. You can assign Collector Groups to an Exclusion List in order to specify
that the exclusions in the Exclusion List apply to the Collectors in the Collector Groups assigned to it. Exclusion Lists
enable you to logically organize, categorize and group exclusions based on the type of activity data they are to exclude.

For example, let’s say that you want to collect network activity data for your system, but a specific application generates
quite a bit of uninteresting logistical network activity that you do not want to collect. In this case, you can define an
Exclusion List named after that application that contains one or more exclusions that relate specifically to the network
activity generated by that application. Exclusion Lists can be organized anyway you see fit. For example, you can create
an Exclusion List for security products, a different one for PDF documents, a different one for HR-related software and so
on.

FortiEDR comes with a default General Exclusion List that includes important exclusions. The exclusions in this group
are not editable.

Adding an Exclusion List

To define an Exclusion List:

1. Click the + Add List option and provide a name to create a new Exclusion List.
2. Add (define) the exclusions of this Exclusion List (as described on the following page). Each exclusion that you add

belongs to a specific Exclusion List.
3. Assign Collector Groups to this Exclusion List (as described below) in order to determine to which Collector Groups

these exclusions apply. A Collector Group can be assigned to multiple Exclusion Lists.
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Assigning a Collector Group to an Exclusion List

You can perform the following operations on an Exclusion List:

Operation Description

Assign a Collector Group: Click the + button in the Exclusion List to which to assign a Collector Group. Then,
select the Collectors groups to which to assign this list and approve it. Note that a
Collector Group can be assigned to multiple Exclusion Lists.

Unassign a Collector Group Click the + button and uncheck the Collector Group to be removed from an
Exclusion List.

Delete Exclusions List Click on the Delete button. Note that all Exclusions in this list will be removed

and will no longer be applied to the assigned Collector groups.

Defining Exclusions

All exclusions must belong to an Exclusion List. Select an Exclusion List on the left to display the exclusions that are
defined in it.

The following describes how to define a Process Exclusion and then how to define an Execution Prevention Exclusion.

Adding a Process Exclusion

1. In the left pane, click the Exclusion List to which to add the exclusion.
2. In the right pane, click the + Add Exclusion button. The following displays providing a choice of the two types of

exclusions that you can define.

FortiEDR 5.1.0 Administration Guide 69
Fortinet Inc.



Security Settings

3. Select Process. The following displays:

4. TheOperating system dropdown menu, specifiesWindows, which is currently the only operating system
supported for exclusions.

5. Define the processes to be excluded using one of the following options: Hash or any combination of File Name /
Path / Signer, as follows:
l Hash: Mark the Hash radio button and specify the Hash that uniquely identifies this process.
l File Name / Path / Signer: Mark the Attributes radio button and check at least one of the File Name / Path /
Signer fields checkboxes and fill the relevant values, as follows:
o Specify the file and/or directory to be excluded by filling in the File name field, the Path field or both. If you
fill in both fields, then that file is only excluded in that path. If you only fill in the File name field, then that file
is excluded wherever it appears.
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If you select Signer, then either upload the Signer’s Certificate, provide its thumbprint or provide the
Signer’s name.

6. The Exclusion List field specifies the Exclusion List that was selected, when the Add Exclusion option was
selected. This field is not editable.

7. Click the Add button. This new exclusion is then listed in the Exclusion Manager page, as shown below:

8. The newly defined exclusions appear with a green background and the words Pending save appear in their LAST
UPDATED column. To define that these exclusions take effect, you must click the Apply button and then click the
Save button in the window that pops up. Their LAST UPDATED column then shows the timestamp when they were
saved.

Adding an Execution Prevention Exclusion

1. In the left pane, click the Exclusion List to which to add the exclusion.
2. In the right pane, click the + Add Exclusion button. The following displays providing a choice of the two types of

exclusions that you can define.
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3. Select Execution Prevention. The following displays:

4. TheOperating system dropdown menu, specifiesWindows, which is currently the only operating system
supported for exclusion prevention. Specify the file and/or directory to be excluded by filling in the File name field,
the Path field or both. If you fill in both fields, then that file is only excluded in that path. If you only fill in the File
name field, then that file is excluded wherever it appears.

5. The Exclusion List field specifies the Exclusion List that was selected, when the Add Exclusion option was
selected. This field is not editable.
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6. Click the Add button. This new exclusion is then listed in the Exclusion Manager page, as shown below:

7. The newly defined exclusion appears with a green background and the words Pending save appear in its LAST
UPDATED column. To define that these exclusions take effect, you must click the Apply button and then click the
Save button in the window that pops up. Their LAST UPDATED column then shows the timestamp when they were
saved.

Setting the State of an Exclusion

The Set State button enables you to enable or disable the selected exclusion(s). By default, an exclusion is enabled.

For changing the state of multiple Exclusions, check the checkboxes of all relevant exclusions and then select the state
from the Set State dropdown under the toolbar.

Deleting an Exclusion

The Delete Exclusion button enables you to delete the selected exclusion(s).

To delete multiple Exclusions, check the checkboxes of all relevant exclusions and then select the Delete option in the
toolbar.

Application Control Manager

The Application Control policy enables FortiEDR to block pre-defined applications from running, so that it does not
launch. It enables limiting the usage of non-desired applications on specific collector groups.

Note – This differs from Application Communication Control (described on page 126), which enables you to control which applications can communicate outside

of the organization, but does not stop them from launching.

This section describes how to define the applications to be blocked by adding them in the Application Control Manager.
In addition, applications can be added to the list of applications to be blocked by adding them from the Forensics window
(as described in Stack View on page 209) and the Threat Hunting window (as described in Threat Hunting on page 80).
These applications are then listed in the Application Control Manager.

In general, in order to block applications so that they are not launched

l The applications must be added to the Application Control Policy
l Collector groups must be assigned to this policy
l The blocklist rule must be enabled on the Application Control Policy.
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To add applications to the blocklist:

1. Select SECURITY SETTINGS > Application Control.

The following window displays, showing the list of all the applications that have been defined to be blocked by the
Application Control policies. A row appears for each application to be blocked.

2. You can then perform any of the following actions:
a. Adding Application(s) to Be Blocked on page 75
b. Exporting the List of Applications to Be Blocked on page 78
c. Enabling/Disabling Application Blocking on page 78
d. Changing the Policy under Which the Application Is Blocked on page 79
e. Searching and Filtering Applications on page 80

f. Editing an Application by selecting the Edit button on the right side of that Application’s row.
g. Deleting an Application by selecting the Delete Application option at the top of the window or selecting the

Delete button on the right side of that Application’s row.
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Adding Application(s) to Be Blocked

To add an application(s) to be blocked:

1. Click the + Add Application option. The following displays:

This dropdown menu provides two options for adding applications to be blocked:
l Manually Adding an Application(s) to Be Blocked on page 75
l Uploading Application(s) to Be Blocked on page 77

Manually Adding an Application(s) to Be Blocked

To manually add an application to be blocked:

1. Select the Add application option from the drop-down menu. The following displays:

2. From the Policy dropdown menu, select one or more of the Application Control policies in which to block this
application or select the All option to specify that this application is to be blocked by all Application Control type
policies. FortiEDR is provided out-of-the-box with a single Application Control type policy and you can clone it in
order to create additional Application Control type policies as needed, as described in page 45.

3. You can optionally use the Tag field in order to classify this application. Tags can be helpful for classifying and
filtering long lists of applications. In the Tag field, click to specify the tag to be added to the application. You can
assign a previously defined tag or define a new tag.
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4. In the Hash field, enter the hash of one or more applications. Each hash is the unique identifier of an individual
application. If you enter multiple hashes, then they must be comma separated. Supported hash formats are
specified under the field.

5. Click the Add button. The Application Control Manager then lists a row for each hash value (application) entered in
the Hash field.
When a Collector Group is assigned to the application control policy (specify above), then all the applications with
these hashes are blocked and cannot be launched.
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Uploading Application(s) to Be Blocked

To upload a list of applications to be blocked from a file:

1. Select the Upload applications option. The following displays:

2. From the Policy dropdown menu, select one or more of the Application Control policies in which to block the
applications specified in the file to be uploaded.

3. You can optionally use the Tag field in order to classify this application. Tags can be helpful for classifying and
filtering long lists of applications. In the Tag field, click to specify the tag to be added to the application. You can
assign a previously defined tag or define a new tag.
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4. In the bottommost field of this window, select the CSV file that contains the list of applications to be blocked. This file
should be a CSV file with hashes on the leftmost column. A sample file can be downloaded from this window.
Alternatively, you can use the same file as can be exported, as described in Exporting the List of Applications to Be
Blocked on page 78.

5. Click the Add button. The Application Control Manager then lists a row for each application in uploaded file.
When a Collector Group is assigned to the Application Control policy (specify above), then all the applications with
these hashes will be blocked and will not be launched.

Exporting the List of Applications to Be Blocked

To export the list of FortiEDR applications to be blocked:

Use the button to export an Excel file.

Enabling/Disabling Application Blocking

If you wish to disable the blocking of all the applications that are under a specific policy, we recommend simply disabling
the blocklist rule of that policy. Alternatively, in order to temporarily block only specific applications, then we recommend
enabling/disabling each application separately. If an application need no longer be on the blocklist, then we recommend
deleting it using the Delete button in the right-most column or in the toolbar.

To enable/disable the blocking of specific applications

1. Select SECURITY SETTINGS > Application Control to display the Application Control Manager. Each row
represents an application to be blocked.

2. In the STATUS column on the right, toggle the value between Enabled and Disabled. Alternatively, you can check
the checkboxes of the desired application rows, and then select the Enabled or the Disabled option from the Set
State dropdown.
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Changing the Policy under Which the Application Is Blocked

To change the policy that blocks an application:

1. Select SECURITY SETTINGS > Application Control Manager to display the Application Control Manager. Each
row represents an application to be blocked.

2. In the Application Control Manager window, check the checkboxes of the desired application rows, and then select
the Policy Assignment option. The following displays.

The policies that have a checkbox to their left have already been assigned all the selected applications. The

policies that have a green minus sign to their left have already been assigned some of the applications. The
right side of the window indicates how many of the applications that you selected in the Application Control Manager
window have been assigned to that policy. The policies that have an empty box to their left were not assigned any of
the selected applications.

3. In the Policy Assignment window, check (or uncheck) the checkboxes of the policies that should block the currently
selected applications.

4. Click the Save button.

Note – Alternatively, in order to modify the policy to which a specific application is assigned, select the Edit button in the Application Control Manager

window in the right side of that application’s row.
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Searching and Filtering Applications

To filter the list of applications defined in the Application Control Manager, use the fields at the top of the window, as
follows:

1. Enter text in the Search field. By default, the Auto option is selected, which specifies that the search is performed
on the most relevant fields and then the list is filtered accordingly. Alternatively, from this dropdown menu, you can
select the column that is searched, as follows:

2. Select the relevant policy from the Policy field.
3. In the State field, select Enabled or Disabled.

Threat Hunting

FortiEDR’s threat-hunting capabilities features a set of software tools and information sources focused on detecting,
investigating, containing and mitigating suspicious activities on end-user devices. To set up Threat Hunting in FortiEDR,
configure the following:

l Collection Profiles on page 80
l Collection Exclusions on page 82

Collection Profiles

Note: Threat Hunting Settings is a license-dependent add-on. You may contact Fortinet Support for more information.

Threat Hunting Collection Profiles control the type of activity data that is collected for the Threat Hunting feature (which is
described in Threat Hunting on page 222). Activity data that is collected is stored on the Repository server.

To access Threat Hunting settings, select SECURITY SETTINGS > Threat Hunting Setting > Collection Profiles.

The following page displays:
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The left side of the Threat Hunting Settings page shows a list of Profiles. A Profile defines the activity event categories
and actions to be collected. FortiEDR comes with several predefined default Profiles, which cannot be modified.

In addition to the pre-defined Profiles, you can define your own custom Profiles by cloning an existing Profile.

The pane on the right side of the page lists all activity event categories and their associated actions. These categories
are the same as those described on Threat Hunting on page 222

Selecting a Profile on the left displays the categories and actions defined for that Profile in the right pane.

Check the checkboxes of the actions for which FortiEDR will collect activity data.

Assigning a Collector Group to a Profile

Profiles are assigned to Collector Groups. Only a single Profile can be assigned to each Collector Group. New Collector
Groups are automatically assigned to the default Inventory Scan Fortinet Profile, which is the first Profile listed in the
Profiles pane.

To assign a Collector Group to a Profile:

1. In the Profiles pane, click the + button of the Profile to which to assign a Collector Group. The following displays
showing the list of all Collector Groups:
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2. Select the checkbox(s) of the Collector Group(s) to assign to the Profile.
3. Click Assign. A message is displayed indicating that the selected groups are currently assigned to another Profile

and they will be reassigned and asking for you approval. Please approve.

Creating/Cloning a Profile

In order to create a new Profile, you must first clone an existing Profile and then customize the clone.

1. Click the Clone icon that appears on the right of the Profile to be cloned.

2. Enter the name of the new Profile.
3. On the right side, enable the activity events to be collected and disable the activity events that should not be

collected.
4. Click Save.
5. Assign the Collector Group(s) on which to apply the newly created Profile.

Collection Exclusions

Exclusions are needed for reducing the amount of Threat Hunting data that is collected and by doing so prolonging the
data retention. The less data that is collected, the longer it will be stored in the databases.
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Exclusions enable you to define certain types of activity events to be excluded from being collected by Threat Hunting
data (even though should be collected according to the Threat Hunting Collection Profile assigned to a Collector group,
which was described in Collection Profiles on page 80). For example, if you know that a certain process is legitimate, but
it creates many activity events that are not relevant to your Threat Hunting investigation, you can use the Collection
Exclusions to define that these activities are not collected.

The Collection Exclusions enables you to define and manage exclusion lists and the exclusions that they contain.

Note – Exclusions are different than security event exceptions, as follows:

l Exclusions define which activity events should be collected. They are exclusions to the Threat Hunting Profile.
l Security event exceptions are defined after a particular security event has occurred. They are an exception to the assigned Security Policy

To access the Collection Exclusions, select SECURITY SETTINGS > Threat Hunting > Collection Exclusions.

The Collection Exclusions page contains the following areas:

l

Filters

To filter the Collection Exclusion list names and its content, simply enter text in the Search field. Afterwards, only the
Exclusion lists that match the provided text are displayed showing only the relevant exclusions.

Defining Collection Exclusion Lists

A Collection Exclusion List contains a list of exclusions. You can assign Collector Groups to an Exclusion List in order to
specify that the exclusions in the Exclusion List apply to the Collectors in the Collector Groups assigned to it. Exclusion
Lists enable you to logically organize, categorize and group exclusions based on the type of activity data they are to
exclude.

For example, let’s say that you want to collect network activity data for your system, but a specific application generates
quite a bit of uninteresting logistical network activity that you do not want to collect. In this case, you can define an
Exclusion List named after that application that contains one or more exclusions that relate specifically to the network
activity generated by that application. Exclusion Lists can be organized anyway you see fit. For example, you can create
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an Exclusion List for security products, a different one for PDF documents, a different one for HR-related software and so
on.

Adding an Exclusion List

To define an Exclusion List:

1. Click the + Add List option and provide a name to create a new Exclusion List.
2. Add (define) the exclusions of this Exclusion List (as described on the following page). Each exclusion that you add

belongs to a specific Exclusion List.
3. Assign Collector Groups to this Exclusion List (as described below) in order to determine to which Collector Groups

these exclusions apply. A Collector Group can be assigned to multiple Exclusion Lists.

Assigning a Collector Group to an Exclusion List

You can perform the following operations on an Exclusion List:

Operation Description

Assign a Collector Group: Click the + button in the Exclusion List to which to assign a Collector Group. Then,
select the Collectors groups to which to assign this list and approve it. Note that a
Collector Group can be assigned to multiple Exclusion Lists.

Unassign a Collector Group Click the + button and uncheck the Collector Group to be removed from an
Exclusion List.

Delete Exclusions List Click on the Delete button. Note that all Exclusions in this list will be removed

and will no longer be applied to the assigned Collector groups.

Defining Collection Exclusions

All exclusions must belong to an Exclusion List. Select an Exclusion List on the left to display the exclusions that are
defined in it.

Exclusions can be defined for a

l Source (process) –Which is identified by a source attribute, such as a Signer.
l Type/Action – Activity event types, as described in Threat Hunting on page 222.
l Target –Which is identified by a target attribute, such as IP & Port

Exclusion can include all of these three or any combination. However, defining an exclusion that only contains a Type is
not valid, because this kind of exclusion should be defined in a Threat Hunting Profile.
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For example, you can define to exclude activity events of a specific Type that have a specific source and a specific target
or to exclude (for example) activity events that have a specific source and any activity or target.

Adding an Exclusion

1. In the left pane, click the Exclusion List to which to add the exclusion.
2. In the right pane, click the + Add Exclusion button. The following displays:

3. From the Operating system dropdown menu, select either Linux or Windows.
4. To define that an exclusion includes a specific Activity Event Type, select the type of action(s) to exclude from the

displayed dropdown list. Alternatively, select the Any option (the default option), which means that you are not
specifying a specific action type.
All action types to be collected are listed according to Category. You can select one or more actions from a single
Category. Actions cannot be selected from different categories. For example, you can select the Process
Termination and the Process Start options from the Process Category in the same exclusion. However, you cannot
select the Key Created option together and the Thread Created options in the same exclusion – to do this you must
create two different exclusions.
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5. To define that an exclusion includes a Source attribute condition, from the Select box, select Source attribute,
which can be identified by file name, path, hash and signer for Source Process or Event Log Name for event log
related activity events, as shown below:
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If you select Hash, then specify the hash, as shown below:

If you select Path, then specify the Path, as shown below. A path can include wild cards. If you wish to include sub-
folders as well, check the Select sub folders checkbox.

If you select File Name, then enter the file name.
If you select Signer, then either upload the Signer’s Certificate, provide its thumbprint or provide the Signer’s name.
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6. To define that an exclusion includes a Target attribute condition, click the + button. From the Select box, select the
Target Attribute and then define the target criteria, as described below:
 Targets can be identified by various criteria, depending on the selected Activity Event Category.
l A process Category event is identified by hash, path, file name or Signer.
l A network Category event is identified by network-related properties, such as a remote IP and port.
l A registry Category event is identified by a registry key path, value name, value type or value size.
l An Event log Category event is identified by the Event Log ID.
When defining an exclusion that contains multiple conditions, an AND relationship exists between the
conditions.
Note: If an OR relationship is needed between the conditions that you define, simply create another exclusion.

7. Click the Add button. This new exclusion is then listed in the Collection Exclusions page, as shown below:

8. The newly defined exclusions appear with a green background and the words Pending save appear in their LAST
UPDATED column. To define that these exclusions take effect, you must click the Apply button and then click the
Save button in the window that pops up. Their LAST UPDATED column then shows the timestamp when they were
saved.

Setting the State of an Exclusion

The Set State button enables you to enable or disable the selected exclusion(s). By default, an exclusion is enabled.
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Deleting an Exclusion

The Delete button enables you to delete the selected exclusion(s).

To delete multiple exclusions, check the requested exclusions checkboxes and choose Delete in the toolbar.

Playbook Policies

The FortiEDR Playbooks feature determines which automatic actions are triggered, based on the classification of a
security event. Playbook policies enable administrators to preconfigure the action(s) to be automatically executed
according to a security event’s classification. Typically, Playbook policies only need be configured once, and can be
modified thereafter, if needed. FortiEDR classifies each security event into one of five Categories.

FortiEDR provides the following Playbook policy out of the box:

l Default Playbook: This Playbook policy specifies the default actions for the Collector Groups assigned to the
policy. By default, all Collector Groups are assigned to this policy.

Automated Incident Response - Playbooks Page

The AUTOMATED INCIDENT RESPONSE – PLAYBOOKS page displays a row for each Playbook policy. To access
this page,select SECURITY SETTINGS > Playbooks.

Each Playbook policy row can be expanded to show the actions that it contains, as shown below:

You can drill down in a Playbook policy row to view the actions for that policy by clicking the icon.

Note: There are more options and actions than those shown above that can be added to a Playbook policy, such as the
blocking of a malicious IP address. You may consult Fortinet Support about how to add them.
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Note: Automatic Incident Response Playbook features can also be triggered by extended detection events when follow-
up actions are configured for the Collector Group of a device on which the event triggered. This enables the system to
follow up upon the detection of such an event and execute a sequence of actions, such as to block an address on a
firewall or to isolate the device in which part of the event occurred.

Assigned Collector Groups

The Assigned Collector Groups pane on the right lists the various Collector Groups in the system. By default, all
Collector Groups are assigned to the Default Playbook policy. You can reassign one or more Collector Groups to
different Playbook policies, if preferred.

Note: When upgrading your FortiEDR system, all existing Collector Groups are automatically assigned to the Default
Playbook policy.

Cloning a Playbook Policy

Cloning a Playbook policy unassigns the policy from one Collector Group and then reassigns it to a different Collector
Group. A Collector Group can only be assigned to one Playbook policy.

1. In the AUTOMATED INCIDENT RESPONSE - PLAYBOOKS page, select the Playbook policy row that you want to
clone in the Playbook Policies list.

2. Do one of the following:
a. Select the checkbox(es) of the Collector Group(s) in the Assigned Collector Groups pane that you want to

assign to the cloned Playbook policy. Then, click the Unassign Group button in the Assigned Collector Groups
pane.

b. Click the Collector Group in the Assigned Collector Groups pane that you want to assign to the cloned
Playbook policy. Then, drag the Collector Group onto the cloned Playbook policy in the Playbook Policies list,
as shown below:

FortiEDR 5.1.0 Administration Guide 90
Fortinet Inc.



Searching and Filtering Applications

The following message displays.

Click Yes.

Advanced Playbooks Data

The Advanced Playbooks Data area at the bottom of the AUTOMATED INCIDENT RESPONSE – PLAYBOOKS page
displays more details about the action selected in the Playbook Policy list.
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Playbook Policy Actions

Playbook policy actions are divided into the following types:

l Notifications on page 92
l Investigation on page 93
l Remediation on page 95
l Custom on page 97

Each of these Categories contains different types of actions that can be performed when a security event is triggered.

Notifications

Notification actions send a notification when a relevant security event is triggered. These actions are implemented in
both FortiEDRmodes (Simulation and Prevention).

Notifications can be one of the following types:

l Emails
l Syslog
l Open Ticket

Each row under Notifications corresponds to a single type of notification (mail [email] notification, Syslog notification or
Open Ticket notification). In the Notifications area, you configure each notification type to indicate whether or not it is to
automatically send the relevant notification, once triggered by a security event. By default, the Default Playbook policy is
set to Simulation mode, and only email notifications are automatically enabled, as shown below:
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Note: Notification actions must be enabled in order to be implemented by a Playbook policy. If notifications are disabled, they are not implemented by the

Playbook policy, even if that policy is configured to send notifications. For more details seeSMTP on page 288.

TheMalicious, Suspicious, PUP, Inconclusive and Likely Safe columns correspond to the possible classifications
for a security event. When a checkmark appears in one of these columns, it means that a notification of the specified
type is sent when an event is triggered that has that classification. Notifications are sent for all security events except
those classified as Likely Safe. For example, the figure below shows that an email notification is sent whenever a
Malicious, Suspicious, PUP or Inconclusive security event is triggered. Syslog andOpen Ticket notifications work in the
same way as Email notifications. For more details about classifications, see Events Pane on page 138.

SMTP, Syslog and Open Ticket must already be configured in order to send their respective notifications. If their settings
are not already configured, the relevant row in the Notifications list displays a message indicating that you must first
configure it, as shown below:

Note: The word Admin in each of these messages is a link that when clicked, jumps to the relevant place in the user
interface to configure it. For example, when you click Admin in any of these messages, the following window displays in
which you can configure the relevant settings.

Investigation

Investigation actions enable you to isolate a device or assign it to a high-security Collector Group, in order to further
investigate the relevant device’s activity.
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Investigation actions can be one of the following types:

l Isolate Device with Collector on page 94
l Isolate Device with NAC on page 95
l Move Device to High Security Group on page 95

Isolate Device with Collector

This action blocks the communication to/from the affected Collector. This action only applies for endpoint Collectors. For
example, if the Playbook policy is configured to isolate the device for a malicious event, then whenever a maliciously
classified security event is triggered from a device, then that device is isolated (blocked) from communicating with the
outside world (for both sending and receiving). This means, for example, that applications that communicate with the
outside world, such as Google Chrome, Firefox and so on, will be blocked for outgoing communications.

A checkmark in a classification column here means that the device is automatically isolated when a security event is
triggered with that classification.

Note: The tab bar at the top of the window may display a white circle(s) with a number inside the circle to indicate that
new security events have not been read by the user. The number represents the number of new registered devices.

When the circle is white, it means that there are no isolated devices and the number inside the circle represents the
number of new registered devices in the last three days.

When the circle is red, it indicates that there are one or more isolated devices. In this case, the number inside the circle
indicates only the number of isolated devices.

You can hover over the number to see the list of new registered devices and isolated devices. Each row shows the
number of devices added, by day.

FortiEDR 5.1.0 Administration Guide 94
Fortinet Inc.



Searching and Filtering Applications

Isolate Device with NAC

This action blocks the communication to/from the affected device by disabling this host on an external Network Access
Control system. A NAC connector must already be configured in order to perform this action. For details about how to
configure NAC connectors, see Network Access Control (NAC) Integration on page 318.

In the dropdown menu next to the action, you can specify which NAC to use for disabling the host or select all of them.

Note: Unlike devices that are isolated using the FortiEDR Collector for which there is an isolation indication on Inventory
tab and un-isolation is available, devices that were isolated using an external system such as a NAC are not indicated as
such on the FortiEDR Console and un-isolation is only possible on the external NAC system.

Move Device to High Security Group

FortiEDR provides two default Collector Groups: the Default Collector Group and the High Security Collector Group.
Both of these default Collector Groups are initially assigned to the Default Playbook policy, and cannot be deleted.

A checkmark in a classification column here means that the device is automatically moved (assigned) to the High
Security Collector Group when a security event is triggered that has that classification. This feature is useful when you
want to mark Collectors that triggered malicious events.

Remediation

Remediation actions enable you to remediate a situation in the FortiEDR system, should malware be detected on a
device.
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Remediation actions can be one of the following types:

l Terminate Process on page 96
l Delete File on page 96
l Clean Persistent Data on page 96
l Block Address on Firewall on page 96

Terminate Process

This action terminates the affected process. It does not guarantee that the affected process will not attempt to execute
again. This action can also be performed manually using the Forensics add-on, as described on Remediating a Device
Upon Malware Detection on page 212

A checkmark in a classification column here means that the affected process is automatically terminated on the
device when a security event is triggered that has that classification.

Delete File

This action ensures that the file does not attempt to exfiltrate data again, as the file is permanently removed from the
device. This action can also be performed manually using the Forensics add-on, as described on Remediating a Device
Upon Malware Detection on page 212

A checkmark in a classification column here means that the affected file is automatically removed on the device when
a security event is triggered that has that classification.

Clean Persistent Data

This action cleans the registry keys in Windows. This action can also be performed manually using the Forensics add-
on, as described on Remediating a Device Upon Malware Detection on page 212.

A checkmark in a classification column here means that the affected registry key is automatically cleaned on the
device when a security event is triggered that has that classification.

Block Address on Firewall

This action ensures that connections to remote malicious addresses that are associated with the security event are
blocked. A Firewall Connector must already be configured in order to perform this action. For details about how to
configure firewall connectors, see Firewall Integration on Firewall Integration on page 311.

In the dropdown menu next to the action, you can specify which firewalls are used to perform the blocking or select all of
them, as shown below:
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A checkmark in a Classification column means that communication with the affected destination is automatically
blocked when a security event is triggered that has that classification.

The firewall must already be configured in order to add malicious destinations to blocked addresses. If its settings are not
already configured, the relevant row in the Remediation list displays a message indicating that you must first configure it,
as shown below:

Note: Clicking the Integration Admin link in this message jumps to the relevant place in the user interface to configure it (in the Integration page under the Admin

tab).

Custom

Custom actions enable you to automatically trigger an incident response in a third-party system as the result of a security
event detected by FortiEDR, according to the Custom Integration connector (and its actions) that you define.

The CUSTOM section of the Playbook page lists the actions that have been defined for Custom Integration Connectors,
as described on Custom Integration on page 328.

Note: This list appears empty appears until at least one Custom Integration Connector has been defined.

A checkmark in a classification column here means that the defined action is triggered in the third-party system when
a security event is triggered that has that classification.

Other Options in the Playbooks Tab

You can perform the following operations using the toolbar at the top of the tab:

l Clone Playbook: Clones a Playbook policy, as described on Playbook Policies on page 89.
l Set Mode: Changes the mode of the Playbook policy. This process is similar to that for setting the mode for a
standard security policy, which is described on Setting a Security Policy’s Prevention or Simulation Mode on page
59
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l Assign Collector Group: Assigns a Playbook policy to a Collector Group. This process is similar to that for
assigning a standard security policy to a Collector Group, which is described on Assigning a Security Policy to a
Collector Group on page 61.

l Delete: Deletes a cloned Playbook policy. Default Playbook policies cannot be deleted.

Note: The default Playbook policy (named Default Playbook) is mandatory and cannot be deleted.
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Inventory

This chapter describes the FortiEDR Inventory, which enables you to monitor the health of FortiEDR components and to
create Collector Groups.

Introducing the Inventory

The INVENTORY tab displays separate pages for COLLECTORS, IoT (devices) and System Components
(AGGREGATORS, CORES and REPOSITORIES). Click the down arrow next to INVENTORY and then select the
relevant option to access its page, as shown below.

This view enables you to monitor system health and to define Collector Groups. If you have a large system with
thousands of FortiEDR Collectors, it may take a few moments to populate this window.

By default, the INVENTORY tab and its various pages are filtered to display all the FortiEDR components that are
degraded, except for FortiEDR Collectors, which are filtered to see all Collectors, regardless of their state.

If there are Collectors in the Degraded state, the following indication appears at the right top corner, which you can click
to filter the view to only show the Collectors in the Degraded state.

You can select to display all Collectors that are in one of the specific states (New, Running, Disabled, Degraded,
Disconnected, Isolated, Selected, Pending Reboot, Migrated, Pending Migration or Unmanaged) using the
dropdown menu at the top left of the window, as shown below:
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When a new FortiEDR Collector registers, an indicator displays on the INVENTORY tab.

The X/Y numbers in the Collector Group Name column indicate the following:

l X indicates the number of Collectors, based on the filter option selected (New, Running, Disabled, Degraded,
Disconnected, Selected or Pending Reboot), as described on the preceding page.

l Y indicates the total number of Collectors in the Collector Group to which the Collector belongs.

For example, the figure below shows 11/11, which means that there are 9 Collectors that are Running in a Collector
Group containing 9 Collectors.

To export the list of FortiEDR components:

• Use the button and select Excel or PDF.
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Uninstalling a Collector

Use the button to uninstall a Collector from a device. Use caution when using this option, as a Collector cannot be
reinstalled after removal using the FortiEDR user interface. Therefore, it is recommended to disable a Collector using the
Enable/Disable option rather than uninstalling it.

Collectors

The COLLECTORS page displays a list of the previously defined Collector Groups, which can be expanded to show the
FortiEDR Collectors that each contains. Additional Collector Groups can be defined by you, as described on Defining a
New Collector Group on page 104. FortiEDR Collectors automatically register with the system after installation. By
default, each FortiEDR Collector is added to the Collector Group called All. You can move any Collector to another
Collector Group, as described on Assigning Collectors to a Collector Group on page 105.

To access this page, click the down arrow next to INVENTORY and then select Collectors, as shown below.
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The default Collector Group (to which new Collectors are automatically added) is marked with a yellow group icon .
You can change to a different default Collector Group by clicking the group icon of another Collector Group.

Click to expand the list and display the FortiEDR Collectors that the Collector Group contains.

The following information is provided for each Collector:

Information Field Description

Checkbox Check this checkbox to select the Collector. You can then use one of the buttons
at the top left of the window, such as the Delete button

Collector Group Name Specifies the name of the Collector Group to which the Collector is assigned.

Device Name Specifies the device name taken from the communicating device on which the
FortiEDR Collector is installed.

Last Logged Specifies the last user that logged into the device on which the Collector is
installed. It shows the domain of the computer/username. If this device has not
been logged into, then this column is blank. In addition, if the Collector is not
V3.0.0.0 or above, then this column is empty and the events from this Collector
will not contain the user from which the security event was triggered.

OS Specifies the operating system of the communicating device on which the
FortiEDR Collector is installed.

IP Specifies the IP address of the communicating device on which the FortiEDR
Collector is installed.

MAC Address Specifies the physical address of the device. If a device has multiple MAC
addresses, three dots (…) display. You can hover over the MAC Address to
display the value (or values, in case of multiple MAC addresses) in a tooltip.
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Information Field Description

Version Specifies the version of the FortiEDR Collectors installed on the communicating
device.

State Specifies the current state of the FortiEDR Collector. Hovering over the STATE
value pops up the last time the STATE was changed. Possible value for STATE
are as follows:

Running The FortiEDR Collector is up and all is well.

Running (Autonomously) The core is temporarily inaccessible. Therefore, policy enforcement is performed
by the FortiEDR Collector.

Disconnected The device is offline, powered down or is not connected to the FortiEDR
Aggregator.

Disconnected (Expired) The device has not been connected for 30 or more consecutive days. Collectors
in this state are not counted for licensing purposes.
Note: To see the list of Collectors in this state, click the down arrow in the Search
box at the top right of the window to display the following window:
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Information Field Description

Then, check the Show only devices that have not been seen for more than 30
days checkbox, and click the Search button. The Collectors area then displays
only devices in the Disconnected (Expired) state.

Pending Reboot After the FortiEDR Collector is installed, you may want some devices to be
rebooted before the FortiEDR Collector can start running. This status means that
the FortiEDR Collector is ready to run after this device is rebooted. The reboot is
performed in the usual manner on the device itself.

Disabled Specifies that this FortiEDR Collector was disabled in the FortiEDR Central
Manager. This feature is not yet available in version 1.2.

Degraded Specifies that the FortiEDR Collector is prevented from performing to its full
capacity (for example, due to lack of resources on the device on which it is
installed or compatibility issues).

Last Seen Counts the number of days passed from the last time this Collector communicated
with the Core.

Defining a New Collector Group

Creating multiple Collector Groups enables you to assign different FortiEDR policies to
different FortiEDR Collectors, which means to different end user groups. In addition, it enables
data segmentation in FortiEDR and reports according to user groups. For example, you may
want to assign a more permissive policy to the CEO of your organization.
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1. Click the button. The following window displays:

2. Enter any name for this group and click the Create new group button.

Assigning Collectors to a Collector Group

1. In the COLLECTORS page, select the checkboxes of the FortiEDR Collectors to be moved to a different group.

2. Select the button. The following window displays showing the names of the current
Collector Groups and how many Collectors each contains:
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3. Select the Collector Group to which to move the selected Collectors.
4. Click theMove to group button.

Deleting a Collector Group/Collector

Deleting a Collector Group simply means that you are deleting a logical grouping of Collectors. These Collectors then
become available to be selected in the default Collector Group. The Collector Group assigned as the default Collector
Group cannot be deleted.

Deleting a Collector only deletes it from the FortiEDR Central Manager’s console. If the FortiEDR Collector is not
uninstalled on the device, it will automatically reappear in the FortiEDR Central Manager’s COLLECTOR list.

To delete a Collector Group/Collector:

l Select the Collector Group’s/Collector’s checkbox and then click the button.
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Enabling/Disabling a Collector

You can enable or disable one or more Collectors simultaneously.

To enable one or more Collectors simultaneously:

1. In the COLLECTORS page, select the checkboxes of the FortiEDR Collectors to be enabled. All selected Collectors
must be in a Disabled ( ) state.

2. Click the down arrow on the button and select Enable. This button is only enabled
when one or more Collectors are selected.

To disable one or more Collectors simultaneously:

1. In the COLLECTORS page, select the checkboxes of the FortiEDR Collectors to be disabled. All selected
Collectors must be in a Running ( ) state.

2. 2 Click the down arrow on the button and select Disable. This button is only enabled
when one or more Collectors are selected. A confirmation message displays:

3. 3 Click Disable collectors.

Device Isolation

An isolated device is one that is blocked from communicating with the outside world (for both sending and receiving). A
device can be isolated manually, as described below. For more details see Investigation on page 93

Note: Isolation mode takes effect upon any attempt to establish a network session after isolation mode has been initiated. Connections that were established

before device isolation was initiated remain intact. The same applies for Communication Control denial configuration changes. Note that both Isolation mode and

Communication Control denial do not apply on incoming RDP connections and ICMP connections.
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To isolate a device:

1. In the COLLECTORS page, select the checkbox(es) of the FortiEDR Collector(s) that you want to isolate.

2. Click the down arrow on the button and select Isolate.
The following window displays

3. Click the Isolate button. A red icon appears next to the relevant Collector to indicate that the Collector has been
isolated, as shown below:

To remove isolation from a device:

1. 1 In the COLLECTORS page, select the checkbox(es) of the FortiEDR Collector(s) whose isolation you want to
remove.
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2. Click the down arrow on the button and select Remove isolation, as shown below.

The following window displays:

3. Click the Remove button.

Unmanaged Devices

The COLLECTORS page also indicates the number of unmanaged devices found in the system at the top right of the
page, meaning those non-IoT devices on which no Collector is installed.

Important: Unmanaged devices are not protected in the system. Therefore, it is recommended that you either install a
Collector on each such device or remove it from your network.

To view the list of unmanaged devices, select Unmanaged in the filter at the top left of the page.
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None of the action buttons at the top of the window are available for unmanaged devices, as there is no Collector
installed on these devices.

IoT Devices

The IOT DEVICES page lists the non-workstation devices, such as printers, cameras and so on, that are part of your
network. To access this page, click the down arrow next to INVENTORY and then select IoT.

This option is only available to users who have purchased the Discover and Protect or the Discover, Protect and
Response license.

FortiEDR provides you with visibility to any device in your network, including those on which FortiEDR components are
not installed. IoTs are proactively discovered from existing FortiEDR Collectors. For more details, see IoT Device
Discovery on page 300.

This page provides all the collected information about each discovered device, including its name, Category (device
type), model number, internal IP address, MAC address, the physical location where the device was detected (based on
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its external IP address) and when it was first and last seen. FortiEDR presents all the information it collected for each

device. Information that was not available for a device is marked as N/A in that device’s row in the table. The
indication indicates that the device was discovered within the last three days. The indication indicates that the device
has not been seen for more than one week.

The default IoT Group to which new IoT devices are automatically added is marked with a yellow group icon . You
can change to a different default IoT Group by clicking the group icon of another IoT Group. Alternatively, you can use
Category-based grouping, where each new IoT device is automatically added to the group that represents its Category
(for example, network devices, cameras, printers and so on).

Defining a New IoT Group

1. Click the button. The following window displays:

2. Enter any name for this group and click the Create new group button.

Assigning Devices to an IoT Group

1. In the IOT DEVICES page, select the checkboxes of the IoT devices to be moved to a different group.

2. Select the button. The following window displays showing the names of the current IoT
Groups and how many devices each contains:

FortiEDR 5.1.0 Administration Guide 111
Fortinet Inc.



Inventory

3. Select the IoT Group to which to move the selected devices.
4. Click theMove to group button.

Deleting an IoT Device/IoT Group

Deleting an IoT Group simply means that you are deleting a logical grouping of IoT devices. These devices then become
available to be selected in the default IoT Group. The IoT Group assigned as the default IoT Group cannot be deleted.

Deleting an IoT device deletes it from the FortiEDR Central Manager’s console. However, if the device is still connected
to your network, it will re-appear following the next network scan.

To delete an IoT device/IoT Group:

l

Select the IoT Group’s/IoT device’s checkbox and then click the button.

FortiEDR 5.1.0 Administration Guide 112
Fortinet Inc.



Inventory

Refreshing IoT Device Data

You can run a scan for a specific IoT device to recollect data for that device.

To rescan an IoT device(s):

1. Select the IoT device’s checkbox for the device(s) that you want to scan and then click the

button. A confirmation window displays.

2. Click the Rescan devices button.

Exporting IoT Information

To export the list of IoT devices:

l Use the button and select Excel or PDF.

To export details for an IoT device:

l Check the checkbox of the device of interest and then select Device Info under the Export button. You can only
export details for one device at a time. This report exports all collected data for the IoT device of interest, including
additional data beyond what is presented in the user interface.
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System Components

The SYSTEM COMPONENTS page lists the FortiEDR Aggregators, Cores and Repositories. To access this page, click
the down arrow next to INVENTORY and then select System Components, as shown below.

The following displays:

Aggregators

The AGGREGATORS area lists the FortiEDR Aggregators.
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Click to expand the list. The following information is provided for each FortiEDR Aggregator:

Information Field Description

Checkbox Check this checkbox to select the Aggregator. You can then use one of the
buttons at the top left of the window, such as the Delete button

IP Specifies the IP address of the communicating device on which the FortiEDR
Aggregator is installed.

Name Specifies the Aggregator name entered during installation

Connected Collectors Specifies the number of FortiEDR Collectors that have been configured to operate
with this Aggregator.

Version Specifies the version of the Aggregator software.

State Specifies the current state of the FortiEDR Aggregator.

Cores

The CORES area lists the FortiEDR Cores.

Click to expand the list. The following information is provided for each FortiEDR Core:

Information Field Description

Checkbox Check this checkbox to select the Core. You can then use one of the buttons at
the top left of the window, such as the Delete button
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Information Field Description

Organization Specifies the name of the organization in a multi-organization FortiEDR
environment. In a single-organization FortiEDR system, this column does not
appear.

IP Specifies the IP address of the communicating device on which the FortiEDR
Core is installed.

Name Specifies the FortiEDR Core name entered during installation

Deployment Mode Specifies whether the FortiEDR Core is physically deployed on your
organization's premises (On-Premise) or in the cloud provided by Fortinet
(Cloud). The following deployment options are available.
l Cloud
l On-premise

Functionality Specifies the core's functionality and enables you to modify it by selecting one of
the following options:
l Core only – Specifies that the system provides basic FortiEDR Core
functionality: events processing, communication control handling, activity
events proxy to the Repository and so on.

l JumpBox – Specifies that the FortiEDR Core is used by the Central
Manager (the central web user interface) as a JumpBox, while the JumpBox
connects to the LDAP, sandbox or to the products. No basic Core
functionalities are provided.
Note: The JumpBox can also be used in the Cloud, not only when the Core is
on-premise.

l Both – Provides both Core and JumpBox functionality, as described above.
Note:It is not mandatory to have a Core with JumpBox functionality. However,
removing JumpBox functionality (by selecting the Core only option) may affect
previously defined connectors, thus causing them to be nonfunctional. In this
case, an appropriate message is displayed.

Version Specifies the version of the FortiEDR Core.

State Specifies the current state of the FortiEDR Core.

Repositories

The REPOSITORIES area shows details about the FortiEDR Threat Hunting Repository server.
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Click to expand the list. The following information is provided for each FortiEDR Repository:

l IP: Specifies the IP and port address of the communicating device on which the FortiEDR Repository is installed.
l STATE: Specifies the current state of the FortiEDR Repository.

Exporting Logs

Exporting Logs

The Export Logs feature enables you to retrieve technical information from the FortiEDR devices deployed in the
organization, such as from Collectors, Cores, Aggregators and the Management server. The retrievable technical
content describes the activities of each FortiEDR device. Typically, the technical content contains logs and statistical
information. The retrieved technical content is password-protected. The password is enCrypted.

Logs only need to be retrieved when Fortinet technical support requests that you provide them. There is no need for you
to analyze the data contained in the FortiEDR logs. You can retrieve logs for the following:

l Exporting Logs for Collectors on page 117
l Exporting Logs for Cores on page 118
l Exporting Logs for Aggregators on page 119

Exporting Logs for Collectors

To export Collector logs:

1. In the COLLECTORS page, select the checkboxes of the FortiEDR Collectors for which you want to export logs.

2. Click the down arrow on the Export dropdown menu and select Collector Logs.
A progress window displays, showing the status of the Collector log retrieval process:
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After the retrieval process completes, the following window displays:

3. Click the Download link to automatically send the retrieved logs to Fortinet technical support.

Exporting Logs for Cores

1. In the SYSTEM COMPONENTS page, select the checkboxes of the FortiEDR Cores for which you want to export
logs.
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2. Click the down arrow on the Export dropdown menu and select Core Logs.

A progress window displays, showing the status of the log retrieval process:
After the retrieval process completes, the following window displays:

3. 3 Click the Download link to automatically send the retrieved logs to Fortinet technical support.

Exporting Logs for Aggregators

1. In the SYSTEM COMPONENTS page, select the checkboxes of the FortiEDR Aggregator for which you want to
export logs.
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2. Click the down arrow on the Export dropdown menu and select one of the following options:

a. Aggregator Logs: Exports the log for the selected Aggregator(s).
b. System Logs: Exports the logs of the central Manager.

A progress window displays.
After the retrieval process completes, a window displays.
Click the Download link to automatically send the retrieved logs to Fortinet technical support.
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Dashboard

This chapter describes the FortiEDR DASHBOARD for monitoring security events.

Introduction

The FortiEDR Dashboard provides a visual overview of the FortiEDR protection of your organization. It provides an at-a-
glance view of the current security events and system health. The Dashboard is automatically displayed after installation
or when you click the DASHBOARD tab.

Note: The system time is displayed in all pages at the bottom right of the status bar. It represents the local FortiEDR
server time. For example, if the FortiEDR server is located in London, and you log in from Los Angeles, USA, then the
time shown is the current time in London, and not the current time in Los Angeles.

The Dashboard enables you to display two different slices or views of the data collected by FortiEDR:

l Device View : This view presents information by device, and represents all the security events detected on a
given device.

l Process View : This view presents information by process, and represents all the security events detected for a
given process.

Click the applicable view button at the top left of the window to display that view in the DASHBOARD tab.
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The information presented in the Dashboard represents an aggregation of events. For more details, you may refer to the
Event Aggregation on page 135. FortiEDR aggregates security events in both the Device view and the Process view in
the Dashboard.

Use the Logged-in User dropdown list at the top-right of the window to access the following options:

l Help: Enables you to download the latest version of the FortiEDR Installation and Administration Guide.
l Privacy Policy: Downloads the FortiEDR privacy policy.
l Logout: Exits the FortiEDR application.

Security Events Chart

The SECURITY EVENTS chart for the Device view shows the number of protected devices in the system at the bottom
of the pane.
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The SECURITY EVENTS chart shows the number and classification of the FortiEDR security events that have not yet
been handled. The chart is color-coded according to security event classification:

l Red: Critical
l Yellow: High
l Grey: Medium

Click this chart to drill down to the Event Viewer, which shows a filtered chart listing the unhandled security events
(Marking a Security Event as Handled/Unhandled on page 143) according to the classification (color) that you clicked in
this chart.

Each security event that is detected by the FortiEDR system is initially marked as unread and unhandled. Multiple users
may be using the FortiEDR Central Manager in parallel. The Unread and Unhandled statuses enable users to keep
track of whether anyone has read and handled the message.

Communication Control Chart

The COMMUNICATION CONTROL chart displays a breakdown of the applications with an Unresolved status detected
in your organization.

FortiEDR 5.1.0 Administration Guide 123
Fortinet Inc.



Dashboard

Click a box in the chart to drill down to the Communication Control.

Collectors Chart

The COLLECTORS chart provides an overview of FortiEDR Collectors. When in operating system view, each bar in this
chart represents a different operating system: Windows, Windows Server and MacOS. In addition, when in General View
mode, the window shows the number of unmanaged devices in the system.

The bar chart is color-coded and numbered to indicate the distribution of statuses among the components within the
operating system group.

Each bar chart indicates the Version or the Operating System of that component, according to the option that you
selected in the View By dropdown menu.
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Click this chart to drill down to the relevant Inventory on page 99, which shows a filtered chart listing the Collectors with
the selected Version or Operating System.

Disconnected status may indicate that the device on which the FortiEDR Collector is installed
is simply powered down or disconnected from the network. It does not necessarily mean that
there is a problem with that FortiEDR Collector or that device.
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Most Targeted Charts

TheMOST TARGETED chart displays the history of the most-infected and targeted processes, applications and
devices. This chart is color-coded according to the classification of the attacks. The information is displayed per last day,
last week or last month, according to your selection.

Click this chart to drill down to the Event Viewer on page 134, which shows a filtered chart listing the security events for
the selected process or device.

External Destinations

The EXTERNAL DESTINATIONSmap displays the locations of the destinations for the security event for the past day,
week or month. Select the timeframe for displaying data in the dropdown menu at the top of the pane.
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System Components

The SYSTEM COMPONENTS chart shows the status of the Cores, Aggregators, Threat Hunting Repository and FCS.

Executive Summary Report

The Executive Summary report provides a comprehensive summary describing security events and system health.
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1. 1 Click the button at the top-right of the Dashboard window. The following window displays:

2. Specify the timeframe for the report in the From/To fields. The default period for the report is one month.
3. ClickGenerate Report. The report opens in a pop-up window.

4. 4 Click Save/Print to save or print the report.
The report presents several sections of information, as follows:
l Event Statistics on page 130
l Destinations on page 130
l Most-targeted Devices on page 131
l Most-targeted Processes on page 131
l Communication Control on page 132
l System Components on page 132
l License Status on page 133
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Event Statistics

The Event Statistics section of the Executive Summary report displays a breakdown of the security events created
during the timeframe of the report. Security events are classified by classification. The total number and percentage of
events triggered by the Exfiltration and Ransomware policies are also displayed. For more details, seeEvent Viewer on
page 134.

Destinations

The Destination section of the Executive Summary report displays a map of all the destinations for the security events
triggered during the timeframe of the report. The names of the top seven countries with the most security events are
shown. There is a pin on the map for each represented country. For more details, see External Destinations on page
126.
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Most-targeted Devices

The Most Targeted Devices section of the Executive Summary report displays all the security events in the system
during the timeframe of the report. A breakdown for the top-five most-targeted devices is shown. For more details, see
the Most Targeted Charts on page 126.

Most-targeted Processes

The Most Targeted Processes section of the Executive Summary report displays all the security events in the system
during the timeframe of the report. A breakdown for the top-five most-targeted processes is shown. For more details, see
the Most Targeted Charts on page 126.
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Communication Control

The Communication Control section of the Executive Summary report displays the number of applications detected for
the first time during the timeframe of the report. In addition, it shows how many of these applications have suspicious
characteristics, such as low reputation or critical vulnerabilities. For more details, see Communication Control on page
175.

System Components

The System Components section of the Executive Summary report displays a bar chart showing the Collectors in the
system by their state. In addition, it shows a breakdown of the components in the system, the number of detected IoT
devices and the number of unmanaged devices (non-IoT devices on which no Collector is installed). For more details,
see the FortiEDR Components on page 13. For more details about IoT devices, see IoT Devices on page 110. For more
details about unmanaged devices, Unmanaged Devices on page 109.
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License Status

The License Status section of the Executive Summary report displays a summary of license-related information. For
more details, see Licensing on page 252.
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Event Viewer

This chapter describes the FortiEDR Event Viewer for monitoring and handling security events.

Introducing the Event Viewer

Upon connection establishment attempt, each FortiEDR Collectors sends relevant metadata to the FortiEDR Core,
which sends it on to the FortiEDR Aggregator so that it can be displayed in the FortiEDR Central Manager Event Viewer.
The Event Viewer enables you to view, investigate and acknowledge handling of each such security event. A row is
displayed for each event.

The Event Viewer enables you to display two different slices or views of the event data collected by FortiEDR:

l Device View : This view presents information by device, and shows all the security events detected on a given
device.

l Process View : This view presents information by process, and shows all the security events detected for a given
process.

Click the applicable view button at the top center of the window to display that view.

Note: Security events that were triggered by Saved Queries appear slightly different in the Event Viewer, asEvent Viewer on page 134
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Event Aggregation

For convenience and easier navigation, FortiEDR aggregates security events in both the Device view and the Process
view in the Event Viewer, as follows:

l Each primary-level row represents a device/process.

Note: The All filter also displays expired security events.
l You can drill down on a device/process to display the security events for that device/process. Each security event

row is marked with a flag indicator.
In the Process view, the Destinations column indicates the number of destinations to which the process attempted
to connect. If only one destination was accessed, its IP address is shown. If more than one destination was
accessed, the number of destination IPs is shown in the Destinations column.
In the Process view, the Device column indicates the number of devices the malware attempted to attack. If only
one device was attacked, its device name is shown. If more than one device was attacked, the number of devices is
shown in the Device column.

l You can drill down further in a security event row to view the raw data items for that event by clicking on the icon.
Raw data items display the relevant information collected by FortiEDR from the device. For example, if a specific
process was connecting to 500 destinations, then 500 raw data item rows display for that security event. For
example, in the figure below, the security event comprises 2 raw data items, coming from different devices and

going to different destinations. You can click the icon to return to the aggregated security event
view.
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Examine the data in both the Device view and the Process view to identify the source of a
problem. In this way, you can determine whether the issue is organization-wide or if only
specific devices are infected.

A security event is triggered when one or more rules in a policy are violated. For example, let’s assume that people
in your organization using the Adobe PDF application modified this application to meet their individual needs, and
that FortiEDR detected this as malware that appeared on 1,000 devices in the organization. In this case, when the
same security event occurs on multiple devices for the same process, you see the following in the Event Viewer:
o In the Device view, you see 1,000 aggregation security events, each with one security event under it.
o In the Process view, you see one security event aggregation named adobe.exe. Under it, there is one security
event for the adobe.exe process. That security event shows the number 1000 in the Devices column and
1,000 raw data items.

The Event Viewer is divided into the following areas of information:

l Events Pane on page 138
l Advanced Data on page 141
l Classification Details on page 168

The following actions can be performed in the Event Viewe:

l Marking a Security Event as Handled/Unhandled on page 143
l Manually Changing the Classification of a Security Event on page 145
l Marking a Security Event as Read/Unread on page 163
l Viewing Relevant Activity Events on page 163
l Viewing Expired Security Events on page 163
l Viewing Application Control Security Events on page 164
l Viewing Device Control Security Events on page 165
l Other Options in the Event Viewer on page 166

When a new security event is generated by FortiEDR, an indicator number displays or is incremented.

Hovering over this number indicates the number of new unread security events, shown below:
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In some cases, Updated displays next to the number of new unread security events indicator. Updated means that
FortiEDR originally classified one of the unread events, but that classification was later changed by the user. After more
data for this security event was received, FortiEDR overrode the manual classification of the event by the user and
changed the classification for the event again, based on the newly received data.

Events Pane

Clicking a security event expands it to show more details and enables the buttons at the top of the window. The following
information is provided for each security event:
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Note: The Extended Detection policy provides detection features (meaning that events are logged and displayed in the
Event Viewer). No protection (blocking) features are provided. The exceptions and forensics options are not available in
the Event Viewer for security events triggered by the Extended Detection policy, because these events were not
collected by a FortiEDR Collector.

Information Field Description

View Indicator Indicates the view context for the security event aggregation. displays for a
device and displays for a process.

Handled/Not Handled Specifies whether any FortiEDR Central Manager user handled this security
event, as described on Marking a Security Event as Handled/Unhandled on page
143

ID Specifies an automatically assigned unique identifier for each security event
generated by FortiEDR. This identifier is particularly useful for security event
tracking purposes when monitoring security events using an external system,
such as a SIEM.

Device Specifies the device name on which the security event has occurred

Process Specifies the process that is infected. This is not necessarily the process that
made the connection establishment request (such as Firefox, which might be
being controlled by the infected application). If the security event was triggered by
a script, then the script name is specified.
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Information Field Description

Classification Specifies how malicious the security event is, if at all. Classifications are initially
determined by FortiEDR. They can be changed either automatically as the result
of additional post-processing, deep, thorough analysis and investigation by the
FortiEDR Cloud Service (FCS) or manually. The FCS is a cloud-based, software-
only service that determines the exact classification of security events and acts
accordingly based on that classification – all with a high degree of accuracy. All
Playbook policy actions are based on the final determination of the FCS. For more
details, see Playbook Policies on page 89. Classifications are:
l Malicious
l Suspicious
l Inconclusive
l Likely Safe
l PUP (Potentially Unwanted Program)
l Safe

Destinations Specifies the IP address to which the malicious entity requested to establish a
connection.

Received Specifies the first time that this security event was triggered. For aggregations,
the earliest received time is displayed.

Last Updated Specifies the last time that the security event was triggered. For aggregations, the
most-recent time is displayed.

Action Specifies the action that was enforced:
l Block : The exfiltration attempt was blocked and this blocking event was
generated.

l

Simulated Block : The policy that protected this device was set to
Simulationmode. Therefore, the exfiltration attempt was NOT blocked and
this blocking event was generated. FortiEDR would have blocked this
exfiltration security event if the policy had been set to Preventionmode.

l Log . The security event was only logged and was not blocked.

For raw data items, the following information is available:

Information Description

Device Specifies the device name on which the security event has occurred.

First Seen The Event Viewer aggregates the occurrences of the same security events into a
single row when it represents the same attack on the same device. This
timestamp specifies the first time this security event occurred. The row of this
security event pops to the top of the list in the Event Viewer each time it occurs
again.
Note:If a change is made to the FortiEDR policy used by a specific FortiEDR Collector, then the security

events before and after that change are not aggregated together.
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Information Description

Last Seen Specifies the most recent time this same security event occurred. See FIRST
SEEN described above.

Destinations Specifies the external address for connection attempt security events.

Process Owner Specifies the user who ran the process that triggered the security event.

Process Type Specifies whether the infected process is 32-bit or 64-bit.

Use Specifies the domain of the computer/user of the device.

Certificate Specifies whether the process or application have a certificate – Signed or
Unsigned. You may refer to http://en.wikipedia.org/wiki/Authorization_certificate
for general information about the subject.

Process Path Specifies the path of the infected process.

Count Specifies the number of occurrences of the same raw event on the same device.

Advanced Data

The ADVANCED DATA area displays a graphic representation of what occurred that led to the security event. This
information shows operating systemmetadata that occurred immediately preceding and at the time the connection
establishment request was issued.

The ADVANCED DATA area contains three tabs.

l Event Graph on page 141
l Geo Location on page 142
l Automated Analysis on page 142

Note: The events graph tabs are always available. The other two tabs may be missing when there is no data available for the security event.

Event Graph

In addition to textual information that is displayed (described above), the Event Graph tab provides an image depicting
the flow of operating system events that led up to the connection establishment request or the attempt to lock data. The
picture is shown as a timeline from left to right (meaning that the left process happened before the others). A circle can
represent an operating system entity such as a process, a thread, a service, a file and so on. The white boxes represent
the operation that was done between the operating system entities, such as create, open, inject, connect and so on.
Typically, the last circle (rightmost) is a connection establishment request or a file access. Each white box has a number
attached to it, representing the sequence of operations, and also the rules that were violated during that operation, along
with the worst classification associated with that operation.
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You can zoom in and zoom out using the buttons at the top right. The button fits the picture to the size of the
window.

Geo Location

The Geo Location tab displays a world map showing the locations of the destinations of the security event and indicating
the country by its flag.

An abundance of additional investigative tools and information are provided by FortiEDR’s
Forensic add-on (page 153).

You can zoom in and zoom out using the buttons at the top right. The button fits the picture to the size of the
window.

Automated Analysis

The Automated Analysis tab provides additional information about the investigation done automatically on Fortinet
Cloud Services (FCS) per the security event to help you understand FortiEDR’s rationale when classifying an item with a
specific classification.

The classification history of a security event is presented in the Classification Details area (see page 129) and shows the
chronology for classifying a security event, as well as the automatic investigation and remediation actions performed by
FortiEDR for that event.
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The information shown in the Automated Analysis tab supplements this analysis, providing even more information
about how and why a given security event was classified as it was. This tab shows the actions that were performed for
the analysis plus a categorized summary of what was analyzed. For example, the analyzed files, memory segments, the
IP address involved in the communication, the email address associated with the security event and so on. A Fortinet
Cloud Services comment is available at the top of this area that summarizes the analysis verdict and conclusion in text.

For example, the following shows a security event that was initially classified as Inconclusive by FortiEDR Core, but after
FCS automatic analysis was reclassified as Malicious. In this case, four files were analyzed. You can click the name of
the file to display more details about it, including its metadata along with several properties of the file (signature,
certificate, hash and so on).

You can click the down arrow next to an item to view all the investigation actions performed and analysis results related
to that item.

Marking a Security Event as Handled/Unhandled

The following describes how to specify that you have handled a security event. When any FortiEDR Central Manager
user marks a security event as Handled, all users see it as having been handled.

1. Select the rule’s checkbox and then click the button or just click the flag icon of the security
event row. The Event Handling window displays.
Note: If an exception was already defined for this security event, then the words event includes exceptions are
displayed at the top of the Event Handling window.

2. In the Classification dropdown list, change the classification for the security event, if needed. For more
details,Manually Changing the Classification of a Security Event on page 145

3. In the comments box, use free text to describe how you handled the security event.

4. Click the Save as Handled button. The flag icon next to the security event changes from dark gray to light gray

to indicate to all users that it has been handled.
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5. [Optional] Check the Archive When Handled checkbox to archive the security event after handling it. When you
select this option, the security event is marked both as handled and as archived.

6. [Optional] Click the arrow to the left of Advanced to display theMute events notification field. Select this
checkbox if you want to mute the notifications for this security event. In addition, specify how long to mute the
security event notifications. Notifications can be muted for 1 Week, 1 Month, 1 Year or Permanently. When
checked, you will not receive notifications whenever this security event is triggered. When using this option, click the
Save as Handled button, which indicates that the security event has been both handled and saved.
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Note: Security events with muted event notifications are indicated by the icon in the Event Viewer.

Manually Changing the Classification of a Security Event

You can manually change the classification of a security event, if needed.

1. Select the rule’s checkbox and then click the button or just click the flag icon of the security
event row. The Event Handling window displays.
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2. In the Classification dropdown list, change the classification for the security event, as needed.

3. Click the

4. [Optional] Click the button to mark the security event as handled after saving
the event.
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After changing the classification of a security event, the Classification Details area displays the history of any
actions (Playbook policy-related actions and others) that were made automatically by FortiEDR, as shown below.
For Playbook policy actions, the timestamp shows when the action was performed, as defined in the Playbook
policy. For more details about Playbook policy actions, see Playbook Policies on page 89.

When the Fortinet logo appears next to an entry in the CLASSIFICATION DETAILS area, it indicates that the
security event was automatically classified by FortiEDR. Security events that are manually classified do not display
the Fortinet logo.
Note: Notifications for security events are not shown in the Classification Details area.

Defining Security Event Exceptions

The following describes how to create a new exception and how to edit an existing one.

Exceptions enable you to limit the enforcement of a rule, meaning to create a white list for a specific flow of security
events that was used to establish a connection request or perform a specific operation.

FortiEDR exception management is highly flexible and provides various options that enable you to define pinpointed,
granular exceptions.

Details describing how to edit an existing exception are described in Editing Security Event Exceptions on page 161. You

can access the Exception Manager by clicking the button at the top of the Events pane
or by selecting SECURITY SETTINGS > Exception Manager. Additional options for managing exceptions are provided
in the SECURITY SETTINGS tab, as described in Exception Manager on page 64.

An exception that applies to a security event can result in the creation of several exception pairs.

An exception pair specifies the rule that was violated and the process on which the violation occurred, including or
excluding its entire location path. For more details, see Playbook Policies on page 89

Note: After an exception is defined for a security event, new identical events are not triggered.

Security events that occurred in the past appear with an icon to indicate that an exception has been defined for
them, even though at the time they were triggered, the exception did not exist. This
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icon on past security events serves as an indication to you that there is no need to create an exception for it, since
one was already created (but after the event occurred).
In cases where an exception was defined for the security event but it does not fully cover all the existing occurrences or
raw data items of this event, a slightly different icon is displayed, as described and shown below.

Note: When defining an exception for Listen on Port Attempt events, listening on 0.0.0.0 means listening on all
interfaces. In such cases, you should use All Destinations.

Defining the Scope of an Exception

When defining an exception, it is important not to make it too broad or too narrow in scope, so that it properly identifies
and catches the data items that you want.

If an exception does not cover all the raw data items for a security event, the icon displays for that exception. This
can happen, for example if the exception was defined only on part of the collector groups and the security event occurred
on devices that are not part of the collector groups on which the exception was set.

In addition, the raw data items comprising a security event distinguish between data items that are covered ( ) and

not covered ( ) by the exception, based on the exception’s current definition.

For example, if you see that the current exception is too narrow and excludes a raw data item that you want to include in

the exception, you can click the icon and then modify and broaden the exception sufficiently so that it will also

include that raw data item. When you click the icon, the Event Exceptions window automatically opens and
displays the existing exception which can be broadened. Alternatively, you can click the + icon to create another
exception that will include the non-covered raw data item. Clicking the + icon after the exception is opened using the
covered icon next to the raw data item opens a new exception from the perspective of that raw data item, meaning that it
includes all the data that is relevant for that raw data item, as shown below:
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In addition, when saving an exception, if the exception does not cover all raw data items for a security event, a message
such as the following displays.
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You can click the Non-covered items link in this message to open the Event Viewer in a new window, and display only
not-covered raw data items, as shown below:

Defining a Security Event as an Exception

1. Click the security event row to be defined as an exception.
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2. Click the Create Exception button. The following window displays:

3. 3 Specify whether this exception applies to all the Collector Groups or only to the Collectors in the same Collector
Group as the one for which this security event was triggered.
Note: The All groups and Collector groups options only apply to the current organization in which the security event occurred.
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For a multi-organization FortiEDR system, an Administrator can also specify whether the exception applies to all
organizations. The All organizations option applies the exception to all organizations, regardless of whether or not
the security event already occurred.
If an Administrator wants to define an exception that applies to one or more, but not all organizations, then he/she
must define the exception separately for each organization.
Exceptions defined by an Administrator (Hoster) that apply to all organizations display as Locked by the
administrator to other users, and cannot be changed by a user other than the Administrator who created it, as
shown below:
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Note: The All organizations option does not display for Local Administrators or regular users. Only an Administrator can set the All organizations option.

Exceptions can only be defined for Collector Groups. If you would like to define an
exception for a specific Collector, then create a Collector Group that only contains that
Collector.

FortiEDR 5.1.0 Administration Guide 153
Fortinet Inc.



Event Viewer

4. Specify whether this exception applies to all Destinations or only to specific destinations. The Ips listed in the
dropdown menu are those Ips that generated connections for this security event. Use the dropdown menu to select
the specific Ips to exclude that were triggered on this security event, which can be either internal or external.

To apply the exception to a specific destination(s), select from the following options:

Option Description

Select All Applies the exception on all destinations that were seen as part of this security
event. If there will be an identical violation (the same set of rules will be
violated on this process) but the connection attempt will be to a different IP,
than the security event will be triggered. To exclude this security event
completely from being triggered in the future you can select the All
Destinations radio button.

Internal Destinations Applies the exception on all internal destinations. Internal destinations are
internal IP addresses that are defined in TCP/IP standard definitions for
internal networks. These IP addresses include the following:
l Loopback addresses: 127.X.X.X, 0:0:0:0:0:0:0:1 and 0:0:0:0:0:FFFF:7f
l 10.0.0.0 –10.255.255.255
l 192.168.0.0–192.168.255.255
l 169.254.0.0–169.254.255.255
l 172.16.0.0 - 172.31.255.255
l IPV6: fc00:: – fd00:: :: or fe80

This option is useful when an application is allowed for use within the
organization, but you do not want it to be used for external communications.
Using this option enables the application to communicate internally without
triggering alerts. However, the application might still trigger alerts when
attempting to connect to an external IP.

<IP Address> Applies the exception to the selected IP address. You can select multiple IP
addresses.
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Option Description

<IP Set> An IP set defines a set of Ips to be included or excluded from a security event.
When you select an IP set here, it means that an exception is applied only to a
device that has one of the Ips specified in the IP set. IP sets can only be
defined by an Administrator, as described in IP Sets on page 308.

5. Specify whether this exception applies to all users or to a specific user.

6. In the Triggered Rules area, specify the path on which to apply the exception. You can select either the Current
Path or Any Path. By default, all options are set to Any Path. In this context, the path indicates the entire path of
the [folder name] in which the process’s file is located. The Current Path is the path used in this security event, as
displayed in the window. When you select Any Path, the process triggers the exception no matter from where it is
running.
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You can define an exception so that a security event is triggered, based on a complex set of conditions. For
example, you can define an exception so that a security event is triggered when a specific process (B) is executed
by another process (A). For example, you can limit an exception so that it applies only when process B is executed
by process A, or every time that process B is executed.
You can also define an exception that specifies that an exception is triggered only when one of the two process
triggers is running, as shown below:

You can also define an exception specifying that it is triggered only when both processes are running.
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You can click the Help button to view relevant help information, as shown below:

FortiEDR enables you any to specify any of the processes in a security event’s stack when defining an exception.
Let’s look at an example in more detail. Let’s say that you want to define an exception that allows the SurSvc.exe
executable to run, but only when it is created from the services.exe executable. Therefore, in order to define this
exception, you would select the SurSvc.exe process in the Apply exception on field and select the services.exe
process in theWhen created by field. Based on this security event’s ancestry chain,wininit.exe, which is the
grandparent of the SurSvc.exe executable, would not be selected in theWhen created by field.
Note that the immediate parent of the SurSvc.exe executable is services.exe and that it is therefore listed at the
top of the When created by field dropdown list and that the SurSvc.exe executable’s grandparent iswininit.exe,
which is listed at the bottom of the list. The order in which the processes run in a security event chain is always
maintained. This means that the oldest ancestor is shown at the bottom of the list of processes in this window and
the immediate parent is at the top.
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You can edit the process path and file name. Wildcards can be used for this purpose.
Note: To use wildcards as part of a process path or file name definition, all Collectors must be V3.0.0.0 or above. If you attempt to use wildcards with older

Collectors, the following error message displays:
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You can only edit the process path or file name when selecting the Current Path option. To do so, click the adjacent

Edit button, and then edit the process/file name as needed. When doing so, the following conditions apply:

Field Condition

Path l Only an asterisk (*) character(s) can be added.
l Do not change the displayed path. Otherwise, it will no longer match.
However, you can replace a piece of the string with an asterisk (*).

l Only a single asterisk character (*) is permitted between two consecutive
path separators (/).

l The number of separators (/) in the displayed path must remain the same.

File Name l Only an asterisk (*) character(s) can be added.
l Do not change the file name. Otherwise, it will no longer match. However,
you can replace a piece of the string with an asterisk (*).

l Only a single asterisk character (*) is permitted.
When a wildcard is used as part of the process path or file name
definition, the entry displays in green, as shown below:

7. [Optional] Enter any comments in the Comments box.
8. Click the Create Exception button.

9. [Optional] You can define another exception for this same security event by clicking the plus button at the top of
the window. Then, define the exception in the same manner as described above in steps 1–8.
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Note: If this exception was created previously, the Remove Exception button appears enabling you to delete the exception.

Device Control Exceptions

Note – Device Control capabilities are license-dependent. You may contact Fortinet Support for more information.

Exceptions on device control security events are similar to other exceptions, with several additional capabilities that
enable you to set the exception on a device name, description, serial number or a combination, as follows:

l The USB device’s description is specified under the Process Name field.
l The device’s serial number is listed in order to exclude a specific USB device with the designated serial number.
l The device’s name is specified under the second Process Name.

For example:
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Editing Security Event Exceptions

1. Click the Edit Exception button in the security event row for the exception you want to modify. The following
window displays:
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2. Modify the Collector Groups, Destinations and Users to which the exception applies and the pairs of rules and
processes that operate together to define an exception in the Triggered Rules area, as needed. For more details,
see Defining a Security Event as an Exception on page 150.
For a multi-organization FortiEDR system, an Administrator can also specify whether the exception applies to all
organizations. The All organizations option applies the exception to all organizations, regardless of whether or not
the security event already occurred.
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3. Click the Save Changes button.

Marking a Security Event as Read/Unread

The following describes how to specify that you have viewed a security event. This does not mean that the security event
has been handled (Marking a Security Event as Handled/Unhandled on page 143). When any FortiEDR Central
Manager user marks a security event as Read, all users see it as having been read. Unread security events are
displayed bold.

To mark a security event as having been viewed:

l

Select the rule’s checkbox and then click theMark As button and then selectMark
as read. The security event row text is no longer displayed bold.

Viewing Relevant Activity Events

Security events may have related Activity events that can be viewed in the Threat Hunting tab.

To view the related Activity event of a Security Event in the Event Viewer –

l Click on the Threat Hunting icon that is displayed when you hover over the event, as shown below. The
Threat Hunting window is then displayed.

Viewing Expired Security Events

Security events in the Event Viewer can be filtered to show only expired events. Expired security events are events that
the system has determined as safe. As such, these security events are only triggered once and then saved internally in
the system. There is no need to define an exception for them. Expired security events cannot be handled in the system in
any way, such as marking them as read/unread, defining an exception for them and so on.

Expired security events can only occur when a Collector is connected to the Core, and do not occur when a Collector
works autonomously.
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Viewing Application Control Security Events

Security events in the Event Viewer can be filtered to show only Application Control security events. Application control
security events are events that were triggered on rules that are part of the Application Control policy. Such events do not
necessarily mean that there was malicious activity but indicate an attempt to execute an application that is listed in the
user-defined blocklist. These security events are displayed separately from other security events. Defining an exception
for them can be done in a similar manner as for other security events. The exception specifies which applications are
blocked by its hash.
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Viewing Device Control Security Events

Note – Device Control capabilities are license-dependent. You may contact Fortinet Support for more information.

Security events in the Event Viewer can be filtered to show device control security events. Device control security events
are events that were triggered on rules that are part of the Device Control policy. Such events do not necessarily mean
that there was malicious activity but indicate USB peripheral access. These security events are displayed separately
from other security events. Defining an exception for them can be done in a similar manner as for other security events.
The exception can be set on the device name, vendor, serial number or a combination.
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Other Options in the Event Viewer

Option Description

Sorting Events Click any column name to sort security events. For example, you may want to sort
by Process and Collector in order to see the history of everything that happened
to that process on that device.

Searching For Events Click the down arrow in the Search Event field to display a variety of search

options . When the Event Viewer display is filtered
by a search, the Search Event field displays the wordsMultiple search

. Click the to redisplay all the security events
(unfiltered).
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Option Description

Note – The User field refers to the employee’s username on the computer and on
the FortiEDRManager.

You can select one or more action types in the AIR Action
dropdown list.

Exporting Events Click the button to export the selected security events to Excel or

PDF.

Archiving Events
Click the button to archive the selected security events. These
security events are not deleted. You can display them using the Search option
(described above) and selecting the Included Archived Events option.

Note – To unarchive a security event, click the Unarchive button, and then
confirm the unarchive action in the window that displays.

Deleting Events
Click the button to completely delete a security event from the FortiEDR
system.
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Option Description

Note – A deleted security event cannot be restored or retrieved. Unless you are
having storage capacity issues, we highly recommend just hiding security events
and not deleting them.

Forensics The optional FortiEDR Forensics add-on enables you to perform deep analysis of
security events, as described on Forensics on page 204.

Exception Manager Click the button to access the Exception Manager, as

described on Exception Manager on page 64.

Classification Details

The Classification Details area displays the classification, policy and rules assigned to the FortiEDR Collector that
triggered this security event.

Click the History down arrow to display the classification history of a security event. The classification history shows the
chronology for classifying the security event, and the actions performed by FortiEDR for that event. This area also
displays relevant details when the FortiEDR Cloud Service (FCS) reclassifies a security event after its initial
classification by the Core.

All FortiEDR actions are based on the final classification of a security event by the FCS. The FCS is a cloud-based,
software only service that determines the exact classification of security events and acts accordingly based on that
classification – all with a high degree of accuracy. All Playbook policy actions are based on the final determination of the
FCS.For more details, see Playbook Policies on page 89.

For example, the following example shows that the security event was reclassified by the FCS and given a notification
status of Suspicious at 15:44:51.
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In the Triggered Rules area, only rules that were violated are displayed. The rule’s configured Action is displayed for
each rule, as defined in POLICIES. The Action that was actually executed is displayed in the action column of the
EVENTS pane of this window. The Action taken is determined by the rule with the highest priority.
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Each entry in the CLASSIFICATION DETAILS area displays the threat name, threat family and threat type. If threat
intelligence data is available for the threat, it displays as well.
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When the Fortinet logo appears next to an entry in the CLASSIFICATION DETAILS area, it indicates that the security
event classification is the one that was automatically added by FortiEDR. Security events that were manually classified
do not display the Fortinet logo.

Contact Fortinet Support for more details about the third-party tool used by Fortinet for the classification process.

Note that when the Playbook policy that relates to a security event is set to Simulation mode, then the event action is
documented in the Event Viewer, but is not performed. Such security events display (simulation) in the History section of
the Classification Details area, as shown below:
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Note – Notification actions are not shown in the Event Viewer, but Investigation and Remediation actions are. For more details, seePlaybook Policy
Actions on page 92.
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When expanding triggered rules, you can see the techniques that were used in this security event, based on the MITRE
ATT&CK common techniques scheme. Clicking the technique opens the MITRE web page, providing additional details,
as shown below.
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Communication Control

This chapter describes the FortiEDR COMMUNICATION CONTROLmechanism for monitoring and handling non
disguised security events.

Application Communication Control - How Does it Work?

FortiEDR provides visibility into any communicating application in your organization, enabling you to control which
applications can communicate outside of the organization.

After FortiEDR installation, the system automatically maps all applications in your network that communicate externally.
After that, you then decide which of these applications to allow to communicate externally when used by a legitimate
user in your organization (allowlist). After the allowlist of communicating applications is defined, only applications in the
allowlist can communicate externally. If an attacker abuses an application in the allowlist, FortiEDR’s patented
technology (Exfiltration and Ransomware prevention policies) blocks the communication and displays a security event in
the EVENTS tab.

FortiEDR Communication Control uses a set of policies that contain recommendations about whether an application
should be approved or denied from communicating outside your organization.

These policies can be configured as a next-generation firewall in order to automatically block communications of
potentially unwanted applications. For example, applications with a known bad reputation or that are distributed by
questionable vendors.

Moreover, FortiEDR Communication Control provides data and tools for efficient vulnerability assessment and control.
Virtual patching is made possible with Communication Control policies that can be configured to automatically block
connections from vulnerable applications.

FortiEDR’s Communication Control mechanism provides the following key advantages:

Mechanism Description

Realtime Proactive Risk
Mitigation

Attack surface reduction using risk-based proactive policies that are based on
application CVE and rating data.

Avoids Productivity Inhibitors Non-authorized applications can still execute. Only their outgoing communication
is prevented.

Manageability Reduces the scope of the problem, which means that Security/IT needs to handle
only applications that communicate externally.

Frictionless Application Control Reduces users’ requests from Security/IT to approve applications.
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Introducing Communication Control

The Communication Control tab identifies all the communicating applications detected in your organization. To access
this page, click the down arrow next to COMMUNICATION CONTROL and then select Applications.

Note – The tab bar at the top of the window may display a white circle(s) with a number inside the circle to indicate that
new applications. The number represents the number of new applications.
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You can hover over the number to see the list of new products. Each row shows the number of new products, by day.

The Communication Control tab contains two main pages:

l Applications on page 177
l Policies on page 194

Applications

The APPLICATIONS page lists all communicating applications detected in your organization that have ever attempted to
communicate. By default, applications are sorted according to their first-seen indicator, placing new applications at the
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top. To access this page, click the down arrow next to COMMUNICATION CONTROL and then select Applications.

Information is organized hierarchically in a two-level tree. The first (top) level specifies the name of the application. The
second level specifies the application version. For example, the figure below shows five versions for the TeamViewer
application.

The following information displays for each application in the application list:

l Selection checkbox
l Resolving status icon
l Signed/Unsigned indication
l Application/Version: The name of the application/version.
l Vendor: The application’s vendor and certificate details.
l Reputation: The reputation score of the application. For more details, Reputation Score on page 179
l Vulnerability: The highest CVE vulnerability score for the application. For more details, see Vulnerability on page
180

l First Seen: The date and time when the application was first seen in the organization.
l Last Seen: The date and time of the last connection of this application.
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The Application Details area of the window on the right displays policy-related details for the entity (application or
version) selected in the application list. This area displays the policy action (Allow or Deny) for each communication
control policy.

The Advanced Data area at the bottom of the window presents statistics about the selected application/version in the
application list. For more details, see Advanced Data on page 188.

Reputation Score

Each application in the APPLICATIONS page shows a Reputation indicator. Reputation scores are determined by a
third-party service, and are based on the hash (signature) of the file.
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Reputation scores use the following range to indicate the reputation for an application:

Reputation Score Reputation Description

1 Known as bad

2 Assumed as bad

3 Unclear, indication a contradiction or inability to determine the reputation

4 Assumed as good

5 Known as good

The Reputation indicator displays Unknown if the reputation score is unknown.

Vulnerability

This option is only available to users who have purchased the Discover and Protect license or the Discover, Protect
and Response license.

Each application in the application list also shows a vulnerability score.

FortiEDR categorizes applications/versions based on the Common Vulnerability Scoring System (CVSS) CVE scheme,
which is commonly used worldwide. FortiEDR’s vulnerability scoring system provides a useful tool for vulnerability
assessment, and enables you to review the weaknesses detected in your environment that could be exploited by
attackers before they actually occur. Vulnerability assessment can be used together with virtual patching to block
applications with known critical vulnerabilities, so that they cannot connect, until the system is patched for the CVEs
listed.
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FortiEDR categories vulnerabilities into the following categories based on National Vulnerability Database (NVD)
severity ratings:

l Unknown
l Low
l Medium
l High
l Critical

The Vulnerabilities area at the bottom right of the window lists the CVE-identified vulnerabilities for the selected
application/version. Each CVE row includes the CVE identifier, the FortiEDR-assigned vulnerability Category and the
CVSS vulnerability scores.

Note – CVSS scoring utilizes two systems: CVSS 3.0, the most recent, and CVSS 2.0, its predecessor. FortiEDR
vulnerability information presents both CVSS 3.0 and CVSS 2.0 scores.

You can click a CVE identifier link to view more details about that vulnerability in your browser, including the type of
vulnerability, the application(s) it affects, the version(s) it affects and so on.
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After a vulnerability is detected in your system, you can decide the type of the action needed to address it. Typically, it is
recommended to upgrade to a newer version of the application, meaning one that does not have the identified
vulnerability. Alternatively, virtual patching can be applied with vulnerability-based policy that is configured to block
communication of any application with known critical vulnerability. For more details, see Policies on page 194. The
information presented in the Advanced Data area of the window also provides useful information to help protect against
vulnerabilities. For more details, Advanced Data on page 188.

Resolved vs. Unresolved Applications

By default, all new applications have an Unresolved status. Unresolved means that either FortiEDR or the user have not
examined the application to ensure that it is safe. Applications with the Unresolved status are indicated by the icon in
the application list.

FortiEDR automatically resolves an application as safe by checking the application’s characteristics. For example,
checking the application’s reputation and vulnerabilities to ensure that it does not have a bad reputation or critical
vulnerabilities. Applications that meet these criteria are automatically changed to the Resolved status by FortiEDR.
Applications with the Resolved status are indicated by the icon in the application list. Applications can also be changed
to the Resolved status by the user, as described onResolved vs. Unresolved Applications on page 182

Sorting the Application List

The application list can be sorted alphabetically by product, vendor, reputation score, vulnerability or arrival time (first
seen or last seen). By default, the list is sorted by arrival time, with the most recent communication at the top.

Marking an Entry as Read/Unread

The following describes how to specify that you have viewed an entity in the application list. You can mark applications or
versions as read/unread.

The first time that an application/version is detected in the application list, it is shown in bold. Bold indicates that the item
is unread (see below).

FortiEDR 5.1.0 Administration Guide 182
Fortinet Inc.



Communication Control

To mark an entity as read:

Select the entity’s (application or version) checkbox and then click the down arrow on the button
and selectMark as read. The text no longer displays in bold.

Note – If you mark an application version as read, all lower levels in the version hierarchy for that application are also
marked as read.

Modifying a Policy Action

The following describes how to apply a different action to an application/version other than that specified in the current
policy for that application/version. In this case, the application/version is excluded from the current action defined in the
policy (Allow or Deny).

When modifying a policy action in this manner, the Application/Version Details area displaysManually to indicate that
the action was modified manually, and is excluded from the action defined in the policy.
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To modify a policy action:

1. Select the application/version checkbox and then click the button. The Modify Action window displays.

2. In the dropdown list on the right of the policy row whose action you want to change, click the down arrow and then
select the action to apply to the selected entity. You can change the action for one or more policies.

3. [Optional] In the Comment field, enter a free-text comment describing the action change. By default, the date and
time when the policy action was changed automatically displays.

4. [Optional] Check the Exclude All Current Versions checkbox if you want to exclude existing application versions
from the decision. In this case, the new communication control decision only applies to a future version of the
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product. The application of the policy action change applies for current versions of the application. When this
checkbox is not selected, the change is applied to all versions of the application.

5. Click the arrow next to the button to save the new communication control

decision for the selected application(s).

When any FortiEDR Central Manager user marks an application/version as Resolved, all users see it as having been
resolved. You can also mark an application/version as resolved using the icon in its row in the application list.

Searching the Application List

You can use the field to perform an advanced search. Click the down arrow to open
the Search Applications window, in which you specify your search criteria.

You can filter the application list by the following criteria:

Filter Criteria

Application Filters by application name

Version Filters by version. This is a free-text field.

Vendor Filters by vendor name.

Certificate Filters by signed or unsigned certificate.
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Filter Criteria

Reputation Filters by reputation score. Check the checkbox(es) for the reputation score(s) of
interest.

Vulnerability Filters by vulnerability score.

CVE Identifier Filters by exact match of the vulnerability identifier, using the following format –
CVE-YYYY-nnnn.

First Connection / Last
Connection

Filters by the specified date range when the first/last connection of the application
was detected in the system.

Status Filters by status (Resolved, Unresolved,).

Action Filters by action.

In Policy Filters by policy. If you specify a specific action in the Action field, then you can
only select from policies with that specific action.

Policy Filters by a specific policy.

With Rule Filters by a specific policy predefined rule.

Collector Group Filters by the Collector Group used to communicate. This means that a device(s)
in the specified Collector Group was used to communicate.

Collector Filters by the Collector (device) used to communicate.

Destination Filters by the Collector destination (IP address).

Process (Name/Hash) Filters by the process name or hash value.

Other Options in the Application Pane

Option Function

Click the down arrow in the button and then select an option

in the dropdown list to filter the application list accordingly. You can filter the list
by:

All Lists all applications for the organization.

Unreolved Lists applications that have not been resolved by either the user or FortiEDR.
Applications with this status are indicated by the icon in the application list. This
is the default filter.

Resolved Lists applications that have been resolved by either the user or FortiEDR.
Applications with this status are indicated by the icon in the application list.

Unknown Vendors Lists applications whose for which the vendor is not known in the system.

Low Reputation Lists applications with a low reputation score.

Critical CVE Lists applications with a Critical CVE score.
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Option Function

Unread Lists applications that have not yet been viewed in the application list.

Click the down arrow on the button and then selectMark as
read orMark as unread. For more details, you may refer to the Marking an Entry
as Read/Unread on page 182.

Click to delete the entity selected in the application list. Note that if the deleted
entity attempts external communication again, it will be added back to the
application list. In this case, any action defined in the policy for this entity must be
redefined.

Click the button to change the current policy action to be applied for the selected
entity, as described onModifying a Policy Action on page 183

Click the advanced filter to review applications by suspicious characteristics, such
as existing vulnerabilities or reputation score. This filter can be used to set up
policy rules. See Policy Rules on page 198.

Click the down arrow in the button and select the format for

exporting data. You can select PDF, Excel or JSON.

Use the Search Application field to perform an advanced search, as described
in Searching the Application List on page 186.

Advanced Data

The Advanced Data area presents statistics about the selected entity in the application list. The information that displays
varies, depending on the entity selected (application or version).

Application Advanced Data

When an application is selected in the application list, the Advanced Data area displays the following information for it:

l Application Information on page 189
l Application Usage on page 190
l Destinations on page 191
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Application Information

The Application Information area displays summary information about the selected application.

In the Process names field, a separate row appears for each application that shares the same vendor, product and
version properties. The Process names field displays the full file path for each such application.

You can click the three dots next to the Process names field to navigate to the Threat Hunting window for that process
name or hash, or to explore the hash in VirusTotal, as shown below:
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Application Usage

The Application Usage area displays details about usage of the selected application.

This area shows the number of connections (communication sessions) per day. The top line shows the total number of
devices within the organization on which the selected application is installed.

Each row below the underline represents a different Collector Group, and shows the number of devices in the
organization in that Collector Group.

Each person icon represents 10% of the total devices in the organization/Collector Group. Black icons represent

devices that communicate externally using the selected application, and gray icons represent devices that did not
communicate externally using the application.

You can hover over the people icons to see the percentage of devices that communicate externally per day using the
selected application. For example, the figure below shows that only 3% of the devices in the organization have the
selected application installed.
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Click theMore… link to open the following window, in which you can view additional details about the selected
application.

Click the Export to Excel button in this window to export application usage information to Excel.

Destinations

The Destinations area shows the destinations to which the selected application communicated (Allowed) or attempted to
communicate (Denied).
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Each row shows the IP address, connection time and country of the destination.

By default, this area displays the five most-recent destinations. Click theMore… link to open the following window, which
displays the last 50 destinations.

Version Details

The Version Details area displays the action defined for the application in each policy, plus its vulnerability details and
affected destinations.
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Policies

The POLICY SETTINGS page displays the Communication Control policies that can be applied to an application or
version in the application list. Communication Control has its own policies. Each policy row can be expanded to show the
rules for that policy. To access this page, click the down arrow next to COMMUNICATION CONTROL and then select
the Policies.

Communication Control policies define the actions to be taken for a given application or application version. Each policy
applies to a different Collector Group(s), and all the devices that belong to that Collector Group(s). A Collector Group can
only be assigned to one policy.

The following information is defined for each communication policy:

Information Field Description

Policy Name The policy name appears in the leftmost column. The policy name is defined when
the policy is created.

Rule The rule as it applies to the policy. The default action for the policy is displayed
under the default rule of the policy. For more details, see the Policy Rules on page
198.

Affected Apps The number of applications affected by the policy.

Action Specifies the action that is enforced when this rule is violated (Allow or Deny).

State (Enabled/Disabled) This option enables you to disable/enable this rule.

The Assigned Collector Groups area on the right lists the Collector Group(s) assigned to the policy.
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Predefined Policies

FortiEDR is provided out-of-the-box with several predefined policies, ready for you to get started. These policies are
marked with the logo.

l The Default Communication Control policy is one such policy, and is always listed first in the list of policies. The
Default Communication Control policy is a blocklisting policy that is automatically applied to any Collector Group
that is not assigned to any of the other Communication Control policies.

l The Servers predefined policy is an allowlist policy that assigns a Deny action to all applications by default, except
for a list of known, recognized and legitimate applications, which are allowed. This policy gives your organization a
jump-start, as some of the leg work to identify legitimate applications in your organization has already been done for
you.

l The Isolation predefined policy isolates (blocks) communication to/from a device. This policy cannot be deleted and
only applies in Prevention mode. When this policy is in force and communication for a given device has been
blocked, you can manually permit communication to/from the device for a specific application using the procedure
below.

To permit communication to/from the device for a specific application:

1. Select the APPLICATIONS page.
2. Select the application/version to which you want to permit communication.
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3. Click the Modify Action button. The following displays:

4. In the Isolation Policy row, select Allow in the dropdown menu.

Policy Mode

The slider for a policy indicates the current mode for the policy. A green slider indicates Prevention mode and a

gray slider indicates Simulation mode. You can change the mode using the button at the top
of the Policies pane. For more details about these modes, you may refer to Protection or Simulation Mode on page 56.
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Policy Rules

For each communication policy, FortiEDR provides four rules out of the box. These rules can be modified to specify the
connections to be blocked/unblocked according to several parameters. FortiEDR provides the following communication
policy rules:

Policy Rule Description

Default rule This rule applies when none of the other three rules apply.

Reputation is less than or equal
to X

This rule enables FortiEDR to block/unblock by reputation score.

Vendor is within X vendors This rule enables FortiEDR to block/unblock by vendor. For this rule, you specify
the vendor(s) to include and to exclude.

Vulnerability is greater than or
equal to X

This rule enables FortiEDR to block/unblock by vulnerability. In the rules, X
represents a user-defined value.

In the rules, X represents a user-defined value.

For example, the figure below shows that the Servers Policy has the following rules defined for it:

l Vendor is within 12 vendors. This rule is enabled for the policy. The action for this rule is Allow.
l Default rule (if none of the rules apply). This rule is always enabled.

You can enable or disable a rule for a policy by clicking the Enabled/Disabled button in the State column of the applicable
rule. This button toggles between Enabled/Disabled.
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Editing a Policy Rule

The four rules for a policy can be modified, as needed.

To edit a rule:

1. Click the Edit button for the rule of the policy that you want to modify. This switches the view to the
APPLICATIONS page, enabling you to review the applications affected by this rule before saving it. The following
displays:

2. In the Select Filter dropdown list, select the parameter whose value you want to set in the rule. This dropdown list
lists the parameters available to configure for the rule.

3. In the rightmost Select Criteria dropdown list, select the value for the parameter. This dropdown list lists the values
available to configure for the parameter specified in step 2.

Note –When modifying the Vendor is within X vendors rule, you specify the vendor(s) to include and those to exclude for the rule.
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4. Click the Setup rule link.

5. In the Under dropdown list, select the policy to which this rule applies.

6. In the Then field, specify whether to Allow or Deny the application based on this rule.

The application list now shows the number of application(s) affected by the rule change.

7. Click the Save and Enable button to save and enable the changes to the rule. A confirmation window displays,
confirming the rule change.
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8. ClickOK.

Assigning a Policy to a Collector Group

1. Check the policy that you want to change in the policy list and then click the Assign Collector Group button. The
following displays:

2. Check the checkbox of the Collector Group you want to assign to the policy.
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3. Click the Assign button. A window displays, prompting you to confirm the reassignment.

4. ClickOK. The following displays:

5. ClickOK.

Creating a New Communication Control Policy

A new Communication Control policy can be created by cloning an existing policy, as described below. New policies are
only needed if you are going to assign different policies to different Collector Groups. Otherwise, you can simply modify
one of the default policies that come out-of-the-box and apply it to all FortiEDR Collector Groups by default.
Modifications made on one policy do not affect any other policies.

1. In the policy list, check the policy that you want to clone. There are two types of Communication Control policies:

blocklisting policies (  ), such as the Default communication control policy, which allows any connection by

default, and allowlisting policies (  ), such as the Servers policy, which denies any connection by default.
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2. Click the Clone button. The following window displays:

3. In the Cloned Policy Name field, specify a name for the cloned policy.
4. Click the Clone button.

Other Options in the Policies Pane

Option Description

Click the down arrow in the button and then select an option in the
dropdown list to filter the policy list accordingly.

Click this button to clone a policy.

Click this button to delete a policy. Before deletion, a confirmation message
displays, prompting you to confirm the deletion of the policy.

Click the down arrow in the button and then select the mode

for the policy, as described in Policy Mode on page 197
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Forensics

This chapter describes the FortiEDR Forensics add-on option for deep analysis of security events.

Introduction

The Forensic Analysis add-on enables a security team (or anyone else) to delve deeply into the actual internals of the
communicating devices’ operating system that led up to the security event.

The Forensic Analysis add-on provides an abundance of deep analysis and drill-down options that reveal the process
flows, memory stacks and a variety of operating system parameters in a graphic view, such as:

l Infected device and application details.
l Evidence path, which includes the process that the threat actor violated and which type of violation was executed.
l Side-by-side security event comparisons.

This option is only available to users who have purchased the Forensics add-on license, which is part of the Protect and
Response license or the Discover, Protect and Response license.

The first stage of working with Forensics is to select one or more security event aggregations or security events to
analyze. To do so, use one of the methods below:

l

In the Event Viewer, select a security event aggregation and then click the button. Selecting a
security event aggregation lets you analyze the aggregation of events triggered on this process.

In this case, the Forensics add-on shows a separate tab for each security event associated with the security event
aggregation. For example, the figure below shows seven tabs for a security event aggregation containing two
events.
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l

Select an individual security event in the Event Viewer and then click the button. In this case, the
Forensics add-on shows a single tab for the selected security event, with all of its related raw data items.

l

Select a raw data item when in drill down, and then click the button. In this case, the Forensics
add-on shows a single tab for the selected security event with a single raw data item.

l In the FORENSICS tab, select Events. In the page that displays, click the Event Viewer link, shown below, and
then select the security event of interest using any of the methods described above.

You can click the button in the FORENSICS tab to display classification details, including the classification, policy
and rules assigned to the FortiEDR Collector that triggered this security event. For more details about classification
details, see Classification Details on page 168.
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To perform deep Forensic analysis:

1. Select the security events to analyze using one of the methods described on Event Viewer on page 134.
Selected security events that are currently loaded to the FORENSICS tab are marked in the Event Viewer with a
fingerprint icon.

2. Each selected security event is then displayed in the Event Viewer as a separate tab:

Each tab shows the same information as in the Event Viewer on page 134, with additional information as described
below.
The following options for viewing more information are provided:
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In the Raw Events area, use the right and left arrows to scroll through the raw data items for a security event.

Click the All Raw Data Items button to display all raw data items. Click the Selected Raw Data Items
button to select a specific raw data item. This action opens the following window, in which you specify the raw data
item(s) to display.

Click Close in the SELECT RAWDATA ITEMS window. The Events page displays only those raw data items you
selected in the view.
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Click the Threat Hunting button to review relevant Activity Events in the Threat Hunting tab

Flow Analyzer View

This view shows a graphic flow diagram depicting the history of what happened before the security event was triggered,
from left to right. Each node can represent a process, a thread or a service.

The arrows indicate the sequence of processes and specify the operation that was performed, such as Create, Inject,
Open and so on. If multiple operations were performed between two processes, then multiple arrows are shown

between them. If an operation repeated several times in the same segment, it is represented by a dashed line .
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Typically, the next to last rightmost node represents a connection request and specifies the IP to which it

attempted to establish a connection. It can also represent an attempt to lock or encrypt a file by ransomware .

The rightmost node represents the action performed by FortiEDR, such as Block, Log or Simulated Block.

The flow chart is interactive. Clicking on a specific node or arrow drills down to the Stack View (described in Stack View
on page 209). This enables you to perform further investigation of the specific stack that was collected during that step.

Stack View

The Stack View displays the following sections of information:

Field Description

Events Shows the same information as in the Event Viewer on page 134.

Stacks A control toolbar that depicts the stacks that were collected in each step prior to
the connection establishment requestor file access. A red dot means that a rule
violation was observed in this stack. You can click the different stack names to
see the collected stack data.
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Field Description

Stack Content Details The bottom of the window displays each stack in the flow of the selected step. The
stack entries represent the executable files that resided in the stack upon
collecting the stack data. Click the stack node to filter the display to show that
stack. The selected stack appears with a red line below it.
Click the Process Hash link display a dropdown menu with the following options:

l VirusTotal: Checks whether this hash was seen elsewhere. This involves
searching another external website (VirusTotal). Clicking the link runs the
query in VirusTotal. Alternatively, you can go to www.virustotal.com, click the
Search tab, paste the hash from FortiEDR and then click Search It.

l Threat Hunting: Checks the activity events that are relevant to this hash.
Clicking this option takes you to the Threat Hunting page.

l Add to Blocklist: Adds this hash to the Application Control block list, as
described in Application Control Manager on page 73. Clicking this option
opens up the Add Application Window with this hash specified.

For each executable, you can see the following information:

l Executable File Name
l Writeable: Specifies whether the executable code can be modified.
l Certificate: Specifies whether or not the certificate was signed.
l Repetitions: Specifies how many times this executable was detected in the stack.
l Base Address of this entry in memory.
l End Address of this entry in memory.
l Hash: Specifies the file hash.

The row of the executable that triggered the FortiEDR security event is highlighted with a red dot . This
indicates the row that you may want to investigate further.

You can click an executable row to display an even deeper level of information describing that process, as shown below:
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Compare View

The Compare View enables you to display two views side-by-side. They can both be either Flow Analyzer View on page
208or Stack View on page 209
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Defining an Exception

After Forensic analysis, you may decide to create an exception for a specific security event. To do so, you may refer to
the Defining Security Event Exceptions on page 147. You may refer to Playbook Policies on page 89 for general
information about Exceptions.

Remediating a Device Upon Malware Detection

After malware is detected on a device, you can use one of the following methods to remediate the situation in the
FortiEDR system:

Method Description

Terminate the Process This method does not guarantee that the affected process will not attempt to
execute again.

Delete the Affected File from the
Computer

This method ensures that the file does not attempt to exfiltrate data again, as the
file is permanently removed from the device. When using this method, be careful
not to delete files that are important to the system, in order to protect system
stability.

Remove or Modify the Registry
Key

This method removes a registry key or updates a registry key’s value. This
method changes malicious registry key modifications by removing newly created
keys or returning key values to their original form.
Note – Some malware have persistency capabilities, which makes the infection
appear again. In addition, in some rare cases, malware can cause the system to
crash if you try to remove them.
Both of these methods can be performed using the Forensics add-on.

To remediate a device on which malware was detected:

1. Select the security event(s) to analyze using one of the following methods described onEvent Viewer on page 134
2. In the Raw Events area, select the relevant process. Use the various forensic tools provided by FortiEDR to

determine the process of interest.
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After selecting the process of interest, the bottom pane of the window displays the list of files associated with that
process.
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3. Check the checkbox of the relevant file and then click the button. The following window displays:
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4. Do one of the following:
a. Check the Terminate process checkbox to terminate the selected process. A warning message displays.

Click Terminate process to terminate the selected process.
b. Check the Remove selected executable file checkbox to delete the specified file from the device. A warning

message displays.

Click Delete file to remove the selected file.
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c. Check the Delete file at path checkbox. In the adjacent field, enter the file path on the device that contains the
file to be removed.

A warning message displays.

Click Delete file to remove the file from the specified path.
d. Check the Handle persistent data (registry) checkbox to clean the registry keys in Windows. In the adjacent

field, enter the value of the registry key to be removed or modified.

Value data should be provided in the required format, based on the value type selected in the dropdown list, as
follows:
l String for types REG_SZ(1), REG_EXPAND_SZ(2), REG_DWORD(4) and REG_QWORD(11).
l Base64 for types REG_BINARY(3), REG_DWORD_BIG_ENDIAN(5), REG_LINK(6), REG_MULTI_SZ
(7), REG_RESOURCE_LIST(8), REG_FULL_RESOURCE_DESCRIPTOR(9) and REG_RESOURCE_
REQUIREMENTS_LIST(10).

Select the Remove key radio button to remove the registry key value.
Select the Modify registry value radio button to change the current registry key value. When selecting this
option, you must also specify the new value for the registry key in the gray box and the key’s value type in the
adjacent dropdown menu (for example, string, binary and so on).

5. Click the Remediate button.
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Retrieving Memory

The Retrieve Memory function enables you to retrieve the stack-memory of a specific Collector. This option enables
you to retrieve memory from a specific communicating device in order to perform deeper analysis by analyzing the actual
memory from the device. This function is only accessible from the Stack View.

Memory is fetched by the Collector in binary (*.bin) format, compressed, encrypted and then sent to the user’s local
machine. The returned file is password-protected. The password is enCrypted.

If the file cannot be sent, it is saved locally on the host by the Collector.

To retrieve memory for a Collector:

1. In the Stack View, select the stack(s) that you want to analyze by selecting its checkbox(es).
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2. Click the Retrieve button. The following window displays:

3. Select one of the following options:
a. Retrieve memory of selected stack entries: Select this radio button to retrieve memory for one or more

specific stack entries. Then, select the stack entries you want to analyze by checking their checkboxes, as
shown below:

You must also specify whether to retrieve the memory fromMemory, Disk or both by selecting the respective
checkbox. TheMemory option is the default. You can select either option or both options. It is important to
remember that the retrievable data may be different in the memory and on disk. In addition, the stack entry may
no longer reside in memory, for example, if the system was rebooted.
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After you make your selection, the window indicates how many stack entries were selected, as shown below.
For example, the figure below shows that three stack entries were selected for analysis.

b. Retrieve memory region from address: Select this option to retrieve memory from a specific memory region.
Specify the To and From addresses for the region in the adjacent fields.

c. Retrieve the entire process memory: Select this option to retrieve memory for an entire process. This option
retrieves all the stack entries comprising the process.

4. Click the Retrieve button.

Isolating a Device

An isolated device is one that is blocked from communicating with the outside world (for both sending and receiving). For
more details about device isolation, see Investigation on page 93.

Note – Isolation mode takes effect upon any attempt to establish a network session after isolation mode has been initiated. Connections that were established

before device isolation was initiated remain intact. The same applies for Communication Control denial configuration changes. Note that both Isolation mode and

Communication Control denial do not apply on incoming RDP connections and ICMP connections.

To isolate a device using the FortiEDR Collector:

1. In the EVENT VIEWER tab, select the checkbox(es) of the security event(s) that you want to isolate, and then click
the Forensics button, as shown below:
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The following window displays:

2. In the Events tab, click the security event that you want to isolate, click the button dropdown arrow
and then select Isolate. The following window displays:
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3. Click the Isolate button. A red icon appears next to the relevant security event in the Events tab to indicate that
the applicable Collector has been isolated, as shown below:

To remove isolation from a device:

1. In the FORENSICS tab, select the checkbox of the security event whose isolation you want to remove.

2. Click the down arrow on the button and select Remove isolation, as shown below.

The following window displays:
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3. Click the Remove button.

Threat Hunting

FortiEDR’s Threat Hunting feature enables you to search for many types of Indicators of Compromise (IOCs) and
malware across your entire environment in order to enable enhanced detection. Searching can be based on various
attributes of files, registry keys and values, network, processes, event log and activity event types. Search operations
apply to both Windows and Linux operating system activity.

Two versions of FortiEDR’s Threat Hunting feature are supported:

l Threat Hunting on page 222
l Legacy Threat Hunting on page 249

Note – Threat Hunting is a license-dependent add-on. You may contact Fortinet Support for more information.

Threat Hunting

Threat Hunting significantly expands and enhances the capabilities of the Legacy Threat Hunting feature, which is
described in Legacy Threat Hunting on page 249. In addition to searching for activities based on a security event’s
process or HASH, you can also search for these activities based on a variety of activity types (such as Process Creation,
File Deletion, Registry Value change, Socket Connect and so on), as well as by Process/File/Registry/Network or Event
Log criteria.

Threat Hunting is ideal in situations where you have identified malware on one endpoint and want to search throughout
your organization to determine whether this same malware exists on another endpoint, even though it may not be
currently running (stealth mode) or in situations where you would like to hunt for the existence of a specific IoC within
your organization.

Note – This Threat Hunting page automatically becomes the only option available after all Collectors are V5.0 or above.

Threat Hunting utilizes activity events, which specify an action taken by an entity. Each type of entity may be involved in
a variety of types of actions. An activity event consists of a source (usually a process), an action (the activity event type)
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and a target (Process, file, Registry key/value, network item(, where the source performs the designated action on the
target.

For example, when a process runs, it can perform various actions on files, such as File Open, File Read, File Delete and
so on. In this case, the process is the source, and it performs an action such as File Open on a target File.

Note – Activity events are not the same as the security events identified in the Event Viewer. Unlike Event Viewer security events, which are only reported in the

Event Viewer as they occur and are detected, activity events are continuously collected based on a wealth of data, activity and actions occurring in your system

and the chosen Threat Hunting Profile. You may refer toThreat Hunting on page 80 for more information.

FortiEDR categorizes the various actions that can be performed into the following categories:

Action Description

Registry Key Actions All targets are either registry keys or registry values and all actions are registry-
related, such as Key Created, Key Deleted, Value Set and so on.

File Actions All targets identify the target file on which the action was performed and all actions
are file-related, such as File Create, File Delete, File Rename and so on.

Process Actions The target is another process and all actions are process related, such as
Process Termination, Process Creation, Executable Loaded and so on.

Network Actions The target is a network item (such as connection or URL) and all actions are
Network related, such as Socket Connect, Socket Close and Socket Bind.

Event Log Actions The only action is Log Entry Created and relates to the logs of the operating
system - Windows and Linux.

Access the Threat Hunting page under the Forensics tab by selecting the Threat Hunting option under the Forensics
tab. The following page displays:

The Threat Hunting page contains the following areas:

l Filters on page 224
l Facets on page 233
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l Activity Events Tables on page 236
l Details Pane on page 240

Filters

The Filters area enables you to define a query that filters the activity events to display in the result tables. It comprises
the following filters:

Note – This area also enables you to save queries and to redisplay saved queries, as described inSaving Queries and Saved Queries on page
226.

Filter Description

Category Filter The Category filter enables you to filter the activity events by their Category.

Device Filter The Device filter enables you to filter by a specific device[s].
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Filter Description

Free-text Query Filter This filter enables you to specify a free-text query to filter the results. This filter
uses Lucene syntax. For details about the supported Lucene syntax features, see
Appendix B - Lucene Syntax on page 380

To simply query definition, the free-text query filter has an auto-complete helper
dropdown list that contains all the available activity event fields, as well as
available syntax operators. Simply start typing to see a dropdown menu of
options. The automatic-complete helper guides you through the process of
creating a query by displaying appropriate options in the dropdown menus, such
as fields and operators when appropriate.
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Filter Description

Time Filter The Time filter enables you to filter for a specific time period. The default is the last
hour.

To clear the contents of all the filters in the Filters area, at the far right of the page, click the button and select Clear all.

Saving Queries and Saved Queries

After filtering the activity events displayed in the result tables, you can save the query to be redisplayed when needed.
Saving a query in this manner also enables you to define it as a Scheduled Query in order to automate the process of
threat detection.
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To save a query:

1. Use the filters to display the desired filtered events in the result tables.

2. In the Filters area, at the far right of the page, click the button and select Save Query. The following displays
populated with the current filter definitions. The Category, Device and Time dropdown menus show the filter
selections and the box underneath it shows the actual query string. For example, as shown below:

3. Fill in or modify the definitions of this saved query, as follows:
l Query Name: Enter any free text name describing this query.
l Description: Enter any free text description of this query.
l Tags: Enables you to assign one or more metadata tags to this query. You can assign a previously defined tag
to this query or define a new tag. These tags can then be used for general information purposes and for
searching through queries in the Event Viewer.
Note – These tags only relate to saved queries.

Click the + to assign tag(s) to this query. The following displays:
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All previously defined tags (for any query in your organization) are listed for your selection.

If this tag is assigned to this query, a checkmark appears on its left: .
To assign a tag to this query, simply click on it. It will then show the checkmark to its left. Each tag that you
assign appears as an icon, as follows:

To unassigned a tag from a query, click on it in the list so that its checkmark is removed or hover over it to
display an X and then click the X to delete it, as shown below:

To create a new tag, click the + Add New Tag button.
To modify the name of the tag or to delete it from the list (and from all queries to which it was assigned
previously in the organization(s) of the logged in user), hover over it and click the Edit or Delete icon, as

needed.
Click the Apply button to assign all the selected tags (with checkmarks) to this query.

l Organization: Specifies the name of the organization in a multi-organization FortiEDR environment when the
logged in user has a Hoster role. In a single-organization FortiEDR system, this field does not appear.

l The Category, Device and Time dropdown menus show the filter selections and enable you to modify the
selection.

l Query String Box: Displays the actual query string according to the selections made above and enables you
to modify it.

l Community Query: Select this option to specify that it is shared with the entire FortiEDR community including
other organizations.
Note – After you have defined a Community Query and saved it, you can edit it. Unchecking the Community
Query option means that this query is no longer available to the FortiEDR community. If however, a community
member already copied this query, they will still have it, even after you unshare it here.

l Scheduled Query: Mark this option to automate the process of detecting threats so that this query is run
automatically according to the schedule that you define. A security event is automatically created in the Event
Viewer upon detecting threats (query matches). Notifications are sent according to the security event’s
definition, such as via email, Syslog and so on.
Marking this checkbox shows the following options:
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The time range of the activity events that this query matches is determined by the frequency of the schedule.
For example, if you define that the query automatically runs once a week, then each time it runs, it will match
and create a security event for all the activity events in the most recent week; the same goes for it being
scheduled once a month – in this case, the query will match all the activity events in the most recent month.
Define the scheduled query, as follows:

Field Definition

Classification Select the classification of the Security Event to be issued when the
scheduled query has run and found matches. The Classification specifies
how malicious the security event is, if at all. Classifications are initially
determined by FortiEDR automatically or manually and are shown in the
Event Viewer, as described in Classification Details on page 168. They can
be:
l Malicious
l Suspicious
l Inconclusive
l Likely Safe
l PUP (Potentially Unwanted Program)
l Safe

Repeat Every/On These options enable you to define the frequency and schedule when this
query will be run. For example, to repeat the query every week on Sunday,
make the selections shown in the screen above.

4. Click the Save button to save this query so that it is available to be redisplayed, as described below. The system
runs the query immediately in order to verify that it is functional.
Note – if the system detects a large quantity of events about which to send notifications, then a warning message is
displayed suggesting that you refine the query so that there are less matches. The reason being that extremely
large quantities of notifications may be more of a hindrance than a help.

To display a saved query:

1. In the Filters area, at the far right of the page, click the button and select Saved Queries. The following displays
listing all the queries that were saved using the Save Query option.
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For each saved query, this list shows the quantity of matches detected (MATCHES), the quantity of devices on
which these matches were detected and the last time the query was run (LAST RESULT). These three columns are
highlighted in gray, as shown above. Additional details about the queries definition are also displayed in each row.

2. Click on the row of a Saved Query to display additional details about that query’s most recent run. For example, as
shown below:

3. You can filter this list of saved queries by typing into the Search field and/or selecting one of the following options:
a. Scheduled/Unscheduled: To specify that Scheduled Queries are listed in this window, click the Scheduled

option. A Scheduled Query is one whose Scheduled Query field was marked when it was created/modified.
b. Community/User: To specify that Community Queries are listed in this window, click the Community option. A

Community Query is one whose Community Query field was marked when it was created/modified.
appears in the list next to Community Queries. User refers to queries that are not Community Queries,
meaning that each one is only available to the Organization for which it was created.

4. 4 You can modify a Saved Query by hovering over it. The following tools are displayed on the right of the row:

Tool Definition

Run Now To run and detect activity events now according to this Saved Query.

Edit To edit the Saved Query definition.

Delete To delete the Saved Query. Multiple queries can be deleted at once by
marking the checkboxes on the left side of each row and then clicking the

Delete
icon at the top of the window.
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5. To enable/disable a saved query, mark the checkboxes on the left side of the relevant rows and select the
Enable/Disable option in the Set State dropdown menu.

Scheduled Queries

Scheduled queries enable you to automate the process of detecting threats so that it is activated automatically according
to the schedule that you define. This will enable timely and continuous detection and notification of threats. A Scheduled
Query runs automatically when you define a Query as a Scheduled Query, as described below. Each time it runs and
detects a match, it generates a security event in the Event Viewer, and sends a notification (via email, Syslog and so on)
according to the security event’s definition.

The security event that is generated by a Scheduled Query in the Event Viewer is similar to a standard security event,
except for the following:

l The following options are not available in the Event Viewer for Saved Query Security Events:
o The Forensics option is not available because it is irrelevant.
o An Exception cannot be defined for Saved Query Security Event.

l In the Process View of the Event Viewer, a Saved Query Security Event shows the name of the Saved Query
instead of the process name, as shown below:

The Classification (in the CLASSIFICATION column) is determined by the definition of the Saved Query.
In the same manner as other security events it indicates the quantity of devices (in the DEVICE column) on which
this type of activity events were found. All other aspects of a Saved Query Security Event are the same as other
security events.

l Clicking the Threat Hunting option on the right side of the Saved Query Security Event in the Event Viewer displays
the Threat Hunting tab and the Saved Query that was run, because that is what triggered the security event.
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l The Event Viewer does not show any ADVANCED DATA for a Saved Query Security Event.

l Triggered Rules: When a Saved Query Security Event is selected in the Event Viewer, the Triggered Rules pane
on the bottom right of the page indicates that this security event was triggered by a Scheduled Threat Hunting
Query, as shown below:

The name of the saved query is listed below it. Click that Saved Query’s name (for example, Credential Access
(Edited)) to display additional details about this saved query, such as its description and the tags that were defined
when it was created/modified, as shown below:
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l

In the Device View of the Event Viewer, a Saved Query Security Event appears under the devices that were
affected. It also shows the name of the Saved Query instead of the process name, as shown below:

If this security event was triggered for more than 100 devices, then this row shows a notification indicating that they
are not all listed here and that you can use the Threat Hunting in option on the right of this event’s row to investigate
further.

Facets

As expected, the continuous, realtime collection of Threat Hunting data produces numerous activity events. The sheer
volume of activity data makes working directly with these activity events almost unmanageable. Therefore, FortiEDR
uses facets to summarize the data displayed in the results tables. Facets are predefined in FortiEDR and represent the
same data that is displayed in the results tables, but in an aggregated form. As such, facets represent the aggregation of
the values in the results tables.

Each individual facet pane summarizes the top five items for that facet. For example, in the Type (action) facet below, the
facet lists the top five actions, based on the filters applied in the query. The number at the top in parentheses () indicates
the total number of different values for this facet in the results table, in this case 24. In this case, the top five actions are
Socket Close, Socket Connect, Library Loaded, Key created and Socket ind.

Facet can show the bottom five instead of the top five. In order to switching from the top five to the bottom five for this

specific facet, click on the arrow on the right side of the number .
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The filters applied in the Filters area affect the results displayed in the Facets and Results Tables areas.

The displayed facets vary according to the filters used in the Filters area.

You can click theMore link to display additional facets.

You can click the button to minimize the Facets area.

Filtering Using Facets

Facets provide an easy-to-use mechanism to aggregate the results in the Activity Events tables. In addition, you can also
further narrow the results in the Activity Events table directly from the facets by including or excluding specific values. For

example, when you hover over an item in a facet pane, a green and red button appear in its row. Click the green plus

button to include that item as a filter or click the red minus button to exclude that item as a filter.

Then, click the Apply button.
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An item highlighted in green indicates that it has been marked as an
inclusion filter, but has not yet been applied by clicking the Apply button. An item highlighted in red

indicates that it has been marked as an exclusion filter, but has not yet been
applied by clicking Apply.

Clicking the Apply button applies the additional filtering criteria to the threat hunting query. In addition, it creates a chip
(indicated by the arrow in the following picture), which represents that additional filter and displays it at the top of the
Facets area. In the example below, the query has been further filtered to only show the File Create type of action. Each
chip is also part of the threat hunting query.

Each chip has either a green or red border on its left side to indicate whether it was defined to include (green) or exclude
(red) that item in the filter.

Each Facet pane may have a green or red left border to indicate whether it has been applied in the query, meaning that
the displayed results are filtered by it.

You can define an unlimited number of chip filters, with an AND relationship between multiple filters. Each facet can
create up to two chips, one for the inclusion of values and one for the exclusion of values.

If two values have been added to the query from the same Facet pane, the relationship between the values in the chip is
OR. The following example shows that the query includes activity events in which their Target Process Name is either
chrome.exe or teams.exe, which is shown below in both the chip and in the facet.
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Hovering over a chip enables you to remove, disable or copy it, as follows:

Tool Definition

Remove The chip is removed and the Facets and Result tables are updated accordingly.

Disable A disabled chip no longer affects the results. The Facets and the Results tabs are
updated as if the chip was removed and the chip appears as follows:

Copy The chip content is copied to memory and can be pasted into the query for further
editing.

In order to enable a disabled chip and update the results according to its criteria, click the Enable icon.

Activity Events Tables

The results presented in the tables in this area are activity events. The Activity Events table area contains six tabs, each
representing one Category of activity events, as follows:
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Category Definition

All Activity This tab lists all activity events, based on the filters defined for the Threat Hunting
query. The number in parentheses () specifies the total number of activity events,
based on your query criteria. This total equals the sum of the activity events in the
other five tabs. Each Category of activity events is represented by a different icon,
as follows:
l Process

l File

l Registry

l Network

l Log
You can hover over the icon in the Process and Attributes column to temporarily
display additional details about the source process, including whether it is signed,
its signature, issuer and so on.

Note – There are several types of attribute icons, such as Signed/Unsigned.

Process This tab shows all matching activity events of category Process.

File This tab shows all matching activity events of category File.

Network This tab shows all matching activity events of type Network.
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Category Definition

Registry This tab shows all matching activity events of type Registry.

Event Log This tab shows all matching activity events of type Event Log.

Each table contains a row for each matching activity event and each table includes different columns according to the
Category.

You can select which columns should appear in any of the tables using the Choose Columns option at the far right of
the page. You can type in the Search box to help narrow the list of columns that display.

Each activity event may also be a part of a behavior and/or a MITRE Technique. A behavior indicates that this activity
event is part of a specific behavior as determined by FortiEDR. A MITRE type (Technique or Tactic) indicates that the
activity event is part of specification of a technique and tactic as classified by MITRE.

The activity events that have such behaviors and/or MITRE indications have values in the related columns in the Activity
Events Tables, as shown below:

When an activity event has a related MITRE indication, it is indicated at the Details Pane (see below). You can hover
over the associated icon to display more details.
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Filtering Using Activity Events Tables

The Activity Events Tables area can be used to add filters to the query in a similar manner as Facets.
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When you hover over an item in the table, a green and red button appear to its right. Click the green plus button to

include that item as a filter or click the red minus button to exclude that item as a filter. For more details, see Filtering
Using Facets on page 234.

Details Pane

You can click anywhere in a row in any of the Activity Events Tables to display more details about the specific Activity
Event in a Details pane on the right. The selected row is marked by a green border on its left.

The Details pane for an activity event contains a Summary tab and one or two other tabs, as follows:
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l Summary Tab: This tab specifies a summary of the Activity Event. At the top of the tab it shows details about the
Endpoint, including the endpoint and its IP, path, operating system and so on. The area below the Endpoint section
shows the source process and its detail. The area below the source graphically shows the action again, which is the
Activity Event type, as well as some additional data regarding the action, if any. The area at the bottom of the pane
shows the target and its details. You can click the or arrow in an area of this pane to show or hide additional
relevant details, respectively.
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l Process Tab: This tab shows additional details about the source process.

FortiEDR 5.1.0 Administration Guide 242
Fortinet Inc.



Forensics

l Target Tab: This tab only displays if the target is of type Process or File and details additional data regarding such.

You can click an icon in the Details pane to display additional details, as shown below:
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Event Log Details Pane

The Details pane for an activity event of type Event Log Created appears somewhat differently, as shown below. In this
case, the action is always Log Entry Created and the target is always the event ID.

You can scroll down in the Target area to view the actual log entry.
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Retrieving a File / Remediating Devices upon Malware Detection

You can remediate any file that is a target of an activity event. You can also download a copy of any file (Retrieve action)
that is a target of an activity event.
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To retrieve a file or remediate the process:

1. Select the relevant Activity Event and open its Details Pane.
2. When hovering over the file name, you can select either of the following options:

l In the Summary pane, select the three dot dropdown menu and then select Retrieve of Remediate the file, as
shown below:

– OR –
l In the Details pane, click the Retrieve or Remediate button, as shown below:

Adding an application to the Application Control policy blocklist

You can add any process that is either the source or the target of an activity event to the Application Control Policy
blocklist such that this process won’t launch on the devices that are assigned to that Application Control Policy.
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To add a process to an Application Control policy:

1. Select the relevant Activity Event and open its Details Pane.

2. In the Summary page, click the option next to the process name and select Add to Blocklist, as shown below:

OR
Go to either the Source or the Target tab of type process and click the Add to Blocklist button, as shown below:
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GDPR and Activity Event Data

The FortiEDR system fully complies with the General Data Protection Regulation (GDPR) standard, as described in the
Personal Data Handling section on page 224. When you use the Personal Data Handling feature to delete data, it also
deletes activity event data. However, the Personal Data Handling Search option does not search for and display the
activity data that it will delete. Just for your own knowledge, in order to see a list of the activity data that will be deleted
you can view it here before you delete it. To do so, simply enter a query here that includes the chosen record from the
Activity Report (that can be accessed by selecting Administration >Tools > Personal Data Handling) in order to find
the data to be removed. For example, if you have provided the string 149 in Personal Data Handling for Search by
Device name, then in the displayed Activity Report, select the record containing the Device name to be deleted. In this
example, it is US-Dev149. Then, in order to display all the activity events that are related to this device, enter the query
Device.Name: US-Dev149, as shown below in order to display the relevant records.
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To find all activity related to a user chosen from a Personal Data Handling Activity Report, enter the following query, and
select the required time range:

"Source.File.Owner:<username> OR Source.User:<username> OR Process.File.Owner:<username here> OR
Process.User:<username> OR Target.File.Owner:<username>"

Similarly, to find all activity related to an IP chosen from a Personal Data Handling Activity Report, enter the following
query:

"Device.IPInternal:<IP> OR LocalIP:< IP > OR RemoteIP:< IP > OR Target.Network.AdditionalData.RemoteIp:<IP>"

Legacy Threat Hunting

FortiEDR’s Legacy Threat Hunting is available in FortiEDR environments that have been upgraded to v5.0 and above
from previous versions. This feature enables you to hunt for files and hashes that were collected before the upgrade to
v5.0.

Use the Legacy Threat Hunting feature when there are Collectors in your system that have not been upgraded to
FortiEDR V5.0 in order to search for files/hashes on those Collectors. After all Collectors have been upgraded to V5.0 or
above, you can use FortiEDR’s Threat Hunting feature instead, which has more extensive collected data. For more
details, seeThreat Hunting on page 222

.Access the Threat Hunting Legacy page under the Forensics tab.

Click the Threat Hunting option under the Forensics tab. This action opens the Threat Hunting page. In this case, the
Hash/Process field is empty.

To search for malware using Threat Hunting (Legacy):

1. Select the basis for the search by clicking the or button. When you select the

button, the search results represent matching HASH values. When you select the button, the
search results represent matching file names.
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When accessing the Threat Hunting page using Method 1, the relevant HASH value appears in the field adjacent

to the button, as shown below.

When accessing the Threat Hunting page using Method 2, the field adjacent to the and
buttons is empty.

2. If the field adjacent to the and buttons is empty, copy and paste the applicable file name or
HASH value into the empty field.

3. Specify the time range for the search using the timeline buttons at the top of the window.

4. Click the Search button. The system searches for matching files in all devices in your environment. When the
search completes, the search results display in the window. The example below shows a search by process.

The row directly above the results table summarizes the results of the search. For example, in the window above,
the system found 2 unique devices and one unique path created in the same one week. The example below shows
the results of a search by HASH.
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The labels row directly above the summary row identifies common, shared data elements. For example, Sha-1,
vendor and so on. The identified elements are shared by all files. Note that typically you see more common data
elements when searching by HASH than by process.
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Administration

This chapter describes the FortiEDR Administration options, which are only available to users with administration rights
(Local Administrators and Administrators).

Licensing

Selecting LICENSING in the ADMINISTRATION tab displays all the entitlements provided by your license.

This window also shows your Serial Number, which is your FortiEDR unique identifier with Fortinet.

Note – The tab bar at the top of the window may display a white circle(s) with a number inside the circle to indicate that
new security events have not been read by the user. For Administration, the number represents the number of unread
system events.

You can hover over the number to see the list of unread system events. Each row shows the number of system events
added by day.
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Updating the Collector Version

The Update Collector Version feature is used to update a FortiEDR version, such as from version 3.1.0 to 3.1.1. To
update a FortiEDR revision, use the Automatic Updates feature described on Automatic Collector Updates on page 295.

When you click the Update Collectors button in the Licensing window, the Update Collector Version window displays.
This window lists all available Collector Groups. TheWindows Version, MacOS Version and Linux Version columns
indicate the current FortiEDR version for the Collectors in a Collector Group.
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You can update the version for the Collectors in a Collector Group for each operating system.

Note that if the Automatic Updates checkbox is checked in the Tools window, then the Update Collector Version
window does not display the revision number in the Windows Version, MacOS Version and Linux Version columns, as
the revision is automatically updated with the Automatic Updates feature.
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To update the version for the Collectors in a Collector Group:

1. Check the checkbox of the Collector Group(s) whose Collectors you want to update. You can select more than one
Collector Group.

2. Select the checkbox of the operating system(s) to update and in its adjacent dropdown list, select the FortiEDR
version for the Collectors in the designated Collector Group. You can select more than one operating system.

3. Click Update. FortiEDR gradually updates all the Collectors in the Collector Group(s) to the required version for the
specified operating system(s), and displays the following window:

4. ClickOK.
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Loading a Server Certificate

To load a certificate:

1. Click . The Load Central Manager Certificate dialog opens.

2. Click Choose File to upload the certificate file.

The certificate common name (CN) must match the FQDN of the FortiEDRmachine.
Otherwise, an error will occur.

3. Click Choose File to upload the private key file.
4. Enter the certificate password in the Private Key Password field.
5. Click Upload.
6. Configure the certificate as follows:

l For cloud deployment, please contact Fortinet Support.
l For on-premise deployment, on the FortiEDRManager VM, add connector.ssl.externalAddress =
%certificate domain% to the /opt/FortiEDR/webapp/application-customer.properties file,
and then restart the VM.

Requesting and Obtaining a Collector Installer

You can click the button to obtain a Collector installer file that can be used to install a
Collector. This option enables you to request an installer for a particular operating system(s), such as Windows, MacOS
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or Linux. This installer is similar to the standard wizard used to install a Collector, except that many of the fields in the
wizard have already been filled in for you. The requested installer is then emailed to you. After you receive the installer
file from FortiEDR, simply unzip it using the password provided in the email, double-click the installer and then follow the
instructions to install a Collector based on the operating system on which it is to be installed, as described in Installing
FortiEDR Collectors on page 26.

In order to determine the type of installer to request (according to the operating system), configure the settings in the
Custom Collector Installers window, as described below.

To configure custom installer settings:

1. In the Licensing window, click the button. The following displays:

2. In the Select the installer you would like to generate area, select the checkbox of the installer(s) you want to request.
Multiple installers can be requested at the same time.

3. In the adjacent dropdown list, select the installer version. When selecting installers for more than one operating
system, you must specify the version for each of them. Specify the version in the same manner as described on
Updating the Collector Version on page 253

4. In the Aggregator Address dropdown list, select the aggregator to which this Collector is registered.
5. In a multi-tenant system, select the organization to which the installed Collector is registered in theOrganization

dropdown list.
6. In theGroup dropdown list, select the Collector Group to which the installed Collector is assigned, or leave the field

empty for the Collector to be assigned to the default Collector Group.
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7. In the Advanced area, specify the following:

l VDI (Virtual Desktop Infrastructure) Installation: If you are installing the Collector on a VDI environment,
check this checkbox. For more details, you may refer to the Working with FortiEDR on VDI Environments
section on page 54.

l Use System Proxy Settings: If you use a web proxy to filter requests in this device’s network, then check the
Use System Proxy Settings checkbox. Note that Windows must be configured to use a proxy and tunneling
must be allowed from the Collector to the Aggregator on port 8081 and from the Collector to the Core on port
555. (Run as Administrator: netsh winhttp set proxy <proxy IP >).

l Start After Device Reboot: Check this checkbox in order to delay data collection until a device reboot is
applied. This is only required in rare cases. Typically, this checkbox remains unchecked.

8. In the Send Installers Link To field, specify the email address to which the installer is to be sent.
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9. Click the button. A confirmation message displays.

10. ClickOK. After the installer is generated by FortiEDR, it is emailed to the specified email address. Note that the link
to download installers is only available for several hours. Be sure to download the installers within the required time
period so that the link does not expire.
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Users

The USERS option specifies who is allowed to use the FortiEDR Central Manager console. During installation of the
FortiEDR Central Manager, you must specify the user name and password of the first FortiEDR Central Manager
console user. This is the only user who can log in to the FortiEDR Central Manager console for the first time.
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To add a user:

1. Click the button.
2. Fill in the displayed window.

3. Define this user’s password. Make sure to remember it and notify the user about this password.
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4. Select the user’s Role. The system comes with three predefined user roles:
l Admin: Is the highest-level super user that can perform all operations in the FortiEDR Central Manager
console for all organizations. This role can create users for any organization. For more details, seeMulti-
tenancy (Organizations) on page 338.

l Local Admin: Is a super user that can perform all operations in the FortiEDR Central Manager console only for
its own organization. Typically, the Local Administrator sets up the users for its organization. This role can only
create users for its own organization.

l User: This user is allowed to view all information and to perform actions, such as to mark security events as
handled, change policies and define Exceptions. This user is very similar to the Local Administrator. However,
this user cannot access the ADMINISTRATION tab, which is described in this chapter.

Note –When upgrading FortiEDR from a version prior to V3.0, all administrators in the previous FortiEDR
version are automatically assigned Administrator and Local Administrator privileges. You can decide whether
to leave each such administrator with both sets of privileges, or to only assign them the Local Administrator
role.

5. Check the Require two-factor authentication for this user checkbox if you want to require two-factor
authentication for the user. When checked, this user must be authenticated using two-factor authentication in order
to log in. For more details about two-factor authentication in FortiEDR, seeTwo-factor Authentication on page 262.

6. Click Save.

Two-factor Authentication

You can require two-factor authentication for a specific FortiEDR user. In this case, that user must provide additional
proof in addition to their user name and password whenever logging in to FortiEDR. In FortiEDR, two-factor
authentication can be used with any third-party authentication application such as Google Authenticator, Microsoft
Authenticator or Duo, in order to verify the user’s identify.

To designate that a user requires two-factor authentication, you must check the Require two-factor authentication for
this user checkbox for that user, as described in Users on page 260.

To log in using two-factor authentication (in this example we use the Google Authenticator app):

1. For a user who requires two-factor authentication to log in, the following window appears the first time that user
attempts to log in.

2. 2 Enter the user name and password and click LOGIN.
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3. After clicking LOGIN, the user’s identify must be verified using Google Authenticator. To do so, launch Google

Authenticator by clicking theGoogle Authenticator icon on your mobile device. A QR code displays, as
shown below:

4. Scan the QR code that displays in the FortiEDR window using your mobile device. After scanning, a FortiEDR token
appears on the mobile device, as shown below. Note that this token (code) changes every 30 seconds.
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5. In the FortiEDR login window, click the INSERT AUTHENTICATOR CODE button. The following window displays:

6. Enter the authentication token (code) you received in step 4, and then click SUBMIT. Be sure to enter the latest
code, as the code changes every 30 seconds.
From this point on, the user can log in using the standard manner. Note that FortiEDR asks for a new token once
every seven days. This means that you must repeat steps 1 through 6 when logging in to FortiEDR every seven
days.

Resetting a User Password

Use the procedure described below to reset a user’s password.

If a user who must use two-factor authentication cannot access the FortiEDR application because of a lost or replaced
mobile device, that user must repeat the procedure in Two-factor Authentication on page 262 in order to log in. Before
performing this procedure, you must first reset that user’s password to accept a new two-factor authentication token.

To reset a user password:

1. In the ADMINISTRATION tab, click the USERS link. The user list displays.
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2. Click the Reset Password button for the user whose password you want to reset. The following window displays:

3. Do one fo the following:
l Click the Set a New Password radio button and define a new password for the user.
l For a user that must use two-factor authentication, click the Reset the Two-Factor Authentication Token
radio button to force user identity verification using two-factor authentication during that user’s next login. This
means that the user must complete the procedure inTwo-factor Authentication on page 262in order to log in.

4. Click the Reset button.

LDAP Authentication

Lightweight Directory Access Protocol (LDAP) authentication is an open, industry-standard application protocol for
accessing and maintaining distributed directory information services over an IP network. LDAP provides a central place
to store usernames and passwords. This enables many different applications and services to connect to an LDAP server
to validate users. This has a major benefit that allows a central place to update and change user passwords.

When LDAP authentication is enabled in FortiEDR, whenever a user attempts to log in to FortiEDR, the system looks for
that user name and password in the central directory, instead of within the FortiEDR directory. If the user is not found on
the LDAP server, the system checks whether the user is defined locally (under Admin > User Settings).

Before you start firewall configuration, make sure that your FortiEDR deployment includes an on-premise Core that has
connectivity to the LDAP server. Details about how to install a FortiEDR on-premise Core can be found in Installing the
FortiEDR Core on page 397.
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To set up LDAP authentication in FortiEDR:

1. Click the LDAP AUTHENTICATION button.

The following window displays:

2. Fill in the following fields:

Field Definition

LDAP Enabled Check this checkbox to enable LDAP authentication in FortiEDR.

On Premise Core Select the on-premise FortiEDR Core that is to communicate with the LDAP
server.

Directory Type Specify the type of central directory in use. FortiEDR supports Active Directory
and OpenLDAP. The default is Active Directory.

Server Host Specify the IP address of your LDAP server

Security Level Specify the protocol to be used for the secured connection – TLS, SSL or
None.

Port This value is dependent on the security protocol that was selected.

Bind DN and Bind Password Specify the user and password for the authentication of FortiEDR in the
Central Directory.

Base DN Specify the location in the Central Directory hierarchy where the Groups that
are used for permission mapping can be found. For example, the DN for the
root of the Domain should always work, but results in low performance.
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Field Definition

User Group Name/Local Admin
Group Name/Admin Group
Name/API Group Name

Specify the name of the group, as it is defined in your central directory (Active
Directory or OpenLDAP), that is to be granted FortiEDR permissions. Be sure
to specify a name for the User, Local Admin, Admin and API groups. Each
of these groups corresponds to a different role in FortiEDR.
For example:
To give the user John user permissions in FortiEDR (for both the FortiEDR
application and the RESTful API), assign John to a FortiEDRUsers group that
is defined in your Central Directory. Then, specify FortiEDRUsers in the text
box next to the User Group Name in the LDAP configuration page of the
FortiEDRmanagement UI. Then, during authentication, FortiEDR determines
the relevant role for the user John by checking that the Central Directory exists
and that the password used in the FortiEDR login page matches the password
in the Central Directory. If both exist and are correct, then FortiEDR checks the
FortiEDRUsers group to which John is assigned and in this case, matches the
user role permissions.

3. 3 If users must use two-factor authentication to log in, check the Require two-factor authentication for LDAP logins
checkbox. For more details about two-factor login, see the Two-factor Authentication section on Two-factor
Authentication on page 262.
Note – Click the Reset 2FA Token button to reset the two-factor authentication token for a specific user. This process works in the same way as described

inResetting a User Password on page 264.
4. Click Save.

Note – Users in Active Directory must not have a backslash (\) in the user name, in order for the name be supported by the FortiEDR Console. In some

cases in Active Directory, a backslash is added when there is a space between a user’s first and last names. For example, “CN=Yell\, “.

SAML Authentication

Security Assertion Markup Language (SAML) is an XML-based open standard for exchanging authentication and
authorization data between parties, particularly between an identity provider (IdP) and a service provider (SP).

FortiEDR can act as an SP to authenticate users with a third-party IdP, enabling transparent user sign-in to the FortiEDR
Central Manager Console.

To set up SAML authentication in FortiEDR:

1. Click the SAML Authentication button.

The following window displays:
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2. Click the Download button to download and save SP data from FortiEDR, which is used by your IdP server during
SAML authentication. Then, upload this FortiEDR data as is to your IdP server using a standard method.
If your IdP requires manual configuration, you can extract the following fields from the XML file that you downloaded
and use them for manual configuration:

Field Description

Entity ID Located under themd:EntityDescriptor tag, in the entityID attribute.

Logout Address Value Located under themd:SingleLogoutService tag, in the Location attribute.

Login Address Value Located under themd:AssertionConsumerService tag, in the Location
attribute.

Certificate Value (Public) Located under the ds:X509Certificate tag.

3. Fill in the following fields:

Field Definition

SAML Enabled Check this checkbox to enable SAML authentication in FortiEDR.

SSO URL Specify the URL to be used by users to log in to FortiEDR. If necessary, you

can edit the suffix of this URL (shown in green) by clicking the Edit button
and then modifying it as needed. You can also copy the URL to the clipboard

using the Copy button (for example, in order to email the FortiEDR
SAML login page to your users).

Make sure that the suffix does not include any spaces and is comprised of only
letters, numbers and underscores

IDP DEscription Specify a free-text description. For example, you may want to specify the IdP
server that you are using here.
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Field Definition

IDP Metadata Upload the IdP metadata to FortiEDR. You can either upload an *.XML file or a
URL. To upload a file, click the File radio button and then click the Select File
button to navigate to and select the applicable *.XML file. To upload a URL,
click the URL radio button and then specify the requisite URL.

Attribute Name Specify the name of the attribute to be read by FortiEDR, in order to determine
the permissions and role to be assigned to that user in FortiEDR. This attribute
must be included as part of the response from the identify provider server to
FortiEDR when a user attempts to log in to FortiEDR.

Role/Group Mapping Specify an attribute value for the User, Local Admin, Admin and API groups.
You must specify a value for at least one of these user roles. Each of these
groups corresponds to a different role in FortiEDR.

Note that if more than a single role is mapped to the user, FortiEDR expects to
get multiple roles as a list of values and not in bulk in the SAML assertion that
is sent by IdP.

4. Click Save.

The examples below describe how the Azure, Okta or FortiAuthenticator SSO services can be used as an IdP that
provides authorization and authentication for users attempting to access the FortiEDR Central Manager console. It
demonstrates how to exchange metadata between the two entities, how to define group attributes and how to associate
them with SAML users so that user permissions are dictated by the Group/Roles mapping in FortiEDR SAML
configuration.

SAML IdP configuration with Azure

Note – Azure may require a license to support SAML integration with their Enterprise Application. Contact Microsoft’s support for further information.

To configure general SAML IdP portal settings:

1. Before you start configuring SAML on Azure, download and save SP data from the FortiEDR SAML configuration
page (fortiEDR.sp.metedata.id.1.xml), as described above on page 197.
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2. Sign in to the Azure Dashboard.
3. In the Azure services, select and navigate to the Azure Active Directory.
4. From the left menu, select Enterprise applications.
5. Click New Application and then Create your own application. The following displays:

6. Leave the default and click Create. The following displays:

7. Click Assign users and groups and configure which users and groups to be provided with access to the FortiEDR
application.
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8. Click Set up single sign on. The following displays:

9. Click SAML. The following displays:

10. Click Edit in the Basic SAML Configuration box.
11. Click Upload metadata file and browse in order to select the FortiEDR SPmetadata file

(fortiEDR.sp.metedata.id.1.xml) that was downloaded from FortiEDR SAML configuration page (as described on
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page 197). Alternatively, you can manually copy entityID and the Reply URL values from FortiEDRmetadata file
and paste it to the relevant input text boxes.

12. Click Save. The required SAML Configuration fields displays populated with details, as shown below:

13. Click Edit in the User Attributes & Claims box.
14. In the User Attributes & Claims window, click Add a group claim. The following window displays:

15. Select the groups to be added to the claim sent to the FortiEDR application. These specific groups should be
specified in the Role/Group mapping on the SAML configuration page of the FortiEDR console in order to determine
the permissions of the signed in user.

16. Check the Customize the name of the group claim checkbox, and in the Name field, enter the Attribute Name
that was specified on the SAML configuration page of the FortiEDR console. In our example, it is fortiEdrGroups,
as shown below:
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17. Click Save. The newly defined attribute should now be included in the assertion, such as in the following example:

18. Before configuring SAML SSO on the FortiEDR console, download the Federation Metadata XML file from the
SAML Signing Certificate section on Azure, as shown below:

19. Select and upload the file into the FortiEDR Central Manager, as follows:

20. Alternatively, you can use the App Federation Metadata URL from Azure, select the URL radio button in the IDP
Metadata configuration on the FortiEDR console and paste it to the same location:
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Azure can now be used as an IdP that awards authorization and authentication to users trying to access the FortiEDR
Central Manager console. When logging into the FortiEDR console via an SSO URL that is specified under the SAML
settings page, an Azure user is awarded access rights to the FortiEDR Central Manager according to the User Groups to
which that user was added in Azure.

SAML IdP Configuration with Okta

To configure general SAML IdP portal settings:

1. Before starting to configure SAML on Okta, you must download and save SP data from the FortiEDR SAML
configuration page (fortiEDR.sp.metedata.id.1.xml), as described in SAML Authentication on page 267

2. Sign in to the Okta Admin Dashboard. The following displays:

3. In your Okta org, click Applications and then Add Applications.
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4. Click Create New App . The following displays:

5. In the Platform field, selectWeb.
6. In the Sign on method field, select SAML 2.0.
7. Click Create.
8. In theGeneral Settings page, select a name for the application. For example, FortiEDRConsole. Optionally, you

can also add the FortiEDR logo here.
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9. Click Next. The Configure SAML page displays:

10. Copy the following values that are taken from the FortiEDR SPmetadata file (fortiEDR.sp.metedata.id.1.xml) that
was downloaded from FortiEDR SAML configuration page, as described in SAML Authentication on page 267.
l Single sign on URL: Under the ‘md:AssertionConsumerService’ tag, in the Location attribute (For example,
https://myexample.fortiedr.com/saml/SSO/alias/1).

l Audience URI (SP entity ID): Under the ‘md:EntityDescriptor’ tag, in the ‘entityID’ attribute (For example,
https://myexample.fortiedr.com/saml/metadata/alias/1).

11. In Advanced Settings, in the Assertion Encryption field, select Encrypted.
12. Use Notepad or another text editor to copy the entire attribute <ds:X509Certificate>XXX </ds:X509Certificate> from

the FortiEDR SPmetadata file (fortiEDR.sp.metedata.id.1.xml) that was downloaded from FortiEDR SAML
configuration page. Then, save this attribute as a .crt file to be used as a certificate.
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13. Upload this .crt file to the Encryption Certificate box on Okta, as shown below:
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14. Leave the default values in the rest of the settings. For example, as shown below:

15. Groups will be used in the assertion so that FortiEDR roles will be assigned according to the current groups in the
Okta directory. For example, to assign theOkta Engineering group to have Admin roles on FortiEDR, add it to Okta
as follows:
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The mapping of this group to the FortiEDR Admin role is then performed in the SAML settings page of the FortiEDR
Central Manager console as follows:
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16. Previewing the assertion should appear similar to the following example:

17. Click Next and then click Finish.
18. When you configure SAML SSO on the FortiEDR console, use the URL for Identity Provide Metadata from the

application Sign On settings in Okta, as shown below:

19. Paste it into the FortiEDR Central Manager as follows:

Okta can now be used as an IdP that awards authorization and authentication to users trying to access the FortiEDR
Central Manager console. When logging into FortiEDR console via the SSO URL that is specified under the SAML
settings page, an Okta user is awarded access rights to the FortiEDR Central Manager according to the User Groups to
which that user was added in Okta.
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SAML IdP Configuration with FortiAuthenticator

FortiAuthenticator configuration is comprised of the following steps:

1. Setting up FortiAuthenticator as an IdP.
2. Setting up user group management (if not configured already).
3. Setting up service provider settings for FortiEDR.

FortiAuthenticator IdP Configuration

To configure general SAML IdP portal settings:

1. Go to Authentication > SAML IdP > General and select Enable SAML Identity Provider portal.
2. 2 Configure the following settings:

Setting Definition

Device FQDN To configure this setting, you must enter a Device FQDN in the System
Information widget in the Dashboard.

Server address Enter the IP address or FQDN of the FortiAuthenticator device.

Username input format Select one of the provided options. In our example, we used username@realm

Realms Select Add a realm to add the default local realm to which the users will be
associated.

Login session timeout Set the user’s login session timeout limit to between 5 – 1440 minutes (one
day). In our example, we used 500 minutes.

Default IdP certificate Select a default certificate the IdP uses to sign SAML assertions from the
dropdown menu.

3. ClickOK to apply these changes.

User Groups Management Settings on FortiAuthenticator

To configure on FortiAuthenticator the assertion attribute that will be used to map users’ permissions to
access FortiEDR:

1. Go to Authentication > User Management > User Groups.
2. Select Create New.
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3. Specify a name for the group to be used for setting User access permissions for FortiEDR. In our example, we used
groupuser.

4. In the Users section, select all the FortiAuthenticator users to be assigned with User permission to the FortiEDR
Central Manager Console in order to add them to this User Group.

5. ClickOK to save the configuration.
6. Repeat steps 1 – 5 above in order to also create Local Admin, Admin and API groups and in order to select the

users to be assigned with these access permissions to the FortiEDR Central Manager Console.

In our example, we created a group named groupadmin and assigned this user the same Admin permissions to the
FortiEDR Central Manager Console, as shown below:

Note – New or existing FortiAuthenticator users can also be configured into groups on the Local Users create and edit
page.
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Service Provider Settings for FortiEDR on FortiAuthenticator

To configure FortiEDR as a SAML service provider on FortiAuthenticator:

1. Go to Authentication > SAML IdP > Service Providers.
2. Select Create New.

3. Fill in the following fields:
l SP name: Enter a name for the FortiEDR SP.
l IDP prefix: SelectGenerate prefix in order to generate a random 16-digit alphanumeric string or alternatively
enter a prefix for the IDP that is appended to the end of the IDP URLs.

4. Click Download IDP metadata to save the FortiAuthenticator IDP data file to be used for uploading into FortiEDR.
You may refer to step 3 in SAML Authentication on page 267 for more information.

5. Click Import SP metadata and select the SP data file that was downloaded from FortiEDR. You may refer to step 2
in SAML Authentication on page 267 for more information.
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6. All other service provider configuration fields are auto-filled after the SP data file import:

7. ClickOK to apply the changes.
8. Go to Authentication > SAML IdP > Service Providers and double-click to open the Service Provider that you

created in the previous step.
9. 9 In the SAML Attribute section, click Create New.
10. In the popup window, enter the attribute name that was configured in the FortiEDR SAML Authentication settings

and select FortiAuthenticator Group as the User Attribute.
In our example, we use fortiedr_role as an attribute name, as shown below:

FortiEDR 5.1.0 Administration Guide 285
Fortinet Inc.



Administration

And therefore the configuration on FortiAuthenticator appears as follows:

11. ClickOK to save the changes.

FortiAuthenticator can now be used as the IdP, which provides authorization and authentication for users trying to
access the FortiEDR Central Manager Console. When logging into the FortiEDR Console via the SSO url that is
specified in the SAML settings page, a FortiAuthenticator user is awarded access permissions to the FortiEDR Central
Manager according to the User Groups into which he/she was added.

Distribution Lists

The DISTRIBUTION LISTS option enables you to specify recipients who will receive an email each time a security event
is triggered by FortiEDR.

Note – You must configure SMTP before using the Distribution List option. For more details, see SMTP on page 288.

Note – Emails are only sent for security events that occur on devices that are part of Collector Groups that are assigned
to a Playbook policy in which the Send Email Notification option is checked.

Each email contains all the raw data items collected by FortiEDR about that security event. The system is provided with a
Distribution List called All Recipients that contains all FortiEDR Central Manager users. All other recipients that are
added to the system are also automatically added to the All Recipients list.
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This window displays a row for each Distribution List. Click the button in a row to view the recipients assigned to that
list.

Use the button to create a new Distribution List.

Use the button to add a recipient/user to a Distribution List.

Select a distribution list row and then use the Enabled/Disabled option in the NOTIFICATIONS pane on the right to
enable or disable the list per event type (system events or security events).

Export Settings

The EXPORT SETTINGS option provides access to the following options:

• SMTP on page 288

• Open Ticket on page 288

• Syslog on page 289
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SMTP

The SMTP option enables you to configure the SMTP server to be used for sending emails. You can also check the
connectivity to the SMTP server.

Note – In a single-organization system, SMTP settings are only accessible in Hoster view (for administrators), or to the local administrator of that organization

To configure SMTP server settings:

l In the SMTP area, enter standard SMTP settings and then click Save.

To test SMTP server connectivity:

l In the SMTP area, click Test. An error message displays if there is no connectivity to the server.

Open Ticket

TheOpen Ticket option enables you to send events to an event-management tool such as Jira or ServiceNow. Open
Ticket automatically opens a ticket and attaches the relevant event to a ticket.

In order for the Open Ticket feature to work properly, you must set up an email feed in the event-management tool to be
used.
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Note – Most event-management tools are supported. FortiEDR has tested and verified that Open Ticket works with the
ServiceNow and Jira systems. For more details about setting up the email feed required for this feature, see Appendix A
– Setting up an Email Feed for Open Ticket on page 372.

Note – Security events are only sent to a ticketing system when they occur on devices that are part of Collector Groups
that are assigned to a Playbook policy in which theOpen Ticket option is checked.

To configure Open Ticket settings:

1. In the Open Ticket area, in the System name field, enter the system name for the tool to be used for event
management. This is a free-text field.

2. In the Email address field, enter the email address that is the destination to which all tickets are to be sent from
FortiEDR. All tickets from all organizations are sent to this email.

3. Click Save.

Syslog

The SYSLOG option enables you to configure FortiEDR to automatically send FortiEDR events to one or more standard
Security Information and Event Management (SIEM) solutions via Syslog.

The FortiEDR Central Manager server sends the raw data for security event aggregations. Each entry contains a raw
data ID and an event ID. Raw data items belonging to the same security event aggregation share the same event ID,
which enables the SIEM to combine them into one security event on the SIEM side, in order to remain aligned with the
FortiEDR system.

Use the button to define a new Syslog destination. The Syslog Name is a free-text field
that identifies this destination in the FortiEDR.

Note – Syslog messages are only sent for security events that occur on devices that are part of Collector Groups that are
assigned to a Playbook policy in which the Send Syslog Notification option is checked.
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All other fields are standard Syslog parameters that the FortiEDR Central Manager is able to send. Check the checkbox
of the fields that you want to be sent to your Syslog.

Select a syslog destination row and then use the sliders in the NOTIFICATIONS pane on the right to enable or disable
the destination per event type (system events, security events or audit trail).

Warning: If syslog is configured for both Hoster view and an organization, two syslog events
will be sent.

Syslog Notifications

Syslog includes the following types of notifications:

Notification Type Fields

Security Event l Event ID
l Device Name
l Process Path
l Certificate
l Last Seen
l Severity
l Count
l MAC Address
l Source IP
l Raw Data ID
l Process Name
l Process Type
l First Seen
l Destination
l Action
l Rules List
l Classification
l Organization
l Organization ID
l Operating System
l Script
l Script Path
l Country
l Users
l Device State
l Autonomous System
l Process Hash
l Threat Name
l Threat Family
l Threat Type

System Events on page 307 l Component Type
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Notification Type Fields

l Component Name
l Description
l Date

Audit Trail on page 292 l Date
l Module
l Username
l Action Description

Syslog Message

The order of the fields in the Syslog message is as follows:

1. Organization
2. Organization ID
3. Event ID
4. Raw Data ID
5. Device Name
6. Device State
7. Operating System
8. Process Name
9. Process Path
10. Process Type
11. Severity
12. Classification
13. Destination
14. First Seen
15. Last Seen
16. Action
17. Count
18. Certificate
19. Rules List
20. Users
21. MAC Address
22. Script
23. Script Path
24. Autonomous System
25. Country
26. Process Hash
27. Source IP
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Syslog Message Format

The Syslog message contains the following sections:

1. Facility Code: All messages have the value 16 (Custom App).
2. Severity: All messages have the value 5 (Notice).
3. MessageType: Enables you to differentiate between syslog message categories – Security Event, System Event or

Audit.
4. Message Text: Contains the name and value of all the selected fields.

For example, Device name: Laptop123. Each field is separated by a semi-colon (;).

Note – Regarding time values in system events :
l Syslog events time is expressed in UTC format.
l For system and audit events, the timestamp is the Central Manager’s time when the event
occurred.

l For security events, the timestamp is the Collector device’s time when the event occurred.

Tools

The TOOLS option provides access to the following options:

Option Reference

Audit Trail Audit Trail on page 292

Component Authentication Component Authentication on page 295

Automatic Updates Automatic Collector Updates on page 295

File Scan File Scan on page 296

End-user Notifications End-user Notifications on page 297

IoT Device Discovery IoT Device Discovery on page 300

Personal Data Handling Personal Data Handling on page 301

Windows Security Center Windows Security Center on page 306

Audit Trail

FortiEDR’s audit mechanism records every user action in the FortiEDR system. System actions are not recorded. You
can download the audit trail to a *.csv file for further analysis.

Each time a new audit trail is created, it can be sent through the Syslog.
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To generate the audit trail:

1. Click the TOOLS link in the left pane.
2. In the AUDIT TRAIL area, specify the From and To dates in the respective fields.
3. Click theGenerate Audit button. A progress window displays:

4. Click the Download link to download the audit trail to a *.csv file. An Excel file, such as the example shown below,
displays:
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Each row in the audit trail file contains the following columns of information:

Field Definition

Date and Time Displays the date and time in the format yyyy-mm-dd hh:mm:ss.

Sub system Displays the change type, such as System, Configuration, Administration,
Forensics, Events, Inventory, Communication Control or Health.

User Name Displays the name of the user.

Description Displays the action and/or a description.

The following actions can be audited:

l System actions
l Policy actions
l Forensic actions
l Administrative actions
l Events
l Inventory actions
l System health changes

Note – If an employee’s/user’s data was removed from FortiEDR for GDPR compliance, then the affected record for that
person still displays in the audit trail but shows GDPR_ANONYMIZE instead of actual user data. For example, as shown
below:
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Component Authentication

In order to install, upgrade or uninstall a Collector, you must supply the Aggregator password. The Aggregator password
is the same for all Collectors in the FortiEDR system. This password is defined during initial system installation. For more
details, see Installing the FortiEDR Central Manager and FortiEDR Aggregator on the Same Machine on page 383.

If you forget the Aggregator password, you can use the COMPONENT AUTHENTICATION option to retrieve it.

To retrieve the Aggregator password:

1. Click the TOOLS link in the left pane.
2. In the COMPONENT AUTHENTICATION area, click the Display button. The following window displays, showing

the retrieved password.

Automatic Collector Updates

The Automatic Collector Updates feature updates the revision for a given FortiEDR version. The revision number is the
fourth digit of the FortiEDR version number. For example, for FortiEDR version 3.1.0.x, x indicates the revision number.

When the Automatically update Collectors to the latest revision checkbox is checked, whenever the content
contains a new build only (for example, 2.7.0.15 is a new build of 2.7.0.5), all Collectors are uploaded to that build. This
means that all Collectors in all Collector Groups in all environments and operating systems are updated to the latest
FortiEDR revision available (as provided by Fortinet using the Load Content feature). For more details about the Load
Content feature, see Content Updates on page 24.

To update a FortiEDR version, use the Update Collector Version feature described in Updating the Collector Version on
page 253.
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File Scan

FortiEDR can perform periodic scans of the files in the system on a scheduled or on-demand basis, based on its
execution prevention policy. During a periodic scan, only the files on the hard drive are scanned and no memory scan is
performed. For a periodic scan, each file on the hard drive is scanned. If a malicious file is identified during a scan, a
security event is triggered.

To schedule a periodic scan:

1. Click the TOOLS link in the left pane.
2. In the FILE SCAN area, check the Perform Scheduled Scan checkbox. This checkbox must be checked to

perform the scan according to the designated schedule.

3. In the Frequency dropdown list, select how frequently to execute the scan. Options areWeekly, Bi-Weekly (every
two weeks) orMonthly.

4. In the Day dropdown list, select the day of the week to execute the scan.
5. In the Hours dropdown list, select the hour of the day to execute the scan.
6. Use the radio button to select on which devices the scheduled scan should be performed. When selecting Collector

Groups or Collectors, you should specify which Groups or Collectors should be included in the scan. Devices that
are not listed here are not scanned.

7. Click the Save button. The scan is performed as scheduled.

To perform an on-demand file scan:

1. Click the TOOLS link in the left pane.
2. In the Ad hoc scan area, select which devices to scan by specifying one or more Collectors or Collector Groups, or

selecting the All Collectors option to scan all devices with installed Collectors.

3. Check the Scan executable files only checkbox to only scan executable files. This option enables a quicker scan,
but neglects documents, scripts and other potentially malicious files.

4. Click Scan now. The scan is performed immediately.
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End-user Notifications

Each device protected by FortiEDR can display an icon in the system tray to indicate its state.

The FortiEDR icon indicates the current state of the device, as follows:

l

Protection On

l

Protection Off/Disabled

l

Degraded

l

Isolated

Note – Terminating a FortiEDR process ends this process and stops the display of the FortiEDR icon in the system tray,
but does not stop FortiEDR protection.

When the FortiEDR icon is configured to display on FortiEDR-protected devices, a popup message displays whenever
something is blocked on a protected device (based on the blocking policy set for that device). File modifications (due to
suspected ransomware), the exfiltration of external connections and execution prevention actions can be blocked. For
example, the following shows that a TCP port listening action was blocked for the DynamicCodeListenTests.exe
process.

Note- This notification is displayed only once for the same process. If the same process is blocked multiple times, only a
single FortiEDR pop up is displayed.

You can choose to show or hide end-user notifications (pop-ups) for the next 24 hours. To do so, right-click the FortiEDR
icon in the system tray and then check the checkbox to hide notifications or leave the checkbox unchecked to display
notifications.
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You can double click the FortiEDR icon in the system tray to review recent blocking activity on the device as shown
below. Each row includes a single event (that can be composed of multiple occurrences) and displays the process name,
the first and last occurrences times, the process ID and the type of blocking: either security or communication control.

Expanding the arrow on the right of each event reveals more details per event including the process path and the
number of occurrences of the same blocking event:
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FortiEDR Icon Configuration

The behavior of the FortiEDR icon in the system tray must be configured in the Administration tab.

To configure FortiEDR icon behavior:

1. 1 Click the TOOLS link in the left pane.
2. In the END USERS NOTIFICATION area, configure the following settings:

Setting Definition

Show System Tray Icon with
Collector Status

Check this checkbox to display the FortiEDR icon on each FortiEDR-protected
device or leave the checkbox unchecked to hide the icon on each protected
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Setting Definition

device. Your selection here is applied on all protected devices. The default is
checked.

Show a Pop-up Message for
Any Prevention Activity

Check this checkbox to enable the display of pop-up messages (end-user
notifications) on FortiEDR-protected devices. Pop-up messages display
whenever a process was prevented. By default, the name of the activity of the
blocked process is displayed in the pop-up message. The default is checked.

In the text box below these two checkboxes, you can customize the text that is displayed in the pop-up message.
Enter the text you want to display in the text box.

3. Click the Save button.

IoT Device Discovery

IoT device discovery enables you to continuously perform discovery to identify newly connected non-workstation
devices in the system, such as printers, cameras, media devices and so on. During the discovery process, each relevant
Collector in the system periodically probes all its nearby neighboring devices. Most nearby devices will respond to these
requests by pinging the originating Collector device and providing information about itself, such as its device/host name
(for example, ABC PC, Camera123), IP address and so on.

Such discovered devices can be seen in the IOT DEVICES page, as described in IoT Devices on page 110.

Note – The following default configuration applies to IoT scans by the FortiEDR Collectors:

l For operational reasons, Collectors that are running on servers or Collectors that are reported to be in one of the following states: degraded, disabled or
isolated Collectors do not take part in the IoT probing process.

l In order to refrain from scans on home or other non-enterprise networks, only subnets in which there is a minimal number of Windows Collectors are
scanned in order to find Connected IoT devices.

l Extremely large subnets are excluded from scans.

If needed, in order to tune the scans to be more comprehensive and more granular, contact Fortinet Support who will change the default configuration.

To enable IoT device discovery, check the Perform ongoing device discovery checkbox. Note that when doing so, all
relevant Collectors in the system perform sniffing in order to identify new connected devices in the system. When
performing this discovery process, FortiEDR uses only the most powerful Collectors in each sub-network to perform
sniffing, and excludes weaker Collectors for this process (disabled and degraded Collectors). This means that FortiEDR
collects all the required information in the most efficient manner possible.

You can exclude specific Collector Groups from this discovery process. To do so, select the relevant Collector Group(s)
in the Exclude Collector Groups dropdown list.

By default and when your organization has more than a single external IP address, FortiEDR ignores the external IP
address of the IoT device while identifying and matching them. You can choose to list devices that use different external
IP addresses separately by unchecking the checkbox next to the Consider devices with different external IP(s) as
separated ones option. However, in this case the same device might be listed more than once in the IoT inventory page.
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The Inventory Auto Grouping option enables you to group discovered devices by device type. For example, cameras,
network devices, media devices, printers and so on. Select the Category option in the dropdown list to group discovered
devices by device type or None. When you select Category, devices are auto-grouped in the IOT DEVICES page, as
shown onIoT Devices on page 110

Click the Save button to save the configuration.

We recommend testing IoT the device discovery process to ensure that it works as expected across all your
organizations before enabling the on-going periodic network scan. Testing can only be performed when IoT device
discovery is not enabled, meaning the Perform ongoing device discovery checkbox is not checked. Select the
Collector to use to test the IoT device discovery process in the Ad Hoc Network Discovery dropdown list and then click
the Test button, as shown below.

The selected Collector sniffs the network once to identify new connected devices. After the test discovery process
begins, you can stop it at any time by clicking the Stop button. In all cases, the scan will be stopped within a predefined
time period (usually 30 minutes).

Personal Data Handling

The FortiEDR system fully complies with the General Data Protection Regulation (GDPR) standard. The GDPR is a
regulation in European Union (EU) law regarding data protection and privacy for all individuals within the EU and the
European Economic Area (EEA). It also addresses the export of personal data outside the EU and EEA areas. The goal
of the GDPR is primarily to give control to citizens and residents over their personal data and to simplify the regulatory
environment for international business by unifying the regulation within the EU.

The GDPR standard requires that all relevant data for an employee of a company that is using the FortiEDR system or a
FortiEDR user be removed from the FortiEDR system, once he/she no longer has access to or uses the FortiEDR
system.

In FortiEDR, the GDPR feature is implemented in the Personal Data Handling area of the Tools window.
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To fully comply with the GDPR standard, the employee’s/user’s device name, IP address, MAC address and user name
must all be totally removed from the FortiEDR system. This data is deleted from FortiEDR in real time, from everywhere
that it appears in the FortiEDR system (for example, from the Inventory, Event Viewer, Audit Trail and so on).

The GDPR regulation obligates you to notify your users, should the FortiEDR system be hacked. You can use the Export
report of monitored users button to export the list of monitored users in the FortiEDR system. This action exports a report
such as the one shown below:

To remove employee/user data from the FortiEDR system for GDPR compliance:

1. Uninstall the Collector from the employee’s/user’s computer. This step is important, so that no further data is
collected from that Collector. For more details about uninstalling, see page 55.
Note – Be sure to do this for all the employee’s/user’s computers on which Collectors are installed.

2. Click the TOOLS link in the left pane.
3. In the Personal Data Handling area you must specify the device name, IP address, MAC address and user name of

the employee/user to be removed from FortiEDR.
Note – If the employee/user has multiple computers on which Collectors are installed, you must repeat the steps
below for each of his/her computers.
Removing an employee/user for GDPR compliance requires an iterative process in FortiEDR that must be
performed four times, in order to remove the device name, IP address, MAC address and user name of the
employee/user successively, one after another. You can remove this data in any order that you prefer. For the
purpose of example, we will start by removing all Device name data for the employee/user.
IMPORTANT – You can remove the device name, IP address, MAC address and user name of the employee/user
from FortiEDR in any order that you prefer. However, you must remove all device name, IP address, MAC address
and user name data from FortiEDR in order to fully comply with the GDPR standard.

4. In the Search by dropdown list, select Device name. This field determines which criterion to search for in the
FortiEDR system (device name, IP address, MAC address or user name).

5. In the adjacent field, enter the device name for the employee/user whose data you want to remove.
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You can copy/paste this information into the adjacent field after locating it elsewhere in the FortiEDR user interface.
For example, you can locate the relevant device name in the Last Logged column in the Collectors list in the
Inventory window, such as shown below, and then copy that value into the relevant field in the Personal Data
Handling area. Similarly, you can also readily locate the MAC address and IP address using the Collectors list in the
Inventory window.

In a similar manner, you can locate the user name in the Event Viewer, and then copy/paste that information into the
adjacent field in the Personal Data Handling area, as shown below:

If you prefer, you can use another method of your choice to identify the device name.
6. After entering the details for the device name, as shown below, click Search to search for all occurrences of the

device name in the FortiEDR system.

The following displays, listing all matching results:
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7. Do one of the following:
a. Click the Export Report button to export a report of the data to be removed for the employee/user. This option

enables you to keep a record of what will be deleted. However, use of this option is not recommended, as all
traces of the employee’s/user’s data are to be permanently removed, including this report.
The following displays after the report has been exported:

Click the Download link to download the Excel report. An example of the downloaded report is shown below:
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b. Click the Delete All Records button to remove all device name data for the employee/user. The following
displays:

Click Delete to remove all device name data for the employee/user from FortiEDR. After several moments, the
following displays, indicating that the data has been removed:

You can check the Export report to Excel before deleting data checkbox if you want to export the data
before it is removed from FortiEDR.

8. Click Continue to proceed with removing the other required data for the employee/user (IP address, MAC address
and user name).

9. Repeat steps 4–8 to remove the relevant IP address from FortiEDR. Be sure to select IP Address in step 4.
10. Repeat steps 4–8 to remove the relevant MAC address from FortiEDR. Be sure to selectMAC Address in step 4.
11. Repeat steps 4–8 to remove the relevant user name data from FortiEDR. Be sure to select User Name in step 4.
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Personal Data Handling of Threat Hunting Data

The search performed by Personal Data Handling (described above) does not show activity event data. This data will be
deleted in case you use the delete option (described above), even though it is not displayed in the search results. If
you’re interested in seeing the activity data that will be deleted, you can view it by using the Search option of the Threat
Hunting feature, as described in Threat Hunting on page 222.

Windows Security Center

FortiEDR is fully integrated with Windows Security Center and has been certified by Microsoft as an anti-virus and threat
protection application. You can choose whether to register FortiEDR Collectors as anti-virus and threat protection agents
in Windows Security Center. When registering FortiEDR Collectors, Windows Security Center indicates that your system
has anti-virus and threat protection provided by FortiEDR.

Note that in some cases, registering FortiEDR in Windows Security Center may prevent other vendors’ products from
installing or functioning properly. Therefore, you can choose whether or not to register FortiEDR Collectors. Your system
is still fully protected, even if you do not choose to register FortiEDR Collectors with Windows Security Center.

To register FortiEDR Collectors with Windows Security Center:

l In the ADMINISTRATION tab, navigate to the Tools > Windows Security Center area, and then check the
Register Collectors to Windows Security Center checkbox.
When registered, FortiEDR is listed under Windows Security, as follows:

FortiEDR 5.1.0 Administration Guide 306
Fortinet Inc.



Administration

System Events

Selecting SYSTEM EVENTS in the ADMINISTRATION tab displays all the system events relevant to the FortiEDR
system.

When a system event is triggered, it is sent via email to the defined distribution list. For more details, you may refer to
Distribution Lists on page 286

Note – System events can also be retrieved using an API command. For more details, refer to the FortiEDR RESTful API
Guide.

Each time a new system event is created, it can be sent through the Syslog.
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The following events are defined as system events in the system. The user receives a notification for each of them if that
system event is enabled for the user’s distribution list. Syslog can also be configured to send system events messages,
as described in Syslog on page 289.

l Core state was changed to Disconnected (and another event when the Core state was returned to the Connected
state immediately afterward)

l Core state was changed to Degraded (and another event when the Core state was returned to THE Connected
state immediately afterward)

l Aggregator state was changed to Disconnected (and another event when the Aggregator state was returned to the
Connected state immediately afterward)

l Aggregator state was changed to Degraded (and another event when the Aggregator state was returned to the
Connected state immediately afterward)

l Threat Hunting Repository state was changed to Disconnected (and another event when the Repository state was
returned to the Connected state immediately afterward).

l Threat Hunting Repository state was changed to Degraded (and another event when the Repository state was
returned to the Connected state immediately afterward).

l Collector registered for the first time (only UI/API; is not sent by email/Syslog)
l Collector was uninstalled via the Central Manager console.
l Collector state was changed to Disconnected Expired.
l License will expire in 21/7 days/1 day
l License expired
l License capacity of workstations has reached 90/95/100%
l License capacity of servers has reached 90/95/100%
l Systemmode was changed from Prevention to Simulation or vice versa
l FortiEDR Cloud Service (FCS) connectivity is down

IP Sets

IP Sets enable you to define a set(s) of IPs to include or exclude for some security events. This feature is used when
defining exceptions.

Note – IP Sets can only be defined if all Collectors are V3.0.0.0 and up. If you attempt to define an exception and all Collectors are not V3.0.0.0 or above, the

following error message displays:
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Each row in the IP Sets window represents an IP inclusion/exclusion definition. The Internal Destinations row is provided
by default (as indicated by the adjacent FortiEDR logo), which defines the default IPs that are included in and excluded
from the FortiEDR system. All organizations in a multi-organization system are provided with this default IP set. In a
single-organization system, the main organization is provided with it. The Internal Destinations IP set cannot be deleted.
However, an Administrator can add Included IPs or Excluded IPs to it.

The IP Sets window lists all the IP sets created by the Administrator. A Local Administrator can edit an IP set that was
specifically created for his/her organization. A Local Administrator cannot edit an IP set that applies to all organizations.

Click the logo in the Internal Destinations row to view its definition, as shown below:
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To define an IP set:

1. Click the button. The following window displays:

2. In the Set Name field, enter a name for the IP set.
3. In theOrganization dropdown list, select the organization to which the IP set applies or select All organizations for

the IP set to apply to all organizations in the FortiEDR system.
4. In the Description field, enter a description for the IP set.
5. In the Included IPs area, click the button to add an IP, IP range or IP mask to be included in the IP set’s

definition. Each click of the button adds a new line to the list. Each entry appears in its own line. For example, you
could add 192.168.23.2, 192.168.23.1-192.168.232 or 192.168.0.0/16.
Similarly, in the Excluded IPs area, click the button to add an IP, IP range or IP mask that is to be excluded.

6. Click the Save button.

The Search IP field at the top-right of the page enables you to search for a specific IP in all of the IP sets defined. The
search option identifies matching IPs, even if they are part of a range in an IP set’s definition.

To use an IP set:

Select an IP set in the Destinations area when defining an exception, as described in Defining a Security Event as an
Exception on page 150.

Integrations

Integrations enable you to configure connectors to external systems, which enables you to trigger predefined types of
actions. FortiEDR provides various connectors out-of-the-box, such as Firewalls and NAC systems. In addition, you
have the option to define customized connectors to any third-party system in order to trigger any action on that system
using an API. The out-of-the-box FortiEDR connectors utilize Fortinet products’ APIs to automatically perform the
required actions in order to extend its automatic Playbook actions.

You can set up an unlimited number of connectors for each type and use them by associating Playbook policies or
Security policies to the actions defined for these integration connectors, as described below.

Note – The Integration menu is only available when the environment is connected to Fortinet Cloud Services (FCS).

To display the INTEGRATIONS page:
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1. Select ADMINISTRATION > INTEGRATIONS.

The top left of this page provides two buttons, as shown below:

l Adding Connectors on page 311 enables you to add and configure connectors for integration with FortiEDR.
l Action Manager on page 332 enables you to upload and manage (add, modify and delete) actions (Python
scripts that call third-party system APIs) to be automatically triggered by FortiEDR as incident responses.

Adding Connectors

The following types of integration connectors are provided to be configured:

l Firewall Integration on page 311
l Network Access Control (NAC) Integration on page 318
l Sandbox Integration on page 324
l eXtended Detection Source Integration on page 326
l Custom Integration on page 328

You can enable or disable a connector by clicking the Enabled/Disabled button next to the connector name. This button
toggles between Enabled/Disabled.

Firewall Integration

When a firewall connector is set and Playbook policies are configured, automatic incident response actions can include
blocking of malicious IP addresses by a firewall upon security event triggering.

Before you start firewall configuration, make sure that:
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l Your FortiEDR deployment includes a JumpBox that has connectivity to the firewall. Details about how to install a
FortiEDR Core and configure it as a JumpBox are described in Installing the FortiEDR Core. You may refer to Cores
on page 115 for more information about configuring a JumpBox.

l The FortiEDR Central Manager has connectivity to the Fortinet Cloud Services (FCS).
l You have a valid API user with access to the external firewall.

Follow the steps below to automatically deny access on the firewall to malicious destination addresses detected by
FortiEDR.

The example below describes how to define an address group on FortiGate and associate it with a FortiGate policy rule,
such that it blocks connections to the addresses in the group. The address group is then used when configuring the
FortiEDR connector so that it is automatically populated with malicious destinations upon detection by FortiEDR.

The same address group can obviously be used for multiple firewall policies in order to cover any VLAN-to-WAN
interface in the network.

FortiGate Configuration

To set up an address group and policy on FortiGate:

1. Go to Policy & Objects > Addresses.
2. Create a new address group to be populated by FortiEDR. The new address group now appears in the FortiGate

Addresses table.

3. Go to Policy & Objects > IPv4 Policy.
4. Create a new policy to deny traffic to any address in the address group that was created as part of step 2. The new
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policy now appears in the FortiGate Policies table.

FortiEDR Firewall Connector Configuration

To set up a Firewall connector with FortiEDR:

1. Click the button and select Firewall in the Connectors dropdown list. The following displays:
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2. Fill in the following fields:

Field Definition

JumpBox Select the FortiEDR JumpBox to communicate with the firewall.

Name Specify a name of your choice to be used to identify this firewall.

Type Select the type of firewall to be used in the dropdown list.

Host Specify the IP or DNS address of your firewall.

Port Specify the port that is used for API communication with your firewall.

API Key / Credentials Specify authentication details of your firewall. To use an API token, click the
API Key radio button and copy the token value into the text box. To use API
credentials, click the Credentials radio button and enter the Firewall API
username and password.

3. In the Actions area on the right, define an action to be taken by this connector.
You have the option to either use an action provided out-of-the-box with FortiEDR (for example, Block address on
Firewall) or to create and use your own custom actions.
a. To block an address on the Firewall, next to the Block address on Firewall field, in the Address Group field,

specify the name of a previously defined address group on the firewall.
- OR -

b. To trigger a custom action on the Firewall, click the + Add Action button to display the following popup window:

l In the Action dropdown menu, select one of the previously defined custom integration actions.
– OR –

l Click the Create New Action button in this popup window to define a new action on the Firewall to be
triggered according to the definitions in the Playbook, as described below. The following displays:
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Fill out the fields of this window as follows in order to define a new action to be triggered in response to an
incident.
Note – In order to trigger this action, a Playbook policy must be defined that triggers this action to execute the script when a security event is

triggered. The definition of this new action here automatically adds this action as an option in a Playbook policy. This action however, is not

selected by default in the Playbook policy. Therefore, you must go to the Playbook policy and select it in order for it to be triggered when a

security event is triggered.

Field Definition

Name Enter any name for this action

Description Enter a description of this action

Upload Upload a Python script that calls an API in the third-party system in
order to perform the relevant action. This Python script must be created
according to the coding conventions that can be displayed by clicking

the icon next to the Action Scripts field. The following displays
providing an explanation of these coding conventions and provides
various links that you can click to see more detail and or/to download
sample files.
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Field Definition

4. Click Save. The new action is then listed in the Actions area.
5. You can click the Test button next to an action to execute that action.

Note – If you are working with a FortiManager in order to manage firewalls, use the same instructions to integrate with the firewall, but select FortiManager as the

integrated device Type when configuring the FortiEDR Connector in the AdministrationèIntegration page, as follows:

Playbooks Configuration

To configure an automated incident response that uses a firewall connector to block malicious
destinations upon security event triggering:

1. Navigate to the SECURITY SETTINGS > Playbooks page.
2. Open the Playbook policy that is applied on devices for which you want the block IP incident response to apply and

place a checkmark in the relevant Classification column next to the Block address on Firewall row that is
under the REMEDIATION section. In the dropdown menu next to the action, you can specify which firewalls to use
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to perform the block or select all of them, as shown below:

FortiEDR is now configured to add malicious IP addresses to the blocking policy on the firewall upon triggering of a
security event. You can check that malicious IP addresses are added to the address group that was configured on
the firewall following FortiEDR security events. In addition, automatic incident response actions are listed in the
CLASSIFICATION DETAILS area of the Events page of the FortiEDR Console, as shown below:

To configure an automated incident response that uses a firewall connector to perform a custom action
upon the triggering of a security event:

1. Navigate to the SECURITY SETTINGS > Playbooks page.
2. Open the Playbook policy that is applied on devices for which you want the custom action (defined above) to apply.
3. In the CUSTOM section, place a checkmark in the relevant Classification columns next to the row of the relevant

custom action.
4. In the dropdown menu next to the relevant custom action, select the relevant firewall connector with which to

perform the action, as shown below:

FortiEDR is now configured to trigger this action in the third-party system upon the triggering of a security event.
This automatic incident response action appears in the CLASSIFICATION DETAILS area of the Events page of the
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FortiEDR Console.

Network Access Control (NAC) Integration

When a Network Access Control connector such as FortiNAC is set and Playbook policies are configured, automatic
incident response actions can include isolating a device by a NAC system upon security event triggering.

Before you start NAC configuration, make sure that:

l Your FortiEDR deployment includes a JumpBox that has connectivity to the NAC server.
Details about how to install a FortiEDR Core and configure it as a JumpBox are described in Installing the FortiEDR
Core. You may refer to Cores on page 115for more information about configuring a JumpBox.

l The FortiEDR Central Manager has connectivity to the Fortinet Cloud Services (FCS).
l You have a valid API user with access to FortiNAC or equivalent network access control system.

Follow the steps below in order to automatically isolate a device by NAC upon the detection of a FortiEDR security event.
The example below describes how to define an API user on FortiNAC in order to enable FortiEDR to perform automatic
device isolation after a FortiEDR security event.

Note: Make sure to add FortiEDR domains and/or IP addresses to the exclusion list on the VLAN that is being used for isolation on the FortiNAC system such

that the FortiEDR Collector would still be able to communicate with its servers when the device is being isolated.
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FortiEDR Connector Configuration

To configure NAC integration:

1. Clickthe button and select NAC in the Connectors dropdown list. The following displays:

2. Fill in the following fields:

Field Definition

JumpBox Select the FortiEDR JumpBox that will communicate with this NAC system.

Name Specify a name of your choice which will be used to identify this NAC system.

Type Select the type of NAC to be used in the dropdown list, for example: FortiNAC.

Host Specify the IP or DNS address of the external NAC system.

Port Specify the port that is used for communication with the external NAC system.

API Key Specify authentication details of the external NAC system. To use an API
token, click the API Key radio button and copy the token value into the text
box. To use API credentials, click the Credentials radio button and fill in the
external NAC system API username and password.

3. 3 In the Actions area on the right, define the action to be taken by this connector.
You have the option to either use an action provided out-of-the-box with FortiEDR (for example, Isolate Device on
NAC)
– OR –
To create or select one of the Custom Integration actions (if one or more have already been defined in FortiEDR, as
described in Custom Integration on page 328.
l To trigger an action on a custom connected third-party system, click the + Add Action button to display the
following popup window:
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a. In the Action dropdown menu, select one of the previously defined actions (which were defined in FortiEDR as
described in Custom Integration on page 328).
- OR -

b. Click the Create New Action button in this popup window to define a new action that can be triggered
according to the definitions in the Playbook, as described below. The following displays:
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Fill out the fields of this window as follows in order to define a new action to be triggered in response to an
incident.
Note – In order to trigger this action, a Playbook policy must be defined that triggers this action to execute the script when a security event is

triggered. The definition of this new action here automatically adds this action as an option in a Playbook policy. This action however, is not selected

by default in the Playbook policy. Therefore, you must go to the Playbook policy and select it in order for it to be triggered when a security event is

triggered.

Field Definition

Name Enter any name for this action

Description Enter a description of this action

Upload Upload a Python script that calls an API from the third-party system in order
to perform the relevant action. This Python script must be created
according to the coding conventions that can be displayed by clicking the
icon next to the Action Scripts field. The following displays providing an

explanation of these coding conventions and provides various links that
you can click to see more detail and/or to download sample files.
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4. Click Save. The new action is then listed in the Actions area.
5. You can click the Test button next to an action to execute that action.

Playbooks Configuration

To configure an automated incident response that uses a NAC connector to isolate a device upon
security event triggering:

1. Navigate to the SECURITY SETTINGS > Playbooks page.
2. Open the Playbook policy that is applied on devices for which you want the isolation response to apply and place a

checkmark in the relevant Classification column next to the Isolate device with NAC row that is under the
INVESTIGATION section.

FortiEDR is now configured to automatically isolate the device upon triggering of a security event. Automatic incident
response actions are listed in the CLASSIFICATION DETAILS area of the Events page of the FortiEDR Console as
shown below:
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Note that isolation by NAC will only be done for devices that are managed on the specified NAC.

To configure an automated incident response that uses a NAC connector to perform a custom action
upon the triggering of a security event:

1. Navigate to the SECURITY SETTINGS > Playbooks page.
2. Open the Playbook policy that is applied on devices for which you want the custom action (defined above) to apply.
3. In the CUSTOM section, place a checkmark in the relevant Classification columns next to the row of the relevant

custom action.
4. In the dropdown menu next to the relevant custom action, select the relevant NAC connector with which to perform

the action, as shown below:

FortiEDR is now configured to trigger this action in the third-party system upon the triggering of a security event.
This automatic incident response action appears in the CLASSIFICATION DETAILS area of the Events page of the
FortiEDR Console.
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Sandbox Integration

When a sandbox such as FortiSandbox is configured and the Sandbox Analysis Policy rule is enabled, files that meet
several conditions and that have not been previously analyzed trigger a sandbox analysis event on FortiEDR and are
sent to the sandbox. The conditions are a combination of several items, such as the file was downloaded from the
Internet and was not signed by a known vendor. If the file is found to be clean, the event is automatically classified as
safe and is archived. If the file is determined by the sandbox to be suspicious or malicious, then the event is classified as
non-safe and any future execution attempt of the file in the environment is blocked by one of the Pre-execution (NGAV)
Policy rules. Note that in all cases the first file execution is not delayed or blocked.

Before you start sandbox configuration, make sure that:

l Your FortiEDR deployment includes a JumpBox that has connectivity to the sandbox.
Details about how to install a FortiEDR Core and configure it as a JumpBox are described in Installing the FortiEDR
Core. You may refer to Cores on page 115 for more information about configuring a JumpBox.

l The FortiEDR Central Manager has connectivity to Fortinet Cloud Services (FCS).
l You have a valid API user with access to the sandbox.

To set up a sandbox connector with FortiEDR:

1. Click the button and select Sandbox in the Connectors dropdown list. The following
displays:
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2. Fill in the following fields:

Field Definition

JumpBox Select the FortiEDR JumpBox that will communicate with this sandbox.

Name Specify a name of your choice which will be used to identify this sandbox.

Type Select the type of sandboxto be used in the dropdown list, for example:
FortiNAC.

Host Specify the IP or DNS address of you sandbox

Port Specify the port that is used for API communication with your sandbox

API Key Specify authentication details of your sandbox. To use an API token, click the
API Key radio button and copy the token value into the text box. To use API
credentials, click the Credentials radio button and fill in the external NAC
system API username and password.

3. Click Save.
In order to complete sandbox integration, the Sandbox Scan rule must be enabled with the FortiEDR Central
Manager.

To enable the Sandbox Scan rule:

1. Navigate to the SECURITY SETTINGS > Security Policies page.
2. Open the Execution Prevention policy that is applied on devices for which you want the sandbox scan to apply and

click the Disabled button next to the Sandbox Analysis rule to enable it, as shown below:

FortiEDR is now configured to send unknown files to the sandbox.

You can check file analysis on your sandbox console.

In addition, you can see sandbox analysis events in the Events page. Events of files that were found to be clean appear
under the Archived Events filter and events of files that were found to be risky are displayed under the All filter, such as
shown below. A sandbox analysis digest is added to the security event’s handling comment.
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eXtended Detection Source Integration

To connect to external systems in order to collect activity data, you must add a new connector for extended detection,
which will automatically collect activity logs and activity data from external systems. Currently, this feature connects to a
FortiAnalyzer device type, which collects the logs from other systems, such as firewalls, Active Directory and other
security products. The aggregated data is then being sent to Fortinet Cloud Services (FCS) where it is correlated and
analyzed to detect malicious indications that will result in security events of eXtended Detection policy rule violations.

Before you start configuring FortiAnalyzer configuration, verify that:

l Your FortiEDR deployment includes a JumpBox that has connectivity to FortiAnalyzer. Details about how to install a
FortiEDR Core and configure it as a JumpBox are provided in Installing the FortiEDR Core. You may refer to Cores
on page 115 for more information about configuring a JumpBox.

l The FortiEDR Central Manager has connectivity to the Fortinet Cloud Services (FCS).
l You have a valid API user that has access to FortiAnalyzer.

To set up an extended detection connector with FortiEDR:

1. Click the button and select eXtended Detection Source in the Connectors dropdown list.

The following displays:
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2. Fill in the following fields: eXtended Detection Source Enabled: Check this checkbox to enable blocking of malicious
IP addresses by FortiAnalyzer.

Field Definition

JumpBox Select the FortiEDR JumpBox that will communicate with the sandbox.

Name Specify a name of your choice which will be used to identify this sandbox.

Type Select the type of sandbox to be used in the dropdown list.

Host Specify the IP or DNS address of your sandbox.

Port Specify the port that is used for API communication with your sandbox.

API Key/Credentials Specify authentication details of your sandbox. To use an API token, click the
API Key radio button and copy the token value into the text box. To use API
credentials, click the Credentials radio button and fill in the sandbox API
username and password.

3. Click Save.

In order to complete eXtended Detection Source integration, the eXtended Detection rules must be enabled with the
FortiEDR Central Manager, as follows.

Enabling eXtended Detection Rules

To enable the eXtended Detection rules:

1. Navigate to the SECURITY SETTINGS > Security Policies page.
2. Open the eXtended Detection policy that is applied on devices on which you want the eXtended detection policy to
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apply and click the Disabled button next to each of the underlying rules to enable it, as shown below:

FortiEDR is now configured to issue eXtended Detection alerts.

Custom Integration

Custom Connector Configuration

The CUSTOM section enables you to connect to any third-party system in order to automatically trigger an incident
response in that third-party system as the result of a security event detected by FortiEDR. After you define a Custom
Integration connector (and its actions) and configure a relevant Playbook policy, an automatic incident response action
will be triggered in the third-party system upon the triggering of a security event.

To set up a Custom Integration Connector in FortiEDR:

1. Click the button and select Custom Connector from the dropdown list.

The following displays:
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2. Fill in the following fields:

Field Description

JumpBox Select the FortiEDR JumpBox that will communicate with FortiAnalyzer. A
FortiEDR deployment must include a JumpBox that has connectivity to the
external system of this Custom Integration Connector. This JumpBox must be
exclusive to this organization and cannot function as a core.

Name Specify a name of your choice to be used to identify this custom connector.

Host Specify the IP or DNS address of the relevant third-party application.

Port Specify the port that is used for API communication with the relevant third-
party application.

API Key/Credentials Specify authentication details of the relevant third-party application. To use an
API token, click the API Key radio button and copy the token value into the text
box. To use API credentials, click the Credentials radio button and enter the
relevant third-party application’s API username and password.

3. In the Actions area on the right, define the action to be taken by this custom connector, as follows:
l To trigger an action on a custom connected third-party system, click the + Add Action button to display the
following popup window:
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a. In the Action dropdown menu, select one of the previously defined actions (which were defined in
FortiEDR as described Custom Integration on page 328).
-OR-

b. Click the Create New Action button in this popup window to define a new action that can be triggered
according to the definitions in the Playbook, as described in the next section below. The following displays:
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Fill out the fields of this window as follows in order to define a new action to be triggered in response to an
incident.
Note – In order to trigger this action, a Playbook policy must be defined that triggers this action to execute the script when a security event is

triggered. The definition of this new action here automatically adds this action as an option in a Playbook policy. This action however, is not

selected by default in the Playbook policy. Therefore, you must go to the Playbook policy and select it in order for it to be triggered when a

security event is triggered.

Field Definition

Name Enter any name for this action.

Description Enter a description of this action.

Upload Upload a Python script that calls an API from the third-party system in
order to perform the relevant action. The Python script must be created
according to the coding conventions that can be displayed by clicking

the icon next to the Action Scripts field. The following displays
providing an explanation of the coding conventions and provides
various links that you can click to see more detail and/or to download
sample files.

4. Click Save. The new action is then listed in the Actions area.
5. Select this action to associate it with the custom connector.
6. You can click the Test button next to it to execute this action.

A new row is added to the CUSTOM section of the Automated Incident Response – Playbooks page. In order for
this custom integration connector to trigger an action, you must define it in the Playbook, as described below.
Note – The actions that you define here can also be selected as an action for a Firewall integration connector (as described in page 232) or for a NAC

integration connector (as described in page 237). These integration connectors might use the same API. Alternatively, you may need to upload a different

script that will be used to perform the same action on different 3rd party products. You can associate several scripts with the same action and select the

appropriate one per connector. For example, an IM Notification action could have two scripts – one for notifications via Slack and the other for notifications

via Teams.

FortiEDR 5.1.0 Administration Guide 331
Fortinet Inc.



Administration

Playbooks Configuration

To configure an automated incident response that triggers an action using this custom integration connector upon the
triggering of a security event:

1. Navigate to the SECURITY SETTINGS > Playbooks page.
2. Open the Playbook policy that is applied on devices for which you want the custom action (defined above) to apply.
3. In the CUSTOM section, place a checkmark in the relevant Classification columns next to the row of that action.
4. In the dropdown menu next to the action, select the connector with which to perform the action or Select All of

them, as shown below:

The example above showed how to configure two custom connectors by using the same action named IM
notification in the Playbook – one for notifications via Teams and the other for notifications via Slack.
FortiEDR is now configured to trigger this action in the third-party system upon the triggering of a security event.
This automatic incident response action appears in the CLASSIFICATION DETAILS area of the Events page of
the FortiEDR Console.

Action Manager

FortiEDR enables you to define connectors to external systems, so that FortiEDR will automatically trigger predefined
actions when a security event is triggered in FortiEDR. You can define your own actions while defining a Custom
integration connector, Firewall integration connector or NAC integration connector (as described above). Each action is
comprised of a Python script (one or several ones) that calls an API from the third-party system in order to perform the
relevant action.

The Action Manager enables you to upload and manage (add, modify and delete) these actions and the Python scripts
that call third-party systems’ APIs.
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To display the Action Manager:

1. In the ADMINISTRATION tab, select INTEGRATIONS.
2. Click the Action Manager button. The following displays:

To define a new action:

1. Click the + Add action button in the top left corner of the window.
2. Fill out the fields of this window as follows in order to define a new action to be triggered in response to an incident.

Note – In order to trigger this action, a Playbook policy must be defined that triggers this action to execute the script when a security event is triggered. The

definition of this new action here automatically adds this action as an option in a Playbook policy. This action however, is not selected by default in the

Playbook policy. Therefore, you must go to the Playbook policy and select it in order for it to be triggered when a security event is triggered.

Field Definition

Name Enter any name for this action.

Description Enter a description of this action.
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Field Definition

Upload Upload a Python script that calls an API from the third-party system in order to
perform the relevant action. This Python script must be created according to
the coding conventions that can be displayed by clicking the icon next to the
Action Scripts field. The following displays providing an explanation of these
coding conventions and provides various links that you can click to see more
detail and/or to download sample files.

3. Click Save.

To modify the script of an action:

1. In the ADMINISTRATION tab, select INTEGRATIONS.
2. Click the Action Manager button.
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3. Select the action of the script to be modified. The following displays:

4. 4 In the Action Scripts area, hover over the name of the script in order to display various tools, as follows:

Tool Description

To overwrite the current script by uploading a different script instead of it.

To download the action’s current script. For example, so that you can edit it.

To delete the action’s selected script.

To upload a new Python script that calls an API from the third-party system in
order to perform the relevant action.

Note – To delete an action entirely, hover over its name in the list on the left and click the Trashcan icon.

5. Click Save.
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Troubleshooting

This chapter describes how to troubleshoot various problems that you may encounter in the FortiEDR system.

Note – For debugging and troubleshooting, Fortinet Support may request that you provide the logs for the FortiEDR devices deployed in your organization

(Collectors, Cores, Aggregators). You may refer toExporting Logs on page 117 for details about how to do so.

Note – If your system includes the Forensics add-on, you can use the Retrieve Memory function to retrieve memory related to a specific stack on a specific

Collector. For more details, you may refer toRetrieving Memory on page 217.

A FortiEDR Collector Does Not Display in the INVENTORY Tab

After a FortiEDR Collector is first launched, it registers with the FortiEDR Central Manager and is displayed in the
INVENTORY tab. If it does not appear to have registered, then perform the following:

1. Check that the device on which the FortiEDR Collector is installed is powered on and has an Internet connection.
2. Validate that ports 8081 and 555 are available and that no other third-party product is blocking these ports.

No Events on the FortiEDR Central Manager Console

If no events are displayed in the FortiEDR Central manager console, then perform the following.

Validate that there is network connectivity between all the system components.

To do so, we recommend:

l Running Telnet on the FortiEDR Collector and connecting to the FortiEDR Core IP via port 555,
l Running Telnet on the FortiEDR Core and attempting to connect to the FortiEDR Aggregator IP on port 8081.

Note – Make sure that Telnet is enabled in Windows.

User Cannot Communicate Externally or Files Modification Activity
Is Blocked

Microsoft Windows-based Devices

TheWindows Event Viewer records whenever a FortiEDR Collector blocks communication from a device or file
modification related to ransomware activity. This information is recorded in the Windows Event Viewer log located in the
following location: Event Viewer > Windows Logs > Application.
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MacOS-based Devices

The MacOS console records whenever a FortiEDR Collector blocks communication from a device or file modification
related to ransomware activity. This information is recorded in the MacOS console log located in the following location:
Applications > Utilities > Console > All Messages, as shown below:
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Multi-tenancy (Organizations)

This chapter describes the operations that can be performed by an Administrator in a FortiEDRmulti-organization
system.

This chapter is only relevant for administrators in a multi-organization system. If you do not have Administrator rights,
there is no need to read this chapter.

What is a Multi-organization Environment in FortiEDR?

Beginning with V3.0, the FortiEDR system can be set up as a single-organization or multi-organization environment.
When set up as a single-organization system, the FortiEDR system and all its operations and infrastructure serve a
single tenant, called an organization in the FortiEDR system, and work as described in all the previous chapters of this
guide.

Note – Prior to V3.0, the FortiEDR system only supported a single tenant (organization).

In a multi-organization FortiEDR system, someone with Administrator rights can perform operations and handle data for
all organizations in the system. For example, think of a multi-organization environment like a hotel chain, which has a
parent company along with hotels in various cities. In this scenario, the ABC Hotel corporate entity represents themain
organization, and each ABC Hotel branch location represents a separate, discrete organization. For example, ABC Hotel
Los Angeles, ABC Hotel New York, ABC Hotel Boston and so on.

FortiEDR uses organizations to distinguish between tenants in a multi-tenant environment. Each organization uses the
same FortiEDR user interface and shares the same FortiEDR database.

Multi-organization and User Roles

FortiEDR uses a series of predefined roles to control access to organizational data, as follows:

l Administrator: Is the highest-level super user that can perform all operations in the FortiEDR Central Manager
console for all organizations. This role can access all organizations in the system, and also includes the same
privileges as the Local Administrator and User roles.
In a FortiEDRmulti-organization system, the system comes with one predefined Administrator user. More than one
Administrator role is permitted.
Note – There must always be at least one Administrator in the system.

l Local Administrator: Is a super user that can perform all operations in the FortiEDR Central Manager console for a
single organization. This role can only access its own organization’s data, and also includes the same privileges as
the User role. More than one Local Administrator role is permitted per organization.

l User: This user is allowed to view all information and to perform actions for its own organization, such as to mark
security events as handled, change policies and define Exceptions. This user is similar to the Local Administrator.
However, this user cannot access the ADMINISTRATION tab, which is described in Administration on page 252.
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Component Registration in a Multi-organization Environment

Collector Registration

Each organization has its own registration password. The Collector installer specifies the Collector organization name. If
theOrganization field is left empty during installation, the Collector is added to the default Hoster account, as shown
below:

After registration, the Collector receives the organization ID. You can rename the organization if preferred.

To specify the organization when installing from a command line, run the following command:

msiexec…\qn ORG=<organization name> AGG=

For more details about Collector installation, see Installing FortiEDR Collectors on page 26.
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Core Registration

Most Cores are shared between organizations. It is possible to install a Core that belongs only to your organization by
installing it on-premises. In this case, you must specify the organization during the Core installation process.

Collectors that do not belong to an organization cannot see that organization’s organization-specific Core.

For more details about Core installation, see Installing the FortiEDR Core on page 397.

Workflow

The following general workflow applies for Administrators when working in a FortiEDRmulti-organization system:

Step 1 – Logging In to a Multi-organization System

For a FortiEDRmulti-organization system, a user must also specify the organization when logging in to the system.
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By default, Administrators are logged in to the main organization, and do not need to specify an organization in the
Organization Name dropdown list.

A Local Administrator or regular User must specify the organization when logging in. The user must be defined for an
organization in order to log in to that organization.

Step 2 – Defining or Importing an Organization

TheORGANIZATIONS page lists all the organizations defined in the FortiEDR system.

The Default (hoster) organization is predefined in the system. This organization represents the main organization in the
system, such as the ABC Hotel chain described before. The Default (hoster) main organization cannot be deleted.

The Default (hoster) organization can be accessed by an Administrator and the Local Administrator that you define for it.

Note – In a single-organization system, the Default (hoster) organization is the only organization. To set up a multi-organization system, seeMoving from a
Single-organization to Multi-organization Structure in FortiEDR on page 346.

The Organizations window contains the following information:

Field Definition

Name Specifies the name of the organization.

Workstation Licenses Capacity For the organization, specifies the number of workstation licenses allocated to the
organization.

Worksstation Licenses in Use Specifies the number of workstation licenses in use (installed).

Servers Licenses Capacity For the organization, specifies the number of servers allocated to the
organization.

Servers Licenses in Use Specifies the number of servers in use (installed).

IoT Devices Capacity For the organization, specifies the maximum number of IoT devices that can be
detected in the organization.
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Field Definition

IoT Devices in Use Specifies the number of IoT devices detected in the organization.

Expiration Date Specifies the expiration date of licenses for the organization.

Click the button in an organization row to edit the properties of that organization.

You can delete an organization as long as it does not have any workstations or servers in use. Click the Delete
button in an organization row to delete that organization.

Click theMigrate Organization button in an organization row to migrate that organization. For more details, see
Migrating an Organization on page 349.

To define an organization:

1. Click the ADMINISTRATION tab and then clickORGANIZATIONS in the left pane. TheORGANIZATIONS page
displays.
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2. Click the button. The following window displays:

All fields in this window are mandatory.
3. Fill in all fields in this window, as follows:

Field Definition

Name A free-text field that specifies the name of the organization. For example, a
hotel branch location like ABC Hotel Los Angeles.

Registration Password Specifies the registration password for the organization. Each organization
can have a different registration password. You set the value for this
password.
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Field Definition

Supported special characters in the password: !, #, %, &, ', +, -, ., /, :, <, =, >, ?,
@, [, \, ], ^, _, `, {, |, }, ~, and ,

You can display the registration password for an
organization by selecting ADMINISTRATION > TOOLS >
COMPONENT AUTHENTICATION > DISPLAY.

Note – If third-party software attempts to stop the FortiEDR Collector service,
the system prompts for the registration password. This is the same password
used when installing the Collector. If an incorrect password is supplied at the
prompt, the message Access Denied displays on the Collector device. In this
case, the FortiEDR Collector service is not stopped. For more details about the
required password to supply in this situation, refer to Component
Authentication on page 295.

Expiration Date Specifies when this license expires. Notifications are sent to you beforehand.
Each organization can have its own expiration date.
Note – If the Default (hoster) organization expiration date is earlier than that
for the organization, then the expiration date for the Default
(hoster)organization applies. Whenever there is an expiration date conflict, the
earlier date always applies.

Vulnerability, IoT Management,
and Device Control

Check this checkbox for the organization to have access to these features.
This option is only available on setups that have purchased a Discover and
Protect license or Discover, Protect and Response license.
Note – The various license types in FortiEDR enable access to different
FortiEDR features. The Administrator can configure the various organizations
in a multi-tenant environment to each have access to different features in the
product. For example, Organization A may have access to the Threat Hunting
feature and Organization B may not.

Forensics and Threat Hunting Check this checkbox to provide the organization access to these features. This
option is only available on setups that have purchased a Discover, Protect
and Response or Protect and Response license.
l Repository storage add-ons: Specifies the number of repository add
ons, out of the total number of add on purchases, to enable this
organization to use.

l eXtended Detection: Check this checkbox to give the organization
access to this feature. This option is only available on setups that have
purchased an eXtended Detection add on. See more details on license
types in Launching the FortiEDR Central Manager for the First Time on
page 21.
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Field Definition

Workstations / Servers / IoT
Devices License Capacity

Specifies the number of license seats for the organization, meaning the
number of Collectors that can be installed in this organization. Before
allocating licenses to an organization, you may need to verify the number of
available licenses that can be distributed. All currently unallocated licenses are
available for allocation to an organization. You cannot enter a number that is
greater than the number of licenses available for allocation.
Note – The License Capacity field in the Licenses window shows the total
number of license seats for the entire FortiEDR system, which are divided into
Workstations, Servers and IoT Devices.
The Default (hoster) organization initially receives the total allocation of
licenses. The Administrator is responsible for allocating these licenses among
organizations. In a single-organization FortiEDR system, licenses do not need
to be allocated between organizations, as there is only one organization.

4. Click the Save button. Note that it may take a minute or so to create the organization.
After creating the organization, the organization appears as a new row in the Organization dropdown list.
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Note – If a user attempts to use a feature that is not available with their license, a warning message displays. For example, as shown below.

Moving from a Single-organization to Multi-organization Structure in FortiEDR

In a single-organization system, the Default (hoster) organization is the only organization.

To create a multi-organization (multi-tenant) system, an Administrator simply needs to add one or more organizations to
a single-organization system. When there are multiple organizations in the system, you can select the organization of
interest in theOrganization dropdown menu that appears at the top left of the window, as described below.

Step 3 - Navigating Between Organizations

In a multi-organization system, all types of information are now organized per organization.
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Administrators can view information in the FortiEDR system for a specific organization or for all organizations together.
To do so, use one of the following methods:

a. Select the Hoster view in theOrganization dropdown menu at the top left of the window to display information for
all organizations together. For more details about Hoster view, see Hoster View on page 357.

b. Select the organization of interest in theOrganization dropdown list.

In Hoster view, each row in the Organizations pane represents a different organization. Note that after you select an
organization, the entire user interface only shows information for that organization.
Note – If that multiple web browser tabs or windows are opened on the same device and each of them navigates to a different organization on the

FortiEDR Central Manager Console, they all show the data of the same organization, which is the last organization that was selected in the Organization

dropdown list. In this case, the dropdown may look as if it points to Organization A however the data would be of Organization B.

Step 4 – Defining a Local Administrator for an Organization

Administrators can create one or more Local Administrators for an organization. You should define at least one Local
Administrator for each organization.

To define a Local Administrator:

1. Click the ADMINISTRATION tab and then click USERS in the left pane.

2. Click the button.
3. Fill in the displayed window, as described in Users on page 260, and then click Save. Be sure to select Local

Administrator in the Roles field.
In addition, you must specify the organization for the Local Administrator in theOrganization field, as shown below.
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Step 5 – Performing Operations in the FortiEDR System

Administrators can perform all of the operations described from Security Settings on page 54 to Forensics on page 204
in this guide using the user interface of the FortiEDR Central Manager for all organizations in the system.
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Administrators can monitor the system per organization or using Hoster view, which shows data for all organizations
together.

Migrating an Organization

FortiEDR’s Consolidation feature enables you to copy all the data and definitions within an organization from one
environment to another environment. This feature copies an organization from one environment (source
setup/environment) to another (destination setup/environment). The copy operation adds to the content in the
destination environment, and does not replace the target’s existing content.

Note that this feature is only available to Administrators.

Organization migration involves three steps, which are described in detail in the procedure below.

To migrate an organization:

1. Click the ADMINISTRATION tab and then clickORGANIZATIONS in the left pane. The Organizations window
displays.

2. Click theMigrate organization button in the row of the source organization that you want to copy to another
environment. The following window displays:
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From this window, you perform three steps to migrate the organization to another environment:
i. Export the Organization: This step exports all the data of the selected organization to a zip file.
ii. This step imports all the organization’s data using the zip file exported in step 1. Note that this step is performed

on the destination environment.
iii. This step moves all the Collectors of the selected organization from the source environment to the destination

environment.
3. In the Export organization field, specify the name of the organization to appear for this data in the destination

environment. Make sure that you assign an organization name that does not already exist in the destination
environment.

4. Click the Export button. All the data and definitions for the organization are exported to a zip file. The zip file is
named as follows: source organization name_environment name_FortiEDR_timestamp_Export.zip, as
shown in the example below:

After the export completes, a Download link displays in the window:
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Note – You can cancel the migration process at any time by clicking the Abort button.

5. Click the Download link to download the exported zip file.
Note – Click the Close button if you want to close this window and continue the migration process at a later time. This action saves the relevant

organizational data. You can later continue this migration process by using the Continue Migration button.

If you click the Close button before downloading the exported zip file, a warning displays. In this case, you must perform the migration process again from

the beginning.

6. Click Next. The following window displays:

7. Log in to the destination environment.
8. Click the ADMINISTRATION tab and then clickORGANIZATIONS in the left pane.
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9. In theORGANIZATIONS page, click the Import Organization button. The following window displays:

10. Select the exported zip file to load and then click Import. This step copies all the data and environment definitions of
the exported organization.
Notes – You cannot import an exported organization that has a name that already exists in the destination environment.

To import:

The FortiEDR platform version must be the same in both the source and destination environments.

The content version must be the same in both the source and destination environments. You can see the Content Version at the bottom of the Licensing

window (see page 187).

You must have sufficient workstation and server licenses in the destination environment.

At the end of the import process, the Import Organization window displays a code. Write down this code, as it will be
entered later as part of the migration process.
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Note – The Import code also displays in the Organization Details window, which you can display at any time by clicking the Edit button in an organization

row in the Organizations window.
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Note that the name of the organization cannot be changed in this window, and is read only.
11. In step 2 of the Migrate Organization window, enter or copy the import code into the Import code field.

Note – If you previously closed the Migrate Organization window, then click the Continue Migration button in the source organization row in the

ORGANIZATIONS page.
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12. Click Next. The following window displays:

In this window, you move the Collectors from the source environment to the destination environment. The Collectors
cannot be registered to both environments at the same time.
Note that until this step is completed, the Collectors are still registered to the organization in the source environment
and their status and security events are displayed there. In the destination environment, Collectors are displayed
with the Pending Migration state, as shown in the Inventory window. This state indicates that the Collector has not
yet been transferred from the source environment to this environment. Collectors in the Pending Migration state are
still registered to the source environment.
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13. Specify the Aggregator Address in the To field. Each Collector is connected to one Aggregator. In this field, you
specify the IP address or DNS name and the port of the Aggregator that will service the Collectors in the destination
environment.

14. Click the Transfer button. The Collectors are transferred from the organization in the source environment to the
organization in the destination environment. A progress indicator counter displays as the Collectors are transferred.

Note – The progress indicator counter continues to display until the organization is deleted in the source environment, which is recommended after all

Collectors have been transferred from the source environment to the destination environment. See step 16 below.

If you click the Abort button at this step, any Collectors already transferred from the source environment to the destination environment remain in the

destination environment.

After a Collector has been transferred from the source environment to the destination environment, its state is
Migrated in the source environment, and is Running (functional) in the destination environment.
Note – Collector protection remains in effect throughout the entire migration process.
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15. [Optional] Click the Stop Transfer button to pause the Collector transfer process. You can resume the transfer
process by clicking the Transfer button again.
IMPORTANT – If a user enters the source organization while a migration process is in progress for it, a warning displays. Any changes made by this user

will not be migrated or included in the destination organization. Any changes made to an organization while it is being migrated are ultimately lost.

16. After all the Collectors were successfully migrated from the organization on the source environment to the
organization on the destination environment, delete the source organization. To do so, select the Administration
tab and then clickOrganizations in the left pane. In the Organizations window, click the Delete button in the row of
the source organization to be removed.
Note – Collector protection and functionality remain throughout the entire migration process.

Hoster View

When you select Hoster view in the Organization dropdown list, all windows in the user interface are affected. In general,
this view shows aggregated data for all organizations.

However, some data is only available in Hoster view, such as the following:

l Export Settings: In a multi-organization system, SMTP-related information is only displayed in Hoster view.
l Tools – Periodic Scan

In addition, there are some special cases where you cannot view administration data in Hoster view, and can only view
data for a specific organization, such as the following:
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l Component Authentication
l Automatic Updates
l End User Notifications

Many of the windows that display aggregated data for all organizations have some special features when displaying data
in Hoster view. In general, in Hoster view, these windows have an additional column or field, and require that you specify
the organization in order to add the item. Several examples are provided below. The examples below are not all-
inclusive.

Licensing

When in Hoster view, the Licensing window shows aggregated information for all organizations.

For example, the Workstations and Servers diagrams indicate the number of allocated and available licenses for all
workstations and servers, respectively, in the entire FortiEDR system. The Licenses in Use numbers represent the
number of Collectors that have been installed out of the total permitted to be installed.

The Load Content option loads content to all organizations. Once loaded, the new configuration applies to all
organizations, including new Collector installers. However, Collectors are not being updated yet.

When in this view, you cannot load content to a specific organization.

When you click the Update Collectors button in the Licensing window, the Update Collector Version window displays,
and includes anOrganization Name column. Use the checkboxes in this column to update the organization for a
Collector Group. All other functionality in this window works in the standard manner.
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Users

In Hoster view, this window includes an Organization column.

When you click the button from this window, the User Details window displays. The User Details window
includes an Organization field that you must specify to add the user.
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Dashboard

In Hoster view, some information does not display in the Dashboard. The information that does display is aggregated for
all organizations, such as Collectors, System Components, Repositories and so on, as shown below.
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To view Dashboard information for a specific organization, you must select the organization of interest in the
Organization dropdown list.

Event Viewer

In Hoster view, the Event Viewer displays the security events from all organizations. TheOrganization column indicates
the organization in which the security event occurred.

Note – The same security event can occur in multiple organizations. In this case, it is displayed in separate rows per organization.
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The various options in the toolbar can be applied on multiple organizations simultaneously. For example, you can
archive security events from different organizations at once using the Archive button and you can export security events
from different organizations using the Export button.

You can also use the Handle Event button to handle security events from multiple organizations. In Hoster view, for
each security event selected in the Events window, the Event Handling window shows the organization name and
security events selected for that organization (when you select security events in up to three organizations).

If you select security events from more than three organizations, the Event Handling window displays the number of
organizations and security events you selected in a summary line at the top of the window.
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In this case, when you hover over the summary line, the details of the selected security events display in a gray box. This
box shows the name of the organization and its associated event IDs.
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Forensics

You can select security events from multiple organizations in the Event Viewer and then click the Forensics button in the
Event Viewer to display these security events in the Forensics window. Each security event tab in the Forensics window
shows the name of the organization in which the security event occurred above the event ID.

Communication Control

The Communication Control window is not available in Hoster view.

Threat Hunting

Threat Hunting (Legacy)

In Hoster view, this window includes anOrganization column. In addition, you can hover over an entry in the Product
column to display version information for the item.

FortiEDR 5.1.0 Administration Guide 364
Fortinet Inc.



Multi-tenancy (Organizations)

Threat Hunting

In Hoster view, this window includes an Organization column.

Security Settings

SECURITY POLICIES Page

In Hoster view, the SECURITY POLICIES page displays all policies from all organizations.
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FortiEDR’s multi-organization feature enables you to clone a security policy from one organization to another. To do so,
you must be in Hoster view. When not in Hoster view, you can only clone a policy within the same organization.

AUTOMATED INCIDENT RESPONSE - PLAYBOOKS Page

In Hoster view, you can view all the notifications for the entire organization, based on the actions defined in the Hoster
Notifications Playbook. This Playbook policy is only available in Hoster view.

Exception Manager

In Hoster view, the Exception Manager page displays all exceptions from all organizations.
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When creating an exception in Hoster view, the organization in which the security event occurred is also shown in the
Exception Creation window, as well as the event ID.
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The Exception Manager page also shows the organization to which the exception applies. In addition, the Collector
Groups column indicates the Collector Groups to which the exception applies.
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Inventory

COLLECTORS Page

In Hoster view, the COLLECTORS page shows all the Collectors from all organizations.

When in Hoster view, you can move Collectors between organizations using this window.

Note – Only Collectors from V3.0 and above can be in the non-default organization.

All older Collectors can only be installed in the default organization.

Only Collectors from V3.0 and above can be moved between organizations.
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To move a Collector between organizations in Hoster view:

1. Check the checkbox of the Collector Group or check the checkbox(ex) of one or more Collectors.
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2. Click the button. The following window displays:

3. In theOrganization field, select the organization to which to move the Collector(s).
4. ClickMove to Group.
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Appendix A – Setting up an Email Feed for Open Ticket

The Open Ticket feature enables you to send events to an event-management tool such as Jira or ServiceNow.

In order for the Open Ticket feature to work properly, you must set up a receiving email feed in the event-management
tool to be used. This appendix provides an example that describes how to set up the required email feed in ServiceNow.

To set up an email feed in ServiceNow:

1. Launch ServiceNow.
2. In the window that opens, select System Properties > Email Properties. The following window displays:
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3. In the Inbound Email Configuration area, check the Email receiving enabled checkbox.

4. In the left pane, select System Security > Users and Groups > Users. The following window displays:
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5. Click the button to create a new user. The following window displays:

6. In the Email field, enter the email address of the FortiEDRmessaging system. This email address is specified in the
Email Address field of the FortiEDR Open Ticket settings, which can be accessed by selecting Administration >
Export Settings in the FortiEDR user interface, as shown below:
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7. In the left pane, select System Policy > Email > Inbound Actions. The following window displays:

8. Click the blue button to create new inbound email actions. The following window displays:

9. Fill in the following fields in this window:

Field Definition

Name Enter a free-text name for the inbound email feed. For example, Fortinet
inbound email.

Target table Select Incident [incident] in the dropdown list.

Action type Select Record Action in the dropdown list.
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Field Definition

Active Check this checkbox to select it.

Stop Processing Check this checkbox to select it.

10. In this window, select theWhen to run tab and then in the From field, select the FortiEDR user created in step 6.

11. Select the Actions tab and then paste the provided JavaScript (see below) into the email body. You can modify this
script, as needed.

The JavaScript includes the following code:

//  Note: current.opened_by is already set to the first UserID that matches the From: email
address
current.caller_id = gs.getUserID();
current.comments = “received from: “ + email.origemail + “\n\n” + email.body_text;
current.short_description = email.subject;
current.category = “request”;
current.incident_state = 1;
current.notify = 2;
current.contact_type = “email”;
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//set highest priority for emails from ensilo
if (email.origemail == "DoNotReply@ensilo.com") {
    current.impact=1;

    current.urgency=1;
}

if (email.body.assign != undefined)
    current.assigned_to = email.body.assign;

if (email.importance != undefined) {
if (email.importance.toLowerCase() == "high")

        current.priority = 1;
}

if (email.body.priority != undefined)
    current.priority = email.body.priority;
//parsing fields from message body example
var severityStart = email.body_text.indexOf('Severity:') + 9;
var classificationStart = email.body_text.indexOf('Classification:') + 15;
var destinitionStart = email.body_text.indexOf('Destinations:');

var severity = email.body_text.slice(severityStart, classificationStart -15 );
var classification = email.body_text.slice(classificationStart, destinitionStart);
 current.insert();

12. When pasting in the JavaScript, make sure that:
l The emails address highlighted in yellow (see above) is the same as that specified in Email Address field of the
FortiEDR Open Ticket settings (see step 6).

l You set the current.impact and current.urgency fields highlighted in light blue to specify the impact and urgency
values for ServiceNow.
Various types of information can be extracted from the email sent by FortiEDR. For example, the text
highlighted in pink in the JavaScript (see above) is an example of how to extract the classification value of this
event from the email.

13. Click the Submit button in the ServiceNow window. This completes the email feed setup.
When FortiEDR sends an email to ServiceNow, a JSON file is attached to it. This JSON file contains the raw data for
the event. Once received, you should save this raw data to the ticket.
The following shows a sample JSON file:

//parsing fields from attachment example
if (sys_email.hasAttachments()){
    var att = new GlideRecord("sys_attachment");
    att.addEncodedQuery("table_name=sys_email^table_sys_id=" + sys_email.getValue("sys_
id"));
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    att.query();
    while (att.next()){   
        if (att.file_name == "event.json" ) {
            var sa = new GlideSysAttachment();

            var binData = sa.getBytes(att);
            var strData = Packages.java.lang.String(binData);
            var parser = new JSONParser();
            var parsed = parser.parse(strData);
            current.comments =("EventId from JSON: " + parsed.EventId);
            }
    }
}

The following shows how an event appears when received in ServiceNow, after being sent from FortiEDR:
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Appendix B - Lucene Syntax

The FortiEDR Threat Hunting free-text query is based on Lucene syntax. This syntax consists of terms and operators, as
described below. For more details about the use of this query, see Threat Hunting on page 222.

Terms

A free-text term is a single word (for example NetworkService or CryptSvc) or a phrase surrounded by double quotes (for
example, ”NetworkService -p -s CryptSvc”) that searches for all the words in a phrase (in the same order) regardless of
the field in which the words appear.

A Field: Value term is a combination of a field and a value.

A list of available fields is provided in the query box, which is an automatically-complete dropdown list.

Examples

Where the Source command line contains the value NetworkService:

Source.CommandLine: NetworkService

Where the value of the remote IP is 10.151.121.130:

RemoteIP: 10.151.121.130

Operators

Operators enable you to customize the search and/or to create more complex queries.

Operators are case insensitive.

Operators Definition

OR , || The query should match either one of the terms/values.

AND, && The query should match both of the terms/values.

NOT, ! The query should not match the term/value.

_exists_ The query should match when the field value is not null.

+ – The term following this operator must be present.

• The term following this operator must not be present.
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Example

Where the Event includes either the RemoteIP field that contains 10.151.121.130 or the Remote Port field that contains
443

RemoteIP: 10.151.121.130 OR RemotePort: 443

Where the ProductName field contains both Microsoft and Windows

Source.File.ProductName: (microsoft AND windows)

Where the ProductName field contains Microsoft and does not include Windows

Source.File.ProductName: (microsoft -windows)

Where the Product Name field contains the exact phrase “Microsoft Windows”

Source.File.ProductName: "microsoft windows"

Where the field Behavior has any non-null value

_exists_: Behavior

Where the field PID does not include the value 5292

Source.PID: (NOT 5292)

Where the Event does not include the value 5292 in any of the Event fields

NOT 5292

Wildcards

Wildcard searches can be run on individual terms using a ? (question mark) to replace a single character, and an *
(asterisk) to replace zero or more characters:

Progr?m Fil*

Note that wildcard queries may consume huge amounts of memory and perform poorly.

Ranges

Ranges can be specified for date, numeric or string fields. The inclusive ranges are specified with square brackets

[min TOmax] and exclusive ranges with curly brackets {min TOmax}.

Numbers 1..5

count:[1 TO 5]

Numbers from 10 upwards

count:[10 TO *]

Dates before 2012

date:{* TO 2012-01-01}
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Ranges of IPs

RemoteIP: [140.100.100.0 TO 140.100.100.255]

Reserved Characters

Should you need to use any of the characters that function as operators in the query itself (and not as operators), then
you should escape them with a leading backslash (\). For instance, to search for c:\Windows\, write the query as
c\:\\Windows\\.

Reserved characters are +,-, =, &&, ||, >, <, !, ( ), { }, [ ], ^, ", ~, *, ?, :, \ and /.
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Appendix C – ON PREMISE DEPLOYMENTS

This chapter describes how to install the FortiEDR backend components for on premise deployments.

Installing FortiEDR components on-premise

In this section we will guide you through on-premise deployment of FortiEDR components.

Before you start the FortiEDR installation process, please make sure that:

l All devices, workstations, virtual machines and servers on which a FortiEDR component will be installed comply
with the system requirements provided on Installing FortiEDR on page 19.

l You have read and selected the most suitable deployment option for you.
l FortiEDR Core, FortiEDR Aggregator and FortiEDR Central Manager use ports 555, 8081 and 443, respectively.
Ensure that these ports are not blocked by your firewall product (if one is deployed).
As a security best practice, it is recommended to update the firewall rules so that they only have a narrow opening.
For example:
l Only open the TCP outbound port 555 to the Core IP address.
l Only open the TCP outbound port 8081 to the Aggregator IP address.

Install the system components top-down in the following order:

1. Installing the FortiEDR Central Manager and FortiEDR Aggregator on the Same Machine on page 383
2. Installing the FortiEDR Threat Hunting Repository on page 389
3. Installing the FortiEDR Core on page 397
4. Installing FortiEDR Collectors on page 26

Installing the FortiEDR Central Manager and FortiEDR Aggregator
on the Same Machine

The following describes how to install both the FortiEDR Central Manager and the FortiEDR Aggregator on the same
machine.

The same ISO file is provided for installing both the FortiEDR Central Manager and the FortiEDR Aggregator. Both of
these can be installed on the same machine or separately. To install these components on different machines, see
Installing the FortiEDR Central Manager and FortiEDR Aggregator on Different Machines on page 388.

The procedure below describes how to install the FortiEDR Central Manager on a VMware-based virtual server.
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1. Create a new virtual server by selecting File > New Virtual Machine.
2.

Select the Typical option and select Next
3.

Select the I will install the operating system later option and click Next.
4.

Select the Linux radio button. In the Version field, select CentOS 7 64-bit and click Next.
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5.

Specify a name such as FortiEDRCentralManager for the virtual machine and the location in which to store the
provided ISO file and click Next.

6.

Change theMaximum disk size according to system requirements listed in Installing FortiEDR on page 19, leave
the default option as Split virtual disk into multiple files and click Next.
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7.

Click Finish
8. Right-click the new machine and select the Settings option
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9.

Select theMemory option and change the RAM according to system requirements listed in Installing FortiEDR on
page 19.

10. Select the Processors option and change the value according to system requirements listed in Installing FortiEDR
on page 19.

11. Select the CD/DVD option and then select the Use ISO image file option on the right.
12. Click the Browse button and select the ISO file provided by Fortinet for the FortiEDR Central Manager. ClickOK.
13. Start the virtual machine.

The virtual machine automatically starts the installation process, which may take a few minutes.
14. Wait until a success message is displayed requesting that you reboot.
15. Reboot the virtual machine.
16. Log into the virtual machine in order to continue the installation process.

Login: root
Change the root password, by entering any password you want. Then re-type it. The password must be strong
enough according to Linux standards.
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17. Enter fortiedr config

18. At the prompt, enter your hostname and click Next. (Note: This can be any hostname)
19. At the prompt, select the role of the virtual machine. For this installation, which installs both the FortiEDR Central

Manager and FortiEDR Aggregator on the same machine, select Both and click Next
20. A list of network interfaces on this virtual machine displays. At the Pick your primary interface prompt, select the

interface to be used as the primary network interface through which all FortiEDR Cores and FortiEDR Collectors will
reach this server, and then click Next.

21. At the Do you want to use DHCP prompt, select No to configure the IP of this virtual machine manually, and then
click Next.

22. At the prompt, enter the IP address of the machine that you are installing. Use the following format:
xxx.xxx.xxx.xxx/yyyy, where yyyy is the routing prefix of the subnet.

23. At the prompt, enter the default gateway and click Next.
24. At the Please set your DNS server prompt, enter a valid IP address and click Next. Use the following format:

xxx.xxx.xxx.xxx/yyyy, where yyyy is the routing prefix of the subnet.
25. At the prompt, select No for debug mode.
26. At the Please set the date prompt, verify the date and click Next. The installer automatically presents the current

date. You can change this date, if necessary.
27. At the Please set your Time prompt, set the time and click Next.
28. At the prompt, select the timezone and country in which the server is being installed.
29. Wait a few moments while the installation processes, until you see the Installation completed successfully message.
30. Log in for the first time, as described on Launching the FortiEDR Central Manager for the First Time on page 21.

Installing the FortiEDR Central Manager and FortiEDR Aggregator
on Different Machines

l To install only the FortiEDR Central Manager component, perform the entire procedure for Installing the FortiEDR
Central Manager and FortiEDR Aggregator on the Same Machine on page 383

l To install only the FortiEDR Aggregator component, perform steps 1 through 19 Installing the FortiEDR Central
Manager and FortiEDR Aggregator on the Same Machine on page 383. Then, perform the steps described below:
a. At the Please enter the management IP address prompt, enter the IP address to be used for communicating

with the FortiEDR Central Manager and click Next
b. At the Please enter your registration password prompt, enter the user and password used to register the

FortiEDR Aggregator with the FortiEDR Central Manager and click Next.
c. Perform steps 21 through 29 of Installing the FortiEDR Central Manager and FortiEDR Aggregator on the

Same Machine on page 383

After you have finished the successful installation of FortiEDR Central Manager, please refer to Launching the FortiEDR
Central Manager for the First Time on page 21.

FortiEDR CLI Commands

The following describes additional commands that you can perform in the FortiEDR Core, Repository Server, FortiEDR
Central Manager or FortiEDR Aggregator CLI.

At the prompt, type fortiedr or fortiedr help to display them.
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After you have finished the successful installation of FortiEDR Central Manager, refer to the Launching the FortiEDR
Central Manager for the First Time on page 21.

Installing the FortiEDR Threat Hunting Repository

The FortiEDR Threat Hunting feature (described in Threat Hunting on page 222) requires a license and the installation of
the Threat Hunting repository, as described below. The installation of the FortiEDRManager is a prerequisite for
installing the Repository server.

Installation of FortiEDR Threat Hunting is comprised of the following steps:

1. Creating a Virtual Machine on page 389
2. Installing an Operating System ISO on page 391
3. Installing a FortiEDR Repository Software ISO on page 395

Creating a Virtual Machine

To create a virtual machine

1. Create a new virtual server. For example, by selecting File > New Virtual Machine…., then selecting Create a
new virtual machine and clicking NEXT.
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2. Enter the desired virtual machine name. For example, FortiEDR-TH-Repository and click NEXT.
3. Enter the virtual machine settings, as follows:

l In the Select storage step, select the storage where the virtual machine disk should be stored on and click
NEXT.

l In the Select Compatibility step, select ESXi 7.0 U1 and later and click NEXT.

l At the Select a guest OS step:
o In the Guest OS family field, select Linux.
o In the Guest OS version field, selectOther 4.x Linux (64-bit).
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o Click Next. The following displays:

l In the Customize hardware step, do the following:
o In the CPU field, enter the number of CPUs, as specified in System Requirements on page 19
o In theMemory field, enter amount of memory in GB, as specified in the System Requirements on page 19
o In the New Hard disk, enter the SSD disk size in GB, as specified in the System Requirements on page
19. It is highly recommended to use SSD.

o Add an OS disk. In the New Hard disk:
n Enter the OS disk size in GB, as specified in System Requirements on page 19
n In the Disk Provisioning field, select Thin Provision.

o Add a DATA disk. In the New Hard disk:
n Enter the DATA disk size in GB, as specified in System Requirements on page 19
n It is highly recommended to use SSD.
n In the Disk Provisioning field, enter Thick Provision Eager Zeroed.

o In the New Network field choose VMXNET3
l To complete the creation of a virtual machine, select Finish.

Installing an Operating System ISO

To install an operating system ISO:

1. Select the newly created virtual machine and click Launch Remote Console.
2. In the VMRCmenu, select Removable Device > CD/DVE drive 1 > Connect to Disk Image File (iso)….

3. Select the FortiEDR_Repository_OSInstaller ISO file and clickOpen
Note: ISO should remain mounted
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Another option instead of completing the two steps described above is to upload the ISO
from the VMWare datastore (this is possible if the ISO has already been uploaded there).

4. Restart the Virtual Machine. The virtual machine starts and the following menu is displayed:

5. Select the Install Node option
6. Log in using the rancher user (without the password) and run the following commands in order to start the K8S

node installation:

sudo su –
bash /k3os/system/install_k3os.sh
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7. For a new installation, enter 1.
8. Complete the k3os installation by providing the following parameters:

l When prompted to enter the SSH password, enter the password to be used for the rancher user. A strong
password must be entered.

l At the k8s cluster token prompt, enter the token to be used if additional nodes will be connected in the future.
This token will be used by additional nodes in order to connect to this k8s cluster.

l At the Use DHCP (yes/no) prompt, enter no.
Note: Using DHCP causes a malfunction of the FortiEDR Repository server so that it is in anOffline state after the installation. When prompted,
enter the IP, Mask and Gateway details of the virtual machine.

l When prompted to select an operation, approve the default (1. Install to disk) by pressing Enter.
l To select the sda disk as the OS disk, enter 1.
l At the Config system with cloud-init file prompt, enter y.
l When asked to provide a Cloud-init file location (file path or http URL), enter edr.yaml.
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l When prompted to continue, enter y.

This may take a while. At the end, the Virtual Machine will restart automatically.
l In the menu, approve the default (k30S Current).

The system will start. This might take a few minutes while OS data is copied to the Virtual Machine
l Log in with the rancher name and the password set previously.
ISO should be disconnected before continuing
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l Run the sudo su - command

9. Check that the installation was successful by running the kubectl get nodes command and checking that the
status of edr-repo-master1 is Ready, as shown below:

Installing a FortiEDR Repository Software ISO

To install the FortiEDR Repository Software ISO, launch the FortiEDR_RepositoryInstaller ISO file:

1. From the VMRCmenu, select Removable Device > CD/DVD drive 1 > Connect to Disk Image File (iso)...
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2. Select the FortiEDR_RepositoryInstaller ISO file and click onOpen.

Another option instead of the two steps described above is to upload the ISO from the
VMWare datastore (this is possible if the ISO has already been uploaded there).

3. Run the following command:

bash /k3os/system/install_edr2.sh

Select init (1) for a new installation.

Existing virtual machine specifications (CPU and RAM) are being validated. If one is found to be lower than the
minimum requirements for proper functioning of the FortiEDR Repository, the following warning appears and the
installation is aborted:

Wait until required docker images import from ISO to local image storage (might take few minutes).
4. Complete the FortiEDR Repository software installation by providing the following parameters:

l When prompted to enter the number of seats, enter the number of seats of your FortiEDR License
(workstations and servers).

l When prompted to specify whether the repository will be used by aManaged Security Service Provider
(MSSP), approve the default if you are not an MSSP or provide the number of expected organizations
(meaning Tenants), if you are.

l When prompted for the FortiEDRManager details, provide its IP and the credentials of one of the FortiEDR
Console administrators that have RestAPI permissions.

l Review the displayed configuration. Type yes to approve it or if the parameters are not correct, press the Enter
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key to restart the configuration process.

Installation may take several minutes

Installing the FortiEDR Core

Preparing for the FortiEDR Core Installation

The workstation, virtual machine or server on which the FortiEDR Core will be installed, must meet the following
requirements:

l Complies with the requirements described in the System Requirements section on Installing FortiEDR on page 19.
l Has connectivity to a Local Area Network (for wired users) or a Wireless Network (for wireless users). If there is no
connectivity, consult your IT support person.

l Has connectivity to the FortiEDR Aggregator. You can check this by browsing to the Aggregator’s IP address. For
problems connecting, see Troubleshooting on page 336.

l Has connectivity to the FortiEDR Reputation Server at 35.186.218.233.
l If the FortiEDR Core is deployed on your organization’s premises (on-premises) and you use a web proxy to filter
requests, then before running the installer, set the system proxy to work with an HTTPS connection, as follows:
o Edit the file /etc/environment to have a proxy address configuration, https_proxy or PAC address.
For example: https_proxy=https://192.168.0.2:443
(for PAC): https_proxy=pac+http://192.168.200.100/sample.pac, where the sample.pac file
contains an HTTPS address of the proxy.

o If the definitions of the system proxy are placed somewhere other than /etc/environment, then:
n Copy the definitions to the file /etc/environment. Note that this affects all processes on the Linux system.
n Define a specific environment variable for the FortiEDR Linux Core with the name nslo_https_proxy at

the file /etc/environment
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For example: nslo_https_proxy=https://192.168.0.2:443
(for PAC): nslo_https_proxy=pac+http://192.168.200.100/sample.pac

Note:For more details about installing a Core in a multi-organization environment, see the Core Registration section
on page 255.

Installing the FortiEDR Core

The following describes how to install the FortiEDR Core.

1. Create a new virtual serve by selecting File > New Virtual Machine.
2.

Select the Typical option and click Next.
3.

Select the I will install the operating system later option and click Next.
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4.

Select the Linux radio button. In the Version field, select CentOS 64-bit and click Next. Alternatively, you can
select a different generic Linux 64-bit in the Version field.

5.

Specify a name for the virtual machine such as FortiEDRCore and the location in which to store the provided ISO file
and click Next.
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6.

Change theMaximum disk size to 80GB, leave the default option as Split virtual disk into multiple files and
click Next.

7.

Click Finish
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8. Right-click the new machine and select the Settings option.

9.

Select theMemory option and change the RAM to at least 8 GB.
10. Select the Processors option and change the value to a total of at least two CPU Cores.

FortiEDR 5.1.0 Administration Guide 401
Fortinet Inc.



Appendix C – ON PREMISE DEPLOYMENTS

11. Select the CD/DVD option and then select the Use ISO image file option on the right.
12. Click the Browse button and select the ISO file provided by Fortinet for the FortiEDR Core. ClickOK.
13. Start the virtual machine. For example, by using the button shown below:

The virtual machine automatically starts the installation process, which may take a few minutes.
14. Wait until a success message is displayed requesting that you reboot.
15. Reboot the virtual machine.
16. Log into the virtual machine in order to continue the installation process.

Login: root
Change the root password, by entering any password you want and then retype it. The password must be strong
enough according to Linux standards.

17. Enter fortiedr config.
18. At the prompt, enter your hostname (any hostname) and click Next.
19. At the prompt, select the role of the virtual machine. For this installation, select CORE and click Next.
20. At the prompt, enter the registration password.

Note that if this is a multi-tenant setup and this Core is to belong only to a specific organization, then the password
should match the registration password that was provided upon creating that organization (listed under
ADMINISTRATION > ORGANIZATIONS tab of the FortiEDR Central Manager).

21. At the prompt, enter the Aggregator external IP address followed by the port (optional). If a port is not provided, the
default port 8081 is used.

22. At the prompt, enter this machine’s external IP address followed by the port (optional). If a port is not provided, the
default port 555 is used.

23. At the prompt, enter the Organization name. For a non-multi-tenant setup, this must be left empty.
24. A list of network interfaces on this virtual machine displays. At the Pick your primary interface prompt, select the

interface to be used as the primary network interface through which all FortiEDR Cores and FortiEDR Collectors will
reach this server, and then click Next.

25. At the Do you want to use DHCP prompt, do one of the following:
a. Select Yes to use DHCP and click Next. Proceed to step 29 below.
b. Select No to configure the IP of this virtual machine manually, and then click Next. Perform steps 26 through 34

below.
26. At the prompt, enter the IP address of the machine that you are installing.

Use the following format: xxx.xxx.xxx.xxx/yyyy, where yyyy is the routing prefix of the subnet.
27. At the prompt, enter the default gateway and click Next.
28. At the Please set your DNS server prompt, enter a valid IP address and click Next.

Use the following format: xxx.xxx.xxx.xxx/yyyy, where yyyy is the routing prefix of the subnet.
29. At the prompt, select No for debug mode.
30. At the Please set the date prompt, verify the date and click Next. The installer automatically presents the

current date. You can change this date, if necessary.
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31. At the Please set your Time prompt, set the time and click Next.
32. At the prompt, select the timezone and country in which the server is being installed.
33. At the Do you want to enable Web proxy prompt, select one of the following:

l No (the default)
l Yes (only for an on-premises Core installation, which should be configured to pass a web proxy)

34. Wait a few moments while the installation processes, until you see the Installation completed
successfullymessage.

35. To verify that core installation succeeded, use the fortiedr status and fortiedr version commands.
36. Verify that the FortiEDR Core details are listed in the INVENTORY tab of the FortiEDR Central Manager.

Upgrading FortiEDR Components

This section describes how to upgrade the components in the FortiEDR system.

Upgrading to a newer build number (major.minor.patch.build) can be done in any order. However, upgrading to newer
major/minor versions (major.minor.patch.build) should be done top-down in the following order:

1. Installing the FortiEDR Central Manager and FortiEDR Aggregator on the Same Machine on page 383
2. Installing the FortiEDR Threat Hunting Repository on page 389
3. Installing the FortiEDR Core on page 397
4. Installing FortiEDR Collectors on page 26

Upgrading the Central Manager

The required upgrade file is provided to you by Fortinet. Use it to perform the procedure below. If both the Central
Manager and the Aggregator are installed on the same machine, you only need to perform this procedure once to
upgrade both components.

1. Copy the FortiEDRInstaller_x.x.x.xxx.x file to the Central Manager machine. You can place the file anywhere on
the Linux machine. For example, FortiEDRInstaller_Management_Agg__5.0.x.y.x.

2. Change the chmod 755 permission and the pathc name in order to enable you to run the upgrade, as shown
below:
[root@dan ~]# chmod 755 FortiEDRInstaller_Management_Agg__5.0.x.y.x

3. Run the upgrade, as shown below:
[root@dan ~]# ./ FortiEDRInstaller_Management_Agg__5.0.x.y.x

4. Wait for the upgrade to complete, as shown below:
FortiEDR installation 5.0.x.y finished successfully

[root@dan ~]#

Upgrading the Aggregator

The procedure for upgrading the Aggregator is the same as that for updating the Central Manager. You only need to
perform the procedure a second time if the Aggregator is installed on a different machine than the Central Manager.

For more details, you may refer to Upgrading the Central Manager on page 403.
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Upgrading the Core

1. Copy the FortiEDRCoreInstaller_x.x.x.x.x file to the Central Manager machine. You can place the file anywhere
on the Linux machine. For example, FortiEDRCoreInstaller_3.1.1.90.x.

2. Change the chmod 755 permission and the patch name in order to enable you to run the upgrade, as shown
below:
[root@dan ~]# chmod 755 FortiEDRCoreInstaller_3.1.1.90.x

3. Run the upgrade, as shown below:
[root@dan ~]# ./ ./ FortiEDRCoreInstaller_3.1.1.90.x

4. Wait for the upgrade to complete, as shown below:
FortiEDR patch 3.1.1.90 finished

[root@dan ~]#
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